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EuxapioTieg

Oa ABeAa va euxapioTiiow 1IBIaiTEPA TNV UTTEUBUVN KaBnyATpia pou K. Alovuaia
KoAokoTod kaBwg eTTiong kai Tnv utrowh@ia AiddkTopa K. Aikatepivn AINAA d16T1 dixwg
TN BonBeia, TN oTAPIEN Kal TNV KaBodAynon Toug dev Ba PtTopoUoe va eKTTovnOEi N
Tapouca OITTAwUATIKA epyacia. Télog &ev Ba umopolca va TrApoAsiyw TIG
EUXAPIOTIEG HOU TTPOG TO CUVOAO TwV BIOACKOVTWY KAl TOU EPEUVNTIKOU TTPOCWTTIKOU
YIQ TIG TTOAUTIMEG YVWOEIG TTOU HOoIPAOTNKAV Padi Jag.



ATtrayopeleTal n avtiypan, amobnkeuon kal diavour Tng TTapoloag epyaciag, €§
OAOKAApPOU 1 TUAPOTOG QUTAG, VIO EUTTOPIKO OKOTTO. EmiTpérmeral n avatummwon,
atroBrikeuon Kal SIavoun yia Pn KEPOOOKOTTIKG OKOTTO, EKTTAIDEUTIKOU ] EPEUVNTIKOU
XOPAKTAPA, PE TNV TTPOUTTOBECN va avagEPETal N TNy TTPOEAEUONG.

EpwtiuaTta TTou a@opouv Tn Xprion NG epyaciag yia aAAn xprion Ba Trpémel va
atreuBuvovTal TTPpog To cuyypagéa. O1 aTTOYEIS KAl TO CUPTTEPACHATA TTOU TTEPIEXOVTAI
0€ QUTO TO £yypa@o ekPPAloOUV TOV CUYYpPA@Ea Kal Oev TTPETTEI va €PUNVEUBED OTI
QVTITTPOOWTTEUOUV TIG €TTiIoNMES B€0eIg Tou MoAuTtexveiou KpATtng.



MepiAnyn

H onuaoia NG UTTapéng TTPACIVWY XWPWV OTIG TTOAEIG gival TTAEOV ETTITAKTIKY, KABWG
N TTOIOTNTA TOU ACTIKOU TTEPIBAANOVTOG €XEI ONUAVTIKA ETTIOPAOCT OTNV UYEIQ Kal TNV
gunuepia Twv Katoikwyv. O1 TTOAUCUXVAOTOG TTPACIVOG XWPOGS, TOU TTAPKOU Twv Ayiwv
ATTOOTOAWV QTTOTEAEI ONUAVTIKOG XWPOG AVAWUXNS Kal TTapdyovTag avavéwaong yia
TOUG KaToikoug TNG TTOANG. O1 eKTINACEIG KAl O1 aVAAUCEIG TTOU TTPAYUATOTTOINONKAY 0T
OIMMAWMATIKA epyacia atrodeikviouv OTI n BAdoTnon OupBdaAel oTn peiwon NG
Bepuokpaciag, TNV ATTOPAKPUVON Twv pUTTWV Kal Tnv atmoBrikeuon Aavepaka,
BeATiovovTag €101 TNV TTOIOTNTA TOU Qépa Kal TO YeVIKO TTepIB&AAov. EmmiTAéov, n
TTapoUCia TIPACIVWY XWPWV TTPOCPEPEl EUKAIPIEG YIO QUOIKA AoKNon, WUXIKA
avavéwaon Kal xaAdpworn, oupBaloviag oTtn BeAtiwon NG CWUATIKAG  Kal
WUXOAOYIKNG UyEiag Twv KaToikwv . Ta atroteAéopaTa auTd utToypaupifouv TN onuaacia
TOU OXedIaOPOU Kal TNG dlaxeipiong Toug pe oTdXo TN PeATiwon TNG TTOIOTNTAG CWNG
oTIG TTOAEIG. H ouvexng épeuva kal agloAdynon Twv TTRACIVWY XWPWV £ival OUCIACTIKA
yia TNV avapBaduion Tou aoTIKoU TTEPIBAAAOVTOG Kal TV TTPOCTACIA TNG UYEIOG Kal TNG
eunuepiag Twv Katoikwyv. TEAOG, N €QAPUOYH TWV ATTOTEAECUATWY O€ TTPAKTIKEG KAl
aTTOTEAEOPATIKEG AUCEIS yia Tn BeATiwon Toug amoTeAei onuavTikd Bripa TTPoOg TNV
acipépo avamTugn Twv TOAcwv. H peBodoAoyia TTou ¥pNoIPOTTOINBNKE yia TNV
agloAdynon Tou TIPdoivou xwpou TrepIAapBavel Tnv emmegepyacia dedouévwy ammod
aI00NTNPEG BEPUOKPATIOg Kal OXETIKAG UYPACIiag TTOU TOTTOBETABNKAV EVTOG KAl EKTOG
Tou TIpdoivou xwpou. EmmiTAéov, avaAuBnkav dedopéva atmmd @opntd TPITTOdIKO
METEWPOAOYIKO OTABUO OXETIKA WE TN BEpUOKPACTia Tou aépa, TN OXETIKA uypaacia Kal
TN Bepuokpacia akTivoBoAiag. lMNa Tnv eKTiPnon Twv BEPPIKWY KATATTOVIICEWY OTOV
avBpwWITIVO opyaviouo, xpnoidotroindnke o Maykéopiog Oepuikdg KAIMaTIKOG AgikTng
(UTCI). Na v ekTipgnon g duvaTtdtntag atroudkpuvong aéplwyv pUTTWV Kal TNG
o0éopeuonc/atmobrikeuong dvBpaka atréd 1 BAGoTnon, XPNOIMOTTOINONKE TO AOYIOUIKO
I-Tree Eco, 10 omroio Baagiletal o dedouéva TTou CUAAEyovTal aTTO TOV TTPACIVO XWEO.
TéANog n Onuioupyia epwTtnuaToAoyiou  eixe wg Pacikd oTdxo va civar duvar n
Kataypagr tng Ammown Twv TTOAITWY OXETIKA YE BEpaTa aioBNTIKAG Kal BlIwoIuéTnTag
Tou idlou Tou TTApkou .Me autdv Tov TPOTTO, N MEAETN agloAoyei Tov avTiKTUTTO TOU
TPACIVOU XWPEOU oTnv ToIdTNTa TOUu aCoTIKOU TTEPIBAANOVTOG Kal OTnv uyeia Kai
guNUEpia Twv KAToiKwY Tng TTOANG, Trapéxoviag OedOPEvVa TTOU PTTOPOUV vda
XpnoigotroinBouyv yia Tn BeATiwon Tou oxedliaopou Kal TNG diaxeipiong Twyv TTPACIVWY
XWPWV.



ABSTRACT

This thesis investigates the importance of urban green spaces in addressing the health
challenges associated with degraded urban environments, such as severe climatic
conditions, poor air quality, and noise pollution, which adversely affect residents'
physical and psychological well-being. The study focuses on evaluating the biggest
park of Chania, the park of Agious Apostolous, using indicators of climate resilience
and air quality sourced from international literature. The aim is to identify specific
gualities of these green spaces that enhance the health and well-being of city dwellers
and to provide insights for future urban planners to improve their design. To assess
these green spaces, various environmental data were collected using sensors placed
within the green spaces and in nearby urban areas. Additionally, a portable weather
station provided further data on air temperature, relative humidity, and radiation
temperature. The study utilized the Universal Thermal Climate Index (UTCI) to
evaluate thermal stress experienced by individuals within and outside the green
spaces. Furthermore, the I-Tree Eco software was employed to estimate the green
spaces' capacity to remove air pollutants and sequester carbon based on on-site data
about tree species, size, and sunlight exposure. The findings emphasize the critical
role of urban green spaces in mitigating urban environmental challenges and highlight
the need for further research to fully understand their positive impacts on residents'
health and well-being in Chania. The study aims to inform urban planning strategies
by identifying effective green space qualities that can be replicated or enhanced to
create healthier and more sustainable cities.
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1.Eicaywyn

Ta Tpdoiva oToIxeia, OTTWG TTAPKA, dAOT, TTECOOPOUIa Kal TTEPIOXEG aVAWUXAG, dev
ATTOTEAOUV POVOV aIoBNTIK TTPOCOAKN OTO ACTIKG TOTTiO, AAAG TTaifoUV KpPioIuo poAo
OTNV €unMEPIa Twv KaToikwyv. MNapéXouv XWPoUg avayuyng, TTEPIOXES VIO CWHATIKA
aoknon, MeElwvouv Tn Beppokpacia TG TTOANG KATd TOUG KOAAOKAIPIVOUG WAVEG,
BeATILWVOUV TNV TTOIOTNTA TOU aEpa Kal dnuioupyouv éva TTepIBAAAOV TTOU TTPOAyEl TV
WuyIkn uyeia. Qotéoo, n avénon TNG QOTIKAG AVvATITUENG, N OOTIKOTIOINON Twv
EKTACEWYV Kal N éAAeIpn oTpaTnyikoU oxediaguou yia Tn d1aTthpnon Tou TTPdcivou
XWPOU €XEl 0ONYNOEI OTN HEIWON AUTWV TWV TTOAUTINWY XWpwVv. H EAAEIpn Xwpwv
Tpacivou atroTeAei TTPOKANON TTOU aTTaITEl dNUIOUPYIKEG Kal TTOAUdIGoTATEG AUCEIG,
TTPOKEINEVOU VA SIGCQANICTEN N BILOIUN ACTIKA AVATITUEN KAl N EUNMEPIQ TWV ACTIKWV
KOIVOTATWV.[1]

Ma TNV avTINETWTTION OAWV AUTWY TWV APVNTIKWYV ETTITITWOEWY N TTONITEIA KaAgiTal va
AGBel olyxpova Kal agipoépa PETPA yia TNV SIAoPAAICN TNG UYEIOG Kal EunuEPIag Twv
katoikwv TG. O 6pog "NBS" avagépetal otig "Nature-Based Solutions" (Aloeig
Baoiopéveg otn @UCN) Kal avTITTPOCWTTEUEI PIO TTPOCEYYION OTOV OXEDIAoUS Kal TN
olaxeipion Tou TTEPIBAAAOVTOG, N oTroia eKPETAAAEUETAI TN QUON YIA TNV €TTIAUCH
TEPIBAANOVTIKWY TTPORANPATWY Kail TN BeATIwoN TNG TTOIOTATAS WG TWV AVOPWTTWY.
O1 NBS atroteAoUv pia TTpAcIvn TTPOCEYYION TTOU EVOWMOTWVEI TN @UON Kal TN
BiotroikINOTNTO O0TO ACTIKO TTEPIBAANOV UE OKOTTO TN dnuioupyia BIWCIPwY AUCEWY yia
mpoBAfuaTa 6TTwG N KAIMATIKA aAAayn, n puttavon, n vyeia, kai n moiétnta {wng.[2]
O1 NBS 0TIg a0TIKEG TTEPIOXEG OTOXEUOUV TN dnuIoupyia BILCINwY TTOAEWV TTOU gival
TTPOCOPUOCUEVEG OTIG TTEPIBAAAOVTIKEG aAAayEG Kal TTapEXOUV KAAUTEPN TToIOTNTA
(wnig via Toug Katoikoug Touc.[3] O1 TTpakTiKEG Twv NBS 0TI aoTikEG TTeEpIOXES
TepIAapBAvouy:

e [lpdoivoug Anudoioug Xwpoug: H Odnuioupyia Tpacivwy  TTAPKWY,
TTPACIVAdWY, KATTWY KOl XWPWV avayuxng yia TOUG KaToikoug. AuToi ol XWwpol
TTaPEXOUV aVAOA KAl XWEO Yia yuxaywyia.

o Aévtpa kal Qutd: H @UTEUON BEVTPWY KAl QUTWV OTIG AOTIKEG TTEPIOXEG VIO TN
onuioupyia okiwv, TNV atroppoenaon Tou CO2, T BeATiwan TNG TTOIGTNTAG TOU
aépa kabwg etTiong Bonboulv oTn ueiwon TNG BepPoKpaaciag.

o YdpoAoyikry Alaxeipion: H alommoinon udpoloyikwyv Alcewv, OTTWG N
onuioupyia UOPOAOYIKWYV TIAPKWY Kal UBPOAOYIKWY OaKTUAiwy, yia Tnv
TTPOANYWN TTANUMUPWY Kal TN BeATIwoN TNG TT016TATAG TOU VEPOU.

o BiokAipaTikr) Apxitektovikr): H oxediaon kal kataokeur KTipiwv 1Tou BaacifovTal
O€ TIPACIVEG TEXVIKEG, OTTWG TAPATOEG PE QUTA, YIa Tn YEiwWon TNG KAIPATIKAG
ETTIOPOONG.

O1 NBS oT1ig aoTikég TTEPIOXEG BonBouv oTn dnuioupyia TTOAewv TTOU Egival TTIO
QaVOEeKTIKEG O€ KAIJATIKEG OAAAYEG, TTIO UYIEIG Kal BIWOIPES. 'EpXovTal QvTIHETWTTEG PE
TIPOKANCEIG OTIG GUYXPOVEG AOTIKEG TTEPIOXEG KAI TIPOCPEPOUV ATTOTEAEOUATIKEG AUCEIG
yIO TNV QVTIMETWITION TOUG KAl WG €K TOUTOU KPIVETAI ATTAPAITNTA N EVOWUATWOT] TOUG
OTIG oUYXpoveEG TTOAEIG. KATToia atrd Ta KUpia TTpoBAAUATA TTOU JTTOPOUV va ETTIAUCOUV



N va ouupdAlouv onuavtik@  otnv AGuPAuvon Toug  OTIG QOTIKEG TIEPIOXEG
TTepIAaPBAvouyv:

e KAipgatikp AMayh: O NBS pummopolv va ponBrAocouv oOTn ueiwon Tou
QVTIKEIMEVIKOU KAIJATIKOU KIVOUVOU, TTPOCQEPOVTAS OKId, YUén Kal TTpooTaCia
ammo TIG uTTEPBEPUIEG KATA TOUG KOAOKaIPIVOUG HWAVESG Kal BonbwvTtag oTtnv
ATTOPPOPNCN TWV PBPOXWYV Kal TNV TTPOANWN TTANUMUPWV.

e PuUmavon tou Aépa: O1 TTpAoIveG EKTAOEIG Kal Ta OEVOPA TTPOCPEPOUV QPUOIKA
QIATPA YIa TNV ATTOPAKPUVON PUTTOYOVWY OUCIWY ATTO TOV aépa, BEATILOVOVTAG
TNV TTOIOTNTA TOU Q€PA OTIG ACTIKEG TTEPIOXEG.[4]

e Alaxeipion Twv YodaTwv: O1 TTPAcIVEG EKTATEIS KAl TO UOPOKUKAWMATA UTTOPOUV
va BonBrijoouv otn diaxeipion Twv UBATWYV, MEIVOVTAG ToV  Kivouvo
TIANUHUPWY Kal BEATILOVOVTAG TNV TTOIOTNTA TOU £€DA@OUG Kal TwV USATWV.

e Yyeia kai Eunuepia: O1 xwpol Tpaacivou TTpodyouV Tn QUOIKN Kal PUXIKA uyEia
TWV KATOIKWYV, TTAPEXOVTAG XWPEOUG avAWUXNG, AVTIMETWTTICOVTAG TO OTPEG KAl
BeATiovovTag Tnv TToIOTATA {WNAG.

e BiomoikiAdTnTa: OI TTPACIVEG EKTACEIG BNUIOUPYOUV OIKOTOTTOUG Yia Tnv dypia
C(wn kal oupgBdaAouv oTn diathpnon TG.

270 TTAQicI0 auTd €XOUV TTPAYUATOTTOINGEI APKETEG PEAETEG TTOU avadeikvUouv TNV
ouvelIo@opd Twv NBS o€ k&Be pia atrd TIg TTPoKAACEIS auTEG. EOTIGloVTaG OTIG £PEUVES
TTOU aoxoAnBnkav pe T ouvoeon Twv NBS pe Tnv uyeia Kal TRV EUunUEPIa TV TTOAITWY,
TapabéTovTal TTAPOKATW KATTOIA XOPAKTNPEIOTIKA TTapadeiypata. Mia peAétn TTou
é\aBe xwpa otnv mreploxr Ovrdapio Tou Kavadd uttodnAwvel 4TI 0 XwpPOG TTPacivou 0To
OOTIKO TTEPIBAANOV OXETICETAl PE POKPOTTPOBEoUNn MeEiwon TG BvnoiudtnTag, He
IOXUPOTEPN OUOXETION OTnv  BvnoliuoéTnTa  TTOU  €VTOTIETAl OE  QAVATTIVEUOTIKA
vooAuaTta.[5] EmmAéov, o1 XWpol TTpacivou €XOuv CUCXETIOTEI PE €va eupu @Aoua
opeAWV yia TNV uyeia, cuptTepIAapBavouévng TnG Peiwong Tou oTpeg. Mia €peguva
TEPIYPAPEI TA ATTOTEAECUATA PIAG BIEPEUVNTIKAG MEAETNG  yia va OIOTTIOTWOEI KaTd
TOooV n KopTiIfdvn Tou OdAlou pTTopei va Asitoupyrioel wg PBIodeikTng yia T
olakUpavon Twv EMMITEDWY OTPEG TTOU PTTOPED va OXETICETal PE DIAPOPETIKA €TTITTEdQ
£€KBEONG O€ XWPOUG TTPacivou. ZupTTepacpaTiké n HETpNon TNG KopTiIdvng OTO GAAIO
TTPOOPEPEI ONUAVTIKEG BUVATOTNTEG Yia TN IEPEUVNON TWV OXECEWV METAEU TNG EVEEiag
KAl TOU XWpPou Trpacivou Kal oudnTaue TTwWG auTr N oIKoAoyIKa €ykupn ueBodoAoyia
MTTOPEI va avaTTuxBei woTe n TTapOox TWV XWPWV TTPACiVOU KOVTA OTO OTTITI UTTOPEI
va evioxUoel TNV owuaTikA euegia .[6]Mia GAAn £peuva TTou d1e€AxBn otn Mepuavia
AVOAQEPETAI OTNV ETTIOPACH TWV XWPWV TTPACIVOU KAl OTA EUEPYETIKA ATTOTEAEOUATO
oTa eTmiTeda TNG IVOOUAIVNG Twv €@rifwyv, Kabwg n PBAGoTnon OUuuPBAAAEl oTnv
aTmmoppOPnOon Twv PUTTWV TToU OXeTiCovial Ye TTPORAAMATA TNG KUKAO®Opia Tou
aipatoc.[7] TéAog pia £peuva TTou €Aafe xwpa oTo Kdouvag KaTédeIEe TNV CUCXETION
METAEU TNG aTTdOTACNG TWV XWPWV TTPACiVOU aTTd TNG OIKIEG TWV avOpWTTWY PE TNV
WuxIKnA vyeia Twv TTaidiwy (NAIKiag 4 £wg 6) Kail To yovidlako ayxog . O1 oxEoE€Ig auTéG
€XOUV ONUAVTIKEG CUVETTEIEG VIO TNV TTPOANYN TWV CUVAICONPATIKWY TTPOBANUATWYV Kl
TWV TTPORANUATWY CUPTTEPIPOPAG oTa TTaIdIA.[8]

ZUpQwva pe pia geAETN avaokoTTnong [3], uttoypappideTal n avaykn agloAdynong Twv
XOPOKTNPIOTIKWY TWV XWPWV TIpacivou €Tl wWoTe oTto PEANOV va JTTopEi va
TPOCSIOPIOTEI N OUCYKETION METAEU QUTWV TWV EIBIKWY XAPOKTNPIOTIKWY Kal TwV
TTPOPRANPATWY UYEIQG O€ CUYKEKPIUEVEG TTANOUCUIOKEG OUADEG.

210 TAQiCI0O QUTAG TNG TTPOCTTIABEIaGg, N OIMMAWMATIKY auTh €xel wG OTOXO va
agloAoyAOEl TO HEYOAUTEPO Kal TTIO TTOAUCUXVAOTO TTAPKO AVAWUXNG OTNV TTEPIOXH TWV
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Xaviwv , To TApKO Twv Ayiwv ATTOOTOAWV TTPOKEIUEVOU VA XPNOIUEUOEl WG
QVTITTPOOWTTEUTIKO TTAPAdEIYUA yIa TNV agloAdynon AAAwV PIKPOTEPWVY Kal AlydTEPO
OUVOETWV XWPWV TNG TTOANG.

Katd tnv agloAdynon autr] Aqeenkav uttown T1000 JEIKTEG KAIMATIKAG AVOEKTIKOTNTAG
000 Kal OgikTeEG TTOIOTNTAG aépa. EIdIKOTEPQ, yIa TNV agloAdynon Tou TTPAcIVOU XWEou,
TIPAYHOTOTTOINONKE £TTECEPYATia TV OEBOUEVWV TTOU APOPOUV Tn BEpUoKpaTia Tou
agpa Kal TN oxeTikA uypacia. Ta dedopéva autd CUAEXBnKav atrd aloBnThpeg TToU
gyKaTaoTddNKav o€ oTaBEPd onuEia Tou TTPACIVOU XWPEOU KOl TOU OOTIKOU XWPEOU,
KABWG Kal atmd Tov PETEWPOAOYIKO OTABPO OTO KEVTPO Twv Xaviwv. ETImTAfov,
utToBANBNKav ot emmegepyacia Ta dedopéva OXETIKA PE TN BEPUOKPATia Tou agpa, Tn
OXETIKA uypacoia kal Tn Beppokpacia akTivoBoAiag, Ta oTroia kataypd@nkav améd Evav
eopNTO TPITTODIKO METEWPOAOYIKO OTABUO. o TOv UTTOAOYIONO Twv BEPUIKWV
eMPRapUVOEWVY TTOU u@ioTatal 0 AvlpwTtTog evidg Kal EKTOG TOU TTPACIVOU XWEOU,
xpnoigotroinBnke o MaykOopiog BePUIKOS KAIMATIKOG d¢ciktng (UTCI), pe Tn xprion
KatdAAnAou AoyiouikoU TTou gival 1a0€01uo d1adIKTUOKA YIO TOV UTTOAOYIOUO TOU.
EmimmAéoy, yia Tov uttoAoyIopo TnG dEopeuong/atmoudkpuvong agpiwy pUTTWY Kal TNV
ammoBrikeuon dvBpaka atmd Ta dEVIpa Tou TTPACIVOU XWPEOU, XPNOIMOTToINONKE TO
Aoyiouiké |-Tree Eco. Ta 06edopéva Tou  ypnoigotmoiRdnkav  TTepIAGUBavav
TTANPOPOPIEG OXETIKA WE TOV apIBUO dEvTpwy, TO €idOG TOoug, TO HEYEBOG TOug, TN
OIAUETPO TNG KOUNG K.Q.
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2 MeBodoloyia

2.1 Neprypa@n mepIoXNG MEAETNG

Ta Xavid gival pia ravéuopen TOAN TTou BpiokeTal oTn vOTIOOUTIKN TTAEUPd TOU vNaI1oU
NG KpAtng otnv EAAGSa. MpokeiTal yia 1o HEYAAUTEPO AOTIKO KEVTPO TNG TTEPIPEPEING
TWV Xaviwv Kal aTToTEAET évav aTTo TOUG TTI0 dNPOPIAEIG TOUPIOTIKOUG TTPOOPIOUOUG TNG
Xwpag .(BA.Eikéva 1)

Eikova 1 Acpopwroypagia tng moAng twv Xaviwv

H 1méAn Twv Xaviwv katoAapBdvel €KTaon TTEPITTIOU OEKATPIWV  TETPAYWVIKWV
XINOUETPWY Kal aTToTeEAEI TN deUTEPN PeEYaAUTEPN TTOAN TOU vNoIoU PETA TO HpAKAEio.
O 0®nRuog Xaviwv apiBuei 110.646 katoikoug (2021), kai Tépa amd Ta Xavid
TepIAaPBAvel Ta HeYaAUTEPQ TTPOACTIO TA OTTOIO £XOUV EVWOEI OIKIOTIKA WE TNV TTOAN
Twv Xaviwv éTTwe: Ta Kouvoutnidiavd, To Z0du, ol Moupviég, n Zouda, n Nepokoupou,
10 Aapdtoo, Ta MepiBoAia, o MaAaTdg Kal To Apwvi.

To KAiga TG TOANG XapaKTNEIiCeTal WG TUTTIKO WECOYEIAKO , e CeoTd Kal Enpd Ta
KaAokaipia Kal ATTIOUG XEIMWVEG. H atudo@aipa eival oxeddv TTavTa {e0Tr Kal Ta Bepud
eTTeIo0dIa (ue Bepuokpaaieg TTadvw atd 38 °C) dev cival TTOAU ouvnBicuéva, agou
uTTdpxel ouvexwe n Balacaivi aupa.

Eikéva 2 Aspogwroypagia tn¢ maAiag moAng rwv Xaviwv

H 8¢on peAétng Tng TTapakdTw SITTAWMATIKAG agopd 1o MNdapko Twv Ayiwv ATTOGTOAWY
TO OTTOI0 BPioKETAI OTNV TTOAN TWV Xaviwy ,n £€KTaon Tou avépxeTal ota 540 oTpéuuarta
EVW 0 apIBUOGS Twv BEVTPWY TTANCIALEI oxedov TIG 2000. Eival eukoAa TTpoofdaaipo atrd
TO KEVTPO TWV XAViwV €ITE JE AUTOKIVNTO €iTE YE HETA PAIKAG HETAPOPAG KABWG ATTEXEI
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TEPITTOU 4 XINOPETPa dUTIKG TOU KEVTPOU TNG TTOANG .H B€0n Tou TTAPKOU TTAPEXE! MIT
6aan eUOoNG Kal XaAdpwong o€ OXETIKA KOVTIVH attéoTaon atrd 1o KEVTPO TNG TTOANG.
Eival TTOAU dnUO@IAEG PHETAEU TWV VTOTTIWVY KAl TWV TOUPICTWY TTOU ETTIOKETTTOVTAI TA
Xavid, KaBwg TTPOCPEPE! PIa EUXAPIOTN AvAPEIEn eUOoNG, TTAPaAIag Kal yuxaywyiag o€
£va opop@o TrePIBAAAoV .To TTapKo dlaBETel Guop@a AouAoUdia, dEvTpa Kal AANG QuTA,
TToU OnuIoupyolv éva dpooepd Kal euxdpioTo TTEPIBAAAOV yia TTEQTTATNMO KAl
XOAGpwon. YTapxouv TIAYKOl KAl KABiopoTa OTTOU Ol ETTIOKETTTEG WTTOPOUV Va
&eKOUPAOTOUV Kal va atToAauoouv Tn @uon. ETriong, uttdpxel TTaidikr xapd n oTroia
Tpoo@épel dlaokEdaon yia Ta Taudid .(BA.Error! Reference source not found.)

Eikova 3 Acpopwroypagia rou Tdpkou Twv Ayiwv AmoaToAwv

To onuepivé TTapKo avaTTuxbnke ota péoa Tou 200U alwva. O apxIKES 1IBEEC TNG
avaTTuéng Tou TTepINGuBavav Tn dnuioupyia evog TTEPIBAANOVTOC XWPOU PE TTOANG
OEvTpa Kal QUTA, KABWGS Kal TNV avéyepon MIag TTAISIKAG XaPAG Kal EYKATAOTACEWV
GOANONG Kal Puxaywyiag yia TOUG ETTIOKETTTEG.

Opiopéveg atd TIC SPaOcTNPIOTNTES TTOU Ol ETTIOKETITEG ITTOPOUV VA aTTOAAUCOUV OTO
Mapko Twv Ayiwv ATTooTOAWV €ivai :

» [leptmmdmnua 1o TAPKOo SIABETEI JOVOTTATION KAl OUOPPA PEPN TTOU O ETTIOKETTTNG
TOU uTTOpEi va TrepinynOei kai va atroAaloel To TTpdcoivo TrepiBaAlov. (BA.Eikdva
4)

Eikéva 4 lNepirrarntik@ povorrdria Tou TapKou Twv Ayiwv ATTooTOAwY
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»  ABANTIKEG KOl YUXAYWYIKEG EYKATAOTAOEIG : To TTaPKO S1aBETEl TTAIBIKN) XOPA WE
TTauyvidla, yATTedo PTTAoKET ,YATTEOO TTODOCPAipoU KAl AANEG EYKATOOTAOEIG
Yl TOUG TTONITEG ,TTAPEXOVTAG TOUG £TOI TNV duvaTOTNTA VO aBAnBouv Kal va

wuxaywynoouv .(BA.Eikdva 5)

Eikova 5 laidikn xapd mdkpou Ayiwv ATTooToAwv

» EkdnAwoeig: 1o mapko Twv Ayiwv ATTOOTOAWV ouxvd @IAoEevel ekdNAWOEIG
OTTWG OUVauAieg, OeaTtpikéC TTAPACTACEIS KAl TTOMITIOTIKEG EKONAWOEIG
,OUUBAaAAovTaG €101 oTa TTONITIOTIKG dpdpeva TNG TTEPIOXNAS. (BA.Eikova 6)

Eikova 6 Acpopwroypagia tou mdpkou Twv Ayiwv ATooTéAwv

2.2 EmiAoyn deIKTWV

O1 deikTeg TTOU ETTIAEXBNKAVY, avaAuBnkav Kal utToAoyioTnkav yia TRV agioAdynon Twv
XWPWV TTPOCIVOU TTOU EUTTITITOUV OTIG KATNYOPIEG TNG KAIUATIKAG AVOEKTIKOTNTAG KOl
TNG TTOIOTNTAG TOU AEPA. ZUYKEKPIYEVA, OI OEIKTEG KAIMOTIKNAG avOeKTIKOTNTAG €ival @ O
O€iKTNG yIa TN pnviaia yéon P€yiotn nueprola Bepuokpaacia ,o0 deiKTNG yia Tn dETuEUOn
AvOpaKka OTOUG XWPOUG TTPacivou, O TTayKOOMIOG OeikTNG BepuikoU KAipaTog Index
(UTCI), kai o deiktng Wuéng Tou eEwTeEPIKOU aEpa. Evn PeTAgU Twv SEIKTWV TTOIOTNTOG
ToU aépa, eTMAEXOBNKav o &eikTng dfopeuong Kal atmopdkpuvong Twyv 03, SO2, NO2
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kal CO atrd mn BAdoTnon. H Aoy auth £yive YeTA attod BIBAIOYPAPIKK) avOOKOTTNON
mepIooOTEpWY aTTrd 100 deikTwyv. H peAETn autr) dev atToTEAE QVTIKEIUEVO TNG
TTapoUCaG Epyaaciag.

2.3 AcikTeg KAIMATIKAG AVOEKTIKOTNTAG

2.3.1 Méon pnviaia TIPA TNG NMEPNOIAG HEYIOTNG BEpUOKpATiag

O &¢ikTnG aUTOG avaépeTal oToV PECO OPO TNG UWNASTEPNG NUEPAOING BepoKpaaiag
TToU TTapaTnPErRonke katd 1n OIAPKEID HIOG OUYKEKPIMEVNG TTEPIOGdoU .H TTepiodog
MEAETNG TOU Ouykekpipgévou Beiktn AapPBdvel xwpa Toug Bepivoug prveg (louviog,
louAIog kal AlyouoTog 2023) KaBwg O eKEiVO TO BIACTNUA TTAPOUCIAZOVTAI OI JEYIOTEG
Bepuokpacieg atnv TEPIOXN Twv Xaviwv Kal KaT €TTEKTAON OTO TTAPKO Twv Ayiwv
AtTooTOAWYV. H XpNoIudTNTA TOU CUYKEKPIPMEVOU OEIKTN agopd AueEca TNV TToIoTNTA
CWAG Kal TNV UyEia TwV KATOIKWV TNG TTEPIOXAS KABWG IBIWG  TIG JECNPEPIAVES WPES N
Bepuokpacia ayyidel TIG PEYIOTEG TINEG TNG YE AUECO TTaKoAoOUBwW, n eTidpacn TNG
Wueng va peyloTotroicital[4] 1o TTAaiclo Tng TTapoloag JITTAWMPATIKAG epyaaciag,
TOoTTOBETABNKAV TECOEPEIC AIoONTPES Senstick oe oTaBepd onpeia péoa oTov TTPACIVO
XWPOo Kal évag aiodnTipag Senstick oe oTaBepd onueio eKTOG Tou TTPACIVOU XWPOU
(ota 500 péTpa ammdéoTOon ATO TOV TTPACIVO XWEO) WOTE va Yivel oUyKpPIon Twv
BEPUOKPOCIWY TTOU ETTIKPATOUV OTOV TTPACIVO KAl OTOV aoTIKG Xwpo. H culioyn
oedopévwy yivoTav KABe 15 Aemrtd. [MAnpo@opieg yia Ta XAPOKTNPIOTIKA Twv
aicbnmpwy Senstick TTapatiBevial oto ke@dAaio 2.6.2. Ta Tnv akpiBéoTepn
XapToypdenon Twv BEpUoKPaCIWY Ba ETTPETTE VA £yKATAOTABE! £va TTUKVOTEPO BIKTUO
alIoOnTpwy OTOV  OOTIKO XWPO. 2TN  CUYKEKPIPEVN  SIMTTAWHATIKY  €pyacia
aglomronOnkay, CUPTTANPWHATIKE, Ta OcdOuEVA TTOU TTAPEXEI O HETEWPOAOYIKOG
oTaBu6G TToU BpioKeTal OTO KEVTPO TwV Xaviwv. [3]

2.3.2 AtroOnkeuon kai déopguon avlpaka otn BAdoTnon

H &éoueuon davBpaka atd Ta dévipa avagépetal otn diadikacia O1Tou 10 SEVTPA
atmoppooUlv Tov 8I0&eidio Tou dvBpaka (CO2) atrd Tnv aTudoeaipa KaTtd Tn SIGPKEIN
NG PWTOOUVBEONG Kal TOV aTToBnKeUouUV aToV id10 Tov EUAIVO OTEAEXOG, Ta QUAAQ Kal
TIG pifeg Toug. AUt n dladikacia €ival onuUavTiKA yia TN hEiwon Tou TToocooTou CO2
oTnVv atpoceaipa, kabwg 1o CO2 eival éva atmd 1a Bacikd agpia Tou BepuoknTTiou TTou
ouvdéeTal ue TNV auénan TnG Bepuokpaaiag Tou TTAAVATN Kal TNV KAIMATIKA aAAayh. [7],

[8]

Ta Oévipa Oeouelouv AvBpaka katd T OIdpKEId TNG QwTooUuvBeong, OTToU
XPNOIYOTIoIOUV TO QWS Tou nAiou, 1o vepd Kal To Oloeidio Tou AvBpaka yia Tnv
Tapaywyr YAUKOZNG kal GAAwv avBpakoUxwyv evwoewv. AuTr n YAUKOZN kal GAAEG
EVWOEIG aTToBnKeUoVTal GTO EUAO KAl Ta AAAG T HATG TWV BEVTPWV.

H déopeuon avBpaka atod Ta SEVTPA €xXEl ONUAVTIKEG TTEPIBAAAOVTIKEG ETTITITWOEIG KAl
ouuBaAAel oTn peiwon Tou emTTédou Tou CO2 otnv aTudéo@aipa, Bonbwvrag aTov
TePIOPIoCPS TNG KAIPATIKAG aAAayng. MNa autdév Tov Adyo, n diathpnon kai n euteuon
OEVTPWV €ival ONUAVTIKEG TTPOKTIKEG yIa TNV TTPOCTACIA TOUu TTEPIBAAAOVTOG Kal T
MEiwoN TNG avBpwTTIVNG £TTIOPACNG OTO KAIWQ.

Ma Tov uttoAoyioué TnG atroBrikeuong avBpaka (carbon sequestration) ammod Ta dévdpa,
10 i-Tree Eco xpnoigotroiei 10 poviéAo "CBM-CFS3," 1Tou avamTtuxbnke amd T1o
Kavadiké Kévipo Adooug (Canadian Forest Service) kai 1o Kévrpo ‘Epeguvag yia 10
Adoog (Canadian Forest Research Centre).
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To CBM-CFS3 (Carbon Budget Model of the Canadian Forest Sector, version 3) €ivai
éva haBnuatikd PHOVTENO TTOU XPNOIYOTTOIEITAl VIO TOV UTTOAOYIOUO TNG aTToBrikeuong
avBpoka oe ddon kal Oévdopa. Autd TO poviéAo AauBdver uttéyn did@opoug
TTAPAYOVTEG OTTWG O1 DIAPOPETIKEG EIBIKEG TOTTOBETIEG, OI KAIMATIKEG CUVOAKEG, N NAIKIa
TWV BEVOPWY, 0 PUBUOG aVATTTUENG, KAl GAAEG TTAPANETPOUG YIA va UTTOAOYIoEl TNV
TTOoodTNTA TOU AvOpaKa TTOU aTTOBNKEUETAlI 0T OA0N KAl TA dEVOPU OE CUYKEKPIUEVES
TEPIOXEG.[9] AuTO TO POVTEAO ETTITPETTEI TOV UTTOAOYIOPO TNG atToBAKeuong dvBpaka
Tpog Ta eTmiTTeda ToUu €dAPOUG Kal TNG PAACTNONG, TTPORAETTOVIAG TTWG QUTH N
atroBrikeuon avBpaka HETABAAAETAI E TOV XPOVO Kal TIG AAANAYEG OTIG TTEPIBAAAOVTIKEG
ouvOnkea.[10]

2.3.3 NMNaykoouiog 0eppikOg KAIpaTIkKOG deikTng (Universal Climate Thermal
Index- UTCI

O¢epuikA Aveon ovopadetal n vonTikA KATAOTOON KATA TNV OTfoia  eKQPAdleTal
IKavoTroinon Me To Bepuikd TePIBGAAOV ammd Toug dlapévovteg o autd, Bdon
uttokeldevikwy Kpitnpiwv (ANSI/ASHRAE Standard 55). 'Evag 6eUtepog opioudg £xEl
olatuttwoei atrd Tov Hensen kai TTpocdiopilel TN BepuIkA dveon cav TNV KATAOTACH
oTnVv otroia oTnv otroia éva dtopo dev emOupuei va peTaBdAAel To Bepuikd TTepIBEGAAOV
Méow TwV TTPAgewyV N TNG CUPTTEPIPOPAG Tou (Hensen, 2004). Q¢ vonTiki katdoTaon
eTnpeddeTal, TEPa atrd TIG MIKPOTTEPIBAAOVTIKEG OUVOAKEG, aTTd TNV WuxoAoyia Tou
aTOHOU Kal aTTd KOIVWVIKOUG TTapdyovTeg. [L1]H avTtiAnyn Tou Bepuikou TepIBAAAOVTOG
gival TTOAAEG QOPEG DIAPOPETIKY avapeoa o€ ATopa TTou Bpiokovtal oTov idlo Xwpo.
MapdAo TTou Ta Opyava KATaypa@ng Twv TTEPIBAAAOVTIKWY OuvBNKWV PTTOpEi va
Ocixvouv akpIBwg TIG idlEg PETPROEIG O dUO SIOPOPETIKEG TTEPIOXEG, N aioBnon TNg
BepUIKAG GveanG PTTOPET va gival TEAEIWG BIAPOPETIKN YIa T ATOUA TTOU BPICKOVTOI EKE.
Etrouévwg yia tov 1Tpoadlopioud TG BepuIKAg dveong atrautolvTal TTITTAEOV TwV
METPACEWV TWV PACIKWY KAIJATIKWY TTAPAPETPWY KAl Ol UTTOKEIMEVIKES AVTIAQWEIG TWV
OIaUEVOVTWY OTOUG XWPOUS Twv Trapatnpriocwyv. H kavotroinon evég atéuou
QVOQOPIKA PeE TO Bepuikd TTEPIBAAAOV gival pia TTOAUCUVOETN Kal 0 PeyAAo Babuod
UTTOKEIMEVIKR avTidpaon ot TTOANEG HETaBANTEG TTou dev eival aveCapTnTeg aAAd
eTnpeddouv £viova n uia TNV GAAN. H avtiAnywn yia 1n Bepuikr dveon eTnpeadeTal amo
QuTéG TIG METABANTEG oI oTroieg TrEPIAGPBAvVOUV Ta XAPAKTNPIOTIKA TOU (QUOIKOU
TEPIBAANOVTOG, TO €iDOG TOU POUXIOUOU, TO ETTITTESO TNG CWHMATIKAG OpacTnpIOTNTAG
KAl Ta OnNUOYPAQPIKA XAPOKTNPIOTIKA Twv UTTO €¢éTaon atOuwv (QUAo, nAikia, uyeia
KATT).

Emopévwg dev ummdpxel KATTOI0 «atmOAUTO» MEYEBOG yia Tov TTPOCdIoPIoUS TNG
BepUIKAG aveong. Mevika n BepuIKA Aveon eTEPxeTal OTav N BEPUOKPATia TOU CWHATOG
olarnpeital HETAlU OTEVWV Opiwv, N uypacia Tou OEPUATOC eival XaunAr kal &ev
KaTtaBAAAeTal «TTPOCTTABEIa» ATIO TOV OPYAVICHO VA PUBUICTEI JE QUOIOAOYIKO TPOTTO
n Bepuokpaaia Tou.

Znuaoia TS OepuIKNC dveonc oTnv Kadnuepivil (wn

O1 ouvBAkeg BepUIKAG Aveong €xouv ouvdebEl e Tnv uyeia Twv avBpwTTwy Kai TNV
ammodoon Twv egpyalopévwy. Mo cuykekpipgéva, o UTTEPPOAIKA Bepud 1 wuxpd
TePIBAANOVT UTTAPXEI TORAPSS KiVOUVOG yia TNV avBpwITIvin uyEia TTou epgavideTal ue
N MOP®Pr) BEPUIKOU OTPEG, EPPPAYUATOG, KPUOTTAYNHATWY KATT.[12]

O 6pog UTCI avagépetal oto "Universal Thermal Climate Index," rou ivail éva &€iktng
TTOU XPNOIYOTIOIEITAI VIO TOV UTTOAOYIOWO TNG avBpwtrivng avtiAnyng NG BepMIKAG
aveong A duodpeoTwyY ouVONKWY Beppokpaaiag. Ze attAd Adyia, To UTCI ekTipd Téoo
QVATPIXIOOTIKI) MUTTOPEi va €ival n Begpuokpacia yia Tov avBpwTTivo Opyaviouo,
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AapBdvovtag uttoywn TrapdyovTeg 6TTwG N BepuoKpacia aépa, n uypaacia, o AvePog Kal
GAAo1 TTapdyovTeg[13].

O 1UTT0G YI1a TOV UTTOAOYIONO Tou UTCI gival TTOAUTTAOKOG Kal GUUTTEPIAGUBAVEI TTOAAEG
HOBNUATIKEG €EI0WOEIG Kal TTAPAUETPOUG. Agv gival KATI TTOU UTTOPEI va UTTOAOYIOEI
€UKOAQ KATTOIOG XWPIG TN XPAON €I181IKOU AOYIOMIKOU A epyaleiwy. YTTApYXouV dIAQOPES
ekd6oeig Tou UTCI Tou AauBdavouv utrown SIAQopous TTapayovTeG, KAl O UTTOAOYICHOG
TOU PTTOPEI VO TTPAYUATOTTOINBEI e UTTOAOYICTIKG AoyIouIKO.[14]

O UTCI xpnoiyoTrolcital cuxva aTtn JETEWPOAOYIa Kal TNV EPEUVNTIKA ETTICTAMN VIO VO
aglohoyroel Tov KivOuvo BepuoTTANgiag Kal TIG ETMITITWOEIS TwV BEPUOKPATCIAKWY
OuUVONKWYVY OTNV UyEia Kal TNV Avean Twv avBpwTTwV.

O utroAoyiopdg Tou Universal Thermal Climate Index (UTCI) eivar TTOAOTTAOKOG Kal
Baoiletal og TTOAEG paBNUATIKEG €6I0WOEIG Kal TTApAPETpoUG. Edw cival o Baoikdg
TUTTOG YIa TOV UtToAoyIouo Tou UTCI:

UTCl=Ta- (Tmrt- Pa* (1.0/8.0))
Otrou:

» "UTCI eivai To Universal Thermal Climate Index (o€ BaBuoug KeAaiou).

» ‘Ta’ givai n atgoo@aipikr) Beppokpaacia (o€ Babuoug KeAaiou).

» "Tmrt’ eival n Bepuokpacia Tng emedveiag (oe Pabuolg KeAaoiou), tToU
uttoAoyiCetal atréd TnVv e€iowon MRT (Mean Radiant Temperature).

» 'Pa’ gival n atpoo@aipik trieon (o€ hPa)

O utmroAoyiopog Tou UTCI TrepidapBavel emmiong dAAoug TrapdyovTeg, OTTwWG N
avepoTaxuTnTa, N uypaacia, kar GAAEG oTaBepEG, AAAG O TTapaTTévw TUTTOG OTTOTEAET TOV
Baoikd utToAoyIOUO.

H oxéon petagu tng Beppokpaciag UTCI (ekppacuévn oe °C) Kal TNG QUOIOAOYIKAG
Katatrévnong mapoucidletal oTov TTapakaTw Tivaka. (BA.Mivakag 1)

Mivakag 1 Zxéon Bepuokpaciag UTCI — Stress category
@ualoloyikng katamévnongUTCI (°C)
range
Above +46 Extreme heat stress

+26 to +32 Moderate heat stress

Slight cold stress
Moderate cold stress

O utroAdoyiopog Tou UTCI gival TToAUTTAOKOG KOl UVABWG aTTaiTel Tn Xprion €101kou
AoyiopikoU A epyaAciwv TTou Aaufdvouv ummdywn Toug OAOUG TOUG QTTAPAITNTOUG
TTapayovTeg. MNa autdv Tov Adyo XpnoigoTToinBnke Aoyiopiké KAEIOTOU KWOIKA TO OTT0I0
aTraitel TNV €l0aywyrn atéd Ta €€ dedopéva: Toug PYECOUG OPOUG OTTO TIG PEYIOTEG
Beppokpaaieg avd nuEPa TTOU KATEypawav ol aloBnTAPES Kal TOUG JECOUG OPOUG TWV
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TIWWV TNG OXETIKAG uypaoiag (%RH) Twv péyioTwy nuepAoIwy BepPoKpaciwy avd
NuéEPa, Katd Tn didpkela 0AOKANPNG TNG BepIvig TTEPIGOOU.

2.3.4 YoO¢n aépa trepIfaAAovrog

Ocov agopd TN Wuén Tou aépa n BAAoTnon emmnpEeddel 10 KAiga péow SIAQopwyY
dladikaolwy, OTTWG N oKioon Kal N TPOTTOTToINoN TNG Porg Tou avéuou. H okiaon atmé
Ta BEVTPA KAl TO XOPTA KPATA TOV 0€Pa TTIO DPOCEPD, TTEPIOPICOVTAG TV aTTOPPOPNCN
TNG NAIAKAG akKTIVOBOAIQG Kal TNV €K VEOU aKTIVOBoAia BepudTnTag oTnv atuoo@aipa.
Ta dévipa kal GAAa @uTA BonBouv eTTiong 0To QIATPAPIOUA TNG PUTTAVONG Kal TN
Meiwon Tng amoppong. [15]H diaBeoiydtnTta  uypaoiag Kol of  BepUoKpadies
TEPIBAANOVTOG €ival oNUAVTIKOI TTAPAYOVTEG TTOU ETTNPEACOUV TNV ATTOTEAECOUATIKOTNTA
TNG QUTIKAG Wuéng. O1 uwnAdTEPEG TaXUTNTEG avEéPOU evioxUouv Tn didxuon NG
BepudTNTAG, EVW N ATHOCQAIPIKN uypacia kal n €5a@Ikr uvypagia €mnpeedlouv Tnv
Tpo@odoaoia vepoU Kal TNV avdatrTuén Twv QuTwv. H @wTtoouvBeon TG BAGOTNONG
MTTOPET £TTIONG VA €TTNEEACEI TNV ATTOTEAEOUATIKOTNTA TNG QUTIKAG YUENng.

Eival onuavTiké va AdBoupe uttown autoug Toug TTapAyovTEG KATA ToV oXeSIQOHO Kal
TNV aglotroinon Twv TTPACIiVWY XWPWV yIia TNV Wugn Twv aoTIKwv Trepioxwy. Ol
XOUNAEG TaxUTNTEG avEPOu Kal n Ouvapik oTaBepdtnTta cuvoolv Tn dnuioupyia
KEVTPOUOAWY CUOTNUATWY WOENG, €V UYWNAOTEPEG TaXUTNTEG AVEWOU WTTOPEI va
eTnpedoouv apvnTika TNV atrédoar. O KatdAANAoG oxedIaoudg TwWV TTPACIVWY XWPWV
MTTOPEl va TTPOCQEPEI avakoUu@ion atmd Tn BeppdTnTa Kal va €ival Pia atrodoTIKA
eVAAANGKTIKA AUon yia Tn peiwon Tng Bepuokpaciag oTIG aoTIKEG TTEPIOXES. QOTOOO,
TPETTEl va AngBouv uttéwn ol did@popol TTapdyovTeg TToU £TTNEEACOUV TNV KATAVOUR TNG
Wuéng, OTTWG Ol POEG aEpda, Ol KAIMATIKEG CUVONAKEG Kal Ol XOPAKTNPIOTIKEG Twv
TTPACIVWY XWPWV, TTPOKEIJEVOU va ETTITEUXOE N EyIoTN atmddoaon TG YUgng atrd Toug
TTPACIVOUG XwpPoug.[16] (

Eikova 7)
...... Longwave from O, Direct and diffuse
"7--.._ atmosphere  [atent Heat shortwave g
.. A o
Reflected ".
shortwave
from tr e(
Reflected < Tr un\plralmn )
shortwave ', Qh (tree)
from Ny Photosynthesis ==\ Sensible Heat
; T ST
Usban built form C (T,>T,) d
built S
f::m C Respiration Qh gains)
{gwav: Heat stordgL/_) & Longwave
from built form QJ /' ‘om lree
7
Longx\ ave Reflected
from surface \/shorm ave
Conduction g
. ;> Soil heat
to subsurface e Rtves
N\ Heat gains A Heat losses T, Temp. of leaf T, Temp. of air

Eikéva 7 AvraAdayég evépyeiag Kata Tn SIGPKEIQ TNG NUEPAS LETAEU EVOS OEVTPOU Kal THS
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H pétpnon Tng Bepuokpaciag Tou agpa PTTOPE va Yivel iTe Je TNV XprRon aiodnthpwy
giTe ME TNV XPAON MABNMATIKWY MOVTEAWV .ZTNV TTapouca OITTAWMATIKY €pyaagia
€EETAOTNKE N PEIWON TNG BEPUOKPATIaG TOU AEPA OTOUG XWPOUG OTTOU EVTOTTICOVTAI Ol
NBS o€ ouvdpTnon Pe TOUG UTTOAOITTOUG AOTIKOUG XWPOUG. & auTo To onueio agiel va
TOVIOTEI OTI Ol ATTOTEAEOMATIKEG ATTOOTACEIS WYUENG aTTd TOUG XWPOUG  TTPOCivou
Kupaivovtal atmd 100 €wg 400 pétpa pakpld atrd autous ,avaloya e 1o P€yebog Tou
XWPOU VW O PTTAE XWwpol £€Xouv TNV duvatdTNTa va WUXouv Tov aépa JeTagu 350 kal
1500 péTpwy atrd aUTOUG .ZUYKEKPIYEVA TO TTAPKO TwV Ayiwv ATTOOTOAWY BpioKeTal
OitTAa otnv BdAacoa ,ouveTTwg ival Aoyiké n wugn atmoé Tnv 8dAacoa o cuvduaouod
ME TOUG XWPOUG TTPAaivou Tou ,va TO €TTNEEGCOUV dueoda. Na autd Tov Adyo n oUyKpion
TNG WUENG TOU TTAPKOU YiveTal PE aloBnThpeG TTou £xouv ToTToBEeTNBEI evidg TOU o€
ouvdapTnon Je aioBnTthpa TTou £xEl TOTTOBETNOEI OTO ACTIKO TUAWA o€ atréaTacn 600
METPWYV aTTO TO TTAPKO KABWG Kal PE TOV PETEWPOAOYIKO OTaBUSO OTO KEVTPO TWV
Xaviwv. Ev cuvexeia TpaydaToTroinBnke n kataypagr Twyv BEPPOKPACIWY ATTO TOUG
alIoONTAPES KATA TOUG BEPIVOUG HAVEG KAl N €§aywWYH TOU HECOU OPOU TWV NUEPHOIWYV
MEYIOTWY BEPUOKPATIWY VIO KABE Priva aT1rd TOV OOTIKO XWPO Kal atmd ToV XWPo
TPaCivou ,ev) OTO TEAOG €yIvVE O UTTOAOYIOHOG Twv SI0POpWY AUTWY TwV
BEPUOKPACIWY PETAEU TWV TTEPIOXWY , OI DIAPOPES AUTEG AVTIOTOIXOUV O¢ Babuoloyieg
ato eAGXIOTN WUEN €wg TNV MEYIOTN WUEN ,auTtég ol Babuoloyicg atreikovifovtal oTov
TTapakaTw Tivaka(BA. Mivakag 2) [17]

Mivakag 2 Zx€on eupoug Wyugng aépa repIBAAAOVTOG e TNV avTioToixn Baduoloyia

EUpog puéng aépa mepiBdaAAlovrog (°C) BaOuoAoyia

<1
1-1.7
1.7-2.3
2.3-3
>3

gl (bW N |

2.4 AcikTeg TO16TNTAG TOU OéPA

2.4.1 Aéopevon/atropdkpuvon 03, SO2, NO2 kai CO atré tn BAdoTnon

H poOmavon Tou aépa OTIC OOTIKEG TTEPIOXEG ATTOTEAE €va QVATITUOOOUEVO Kal
oNMAvTIKG TTEPIBAAAOVTIKO TTPORANUA TTaYKOOMiwG. KaBwg o TTANBUo OGS Twv TTOAEWV
ouvexiel va aufdvetal KAl N OOTIKOTTIOINON ETTEKTEIVETAI, Ol EKTTOUTTEC PUTTWYV
augdvovTal, TTPOKAAWVTAG TTOIKIAEG ETTITITWOEIC GTNV UYEid Twv avBpwTTwy Kal TO
mepIBaAAov .01 Tiyég pUTTavong Tou aépa OTIG AOTIKEG TTEPIOXEG €ival TTOIKIAEG, AAAG
ouxvda TrepIAaUBAvVOUV TNV KUKAOQOPIa OXNUATWYV, TIS BIOINXAVIKEG EYKATACTACEIG, TV
oIKIaKr Béppavan Kai TNV kauon Piopdalag. O1 eKTTOPTTEG agpiwy OTTwG To OIOEEIdIO TOU
alwTtou (NO2), 1o dioeidio Tou Beiou (SO2), To povogeidio Tou avBpaka (CO) kal Ta
owpartidia (PM2.5 kai PM10) aug¢dvouv tn putravon tou aépa. O EMITITWOEIS TNG
PUTTOVONG TOU 0€Pa OTIG AOTIKEG TTEPIOXEG €ival TTOAOTTAEG Kal coBapéS. O1 KATOIKOI
TWV TTOAewV €KTIOEVTAI 0 UWPNAEG OUYKEVTPWOEIG PUTTWYV, Ol OTTOiEG PTTOPOUV va
TIPOKOAEOOUV  AVOTIVEUOTIKA  TTPOPRANAMATA, KAPDIOYYEIOKEG TTOONOEIG,  KapkKivo
augnuévn voonpoTnta kai Bvntotnta. EmimAéov, n putravon tou aépa eTrnpeddel To
TEPIBAAANOV, TTPOKOAWVTAG OEUvon TOou €BAQPOUG, ATTOTPOTIN TNG QVATITUENG TWV
QUTWV Kal ¢nUIEG o€ KTipla Kal pvnueia .H BAGoTnon uTTopei va aTropakpUVvel TOUG
aTHOOQAIPIKOUG  pUTTOUG  (OwuaTtidia kai aépia) pe T dadikacia TG &NpPNg
evatréBeong. H ¢npn evammdbeon eival n PeTa@opd Twv pUTIWV OTTO £va OnNUEIO TOU
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aépa O€ PIa QUTIKA ETTIQAVEIQ, N OTTOId OXETICETAI KUPIWG PE TN OUYKEVTPWON TWV
PUTTWV KOVTA OTNV ETTIQAVEIA, TIG KAIPIKEG CUVOAKES Kal TIG 1010TNTEG TG BAGOTNONG.
Ta mepIoodTEPA QUTA £XOUV PEYAAN em@AveIa avd povdada dykou, augdvovTag Tnv
mOavoTNTa aTmdBeong o€ oUYKPION HPE TIGC OPAAEG, KATOOKEUAOWUEVEG ETTIQAVEIEG TTOU
UTTAPXOUV OTIG OOTIKEG TTEPIOXEG. TMa TTapddelypa, éxel avagepBei 10-30 @opég
Taxutepn €vattéBeon yia CWHATIOIR HIKPOUETPWY (<um) o€ OUVOETIKO ypacidl o€
ouyKpIon PE YUAAIVEG Kal TOIMEVTEVIEG €TIQAVEIES. Ta va ekTIUNBEI TO pPéyeBog TwV
QUTAG TNG CUPPBOAAG XpNolhoTToIouvVTal CUVHBWG POVTEAX.[18]

H atropdkpuvon Tng putravong i N kaBodikr pon puttwy (F) og g/m2/s uttoAoyileTal
atré Tov TUTTO:

E¢iowon 1 Ymroloyioudg atroudkpuvong TnG puttavong
F=vdC

Ortrou:

Vd = TaxutnTta ammébeong (mM/s), kai

C = ouykévtpwon puTtwy (g/m3)

H taxutnta amdéBeong uttoloyileTal wg €ENG:

E¢iowon 2 YmroAloyioudg taxutnTag améBeong pUutrwyv

Vd = 1/(Ra + Rb + Rc)
Ortrou:
. Ra =¢ival n agpoduvapikr] avTioTaon Tou opIakoU OTPWHATOG,
. Rb =¢civai n avriotaon Tou 1EW0UG UTTOOTPWHATOG, Kal

. Rc =¢ival n avriotaon pgeTa@opdg TTou eEapTATal ATTO QUCIKOXNMIKES
aAAnAemdpdozeig.

O1 wplaieg TiHEG yia TG avTioTdoelc Ra kal Rb uttoAoyifovTal péow TUTTOTTOINHEVWY
TUTTWV KaI JETEWPOAOYIKWY dESONEVWY. ZUVNOWG, OI TINEG TOUG Eival HIKPEG O€
ouykpion Pe To Re, To oTroio eTTnpeddel TTepIoadTEPO TNV amméBean puttwy. O1 TIPEG
Tou Rc yia 1o O3, 10 SO2 ka1 To NO2 utroAoyifovTal he Tn xprion uUppIOIKWYV
MOVTEAWY evaTTOBe0oNG HE HEYAAEG QUAAIKEG ETTIQAVEIES. TO RC £XEI TPEIG CUVIOTWOEG:
TNV avTioTaon Twv oTodaTwy (rs), TNV avrioTacn Tou JEGO@UAAOU (rm) Kal TNV
avtiotaon Tng emdepuidag (rt).[19]

2UvoAIKd, 1o Rc divetal atro:
E¢iowon 3 YmoAoyiopdg Tng avriotaong TnG EMQAVEIAG TwV QUAAWV
1/Rc = 1/(rs+rm)+1/rt

H avtiotaon tou pecgo@uAhou ival 0 s/m yia 1o SO2 kai 10 s/m yia To O3, evw yia T0
NO2 givai 100 s/m, Adyw Twv dla@opwv 0T PETAPOPA Tou vepou Kal Tou NO2 aT1o
E0WTEPIKO TWV QUAAWYV, WOTE va emITEUXOEi N owoTr TaxutnTa amédeong. H
avtiotaon Tng emdepuidag opiCetal o€ 8.000 s/m yia To SO2, 10.000 s/m yia 10 O3
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kal 20.000 s/m yia 1o NO2, yia va An@Bouv utroyn ol dIapopoTToIfCEIG OThV
avtioTaon YETAgU Twv pUTTWV.

Ta peTewpoloyikd dedopEVa TTOU XPNOIPOTTOIOUVTAI YIA TOV UTTOAOYIOUS TNG
avtioTaong Tou B6Aou TTepIAaUBAvVoUY TNV UTOCUVOETIKA evepyr] akTivoBoAia (PAR),
TN Bgppokpaacia aépa, TRV TaxUTNTA AvEPoU, TNV TaxXUTNTA TPIBAG, TN CUYKEVTPWON
Tou CO2 (oT1aBepny ota 390 ppm) Kal TV ammOAuTn uypacia. H Bgpuokpacia, n
TaXUTNTA TOU AVEPOU Kal N aTTOAUTN uypaacia PETPWVTAI 1} UTTOAOYICOVTal PE wpldia
dedopéva. H PAR gival 10 46% TnG ouvoAIKNG NAIAKNAG akTIVOBOAIag.

H avtiotaon Rc yia to CO kaBopiletal otaBepr) o€ 50.000 s/m yia TepIOdOUG g
QUAAa kai 1.000.000 s/m xwpig @UAAQ, kaBwg n atmropdkpuvon Tou CO dev oxeTiCeTal
aueca pe Tn dilatrvor). MNa 1a PM10, n yéon taxutnta amébeong cival 0,0128 m/s katd
TNV TTEPiodo pe QUANA. H Baoiki Taxutnta atmébeong yia Ta PM2.5 eCaptdrtal atmd tnv
TaXUTNTO TOU AVEPOU, Kal yia TTEPIGdOUG BPoXAG opideTal INBEVIKN.

To povTEAO XPNOIKOTTOIEITAI YIO TNV EKTIKNON TNG ATTONAKPUVONG PUTTWY O PEYAAN
KAipaka. H wplaia por] puttwv avé TeTpaywvikd pETpo BOAoU dévTpwv
TTOAaTTAQCIAZETAI JE TN OUVOAIKT QUAAIKA ETTIQAVEIN YIa va eKTIMNOEI N CUVOAIKA
aTTOPAKpuUvVon PUTTIWY € Ia TTEPIoXT. H QUAAIKNA emi@dveia uttoAoyideTal he Baon To
TT0000TO agIBOAWY BEVTPWY, TIG NUEPOMNVIEG AVATTITUENG TWV GUAAWY KOl TO PEYIOTO
LAI (Leaf Area Index), 6TTw¢g kaBopileTal atrd dedopéva Trediou.

H atmmoudkpuvon Twy pUTTWY atmd kaBe dEvTPOo uttoAoyileTal Ue Tov TUTTO:

Eéiowan 4 YmoAoyiouocg yia kGBe karnyopia diauéTpou KopuoU TnNS IKavoTnTag Twv

IX = Rtx(LAX)
oTTOU:
. Ix eival n ammoudkpuvon pUTTWV aTTd To GUYKEKPIWEVO OEvTpo (Kg),
. Rt eival n cuvoAikr atropdkpuvaon puttwy atmo OAa ta dévrpa (kg),
. LAX gival n @UAAIKN etmipdveia Tou dévTpou (M?) Kal
. LAt cival n ouvoAikiy QUAAIKE ei@Aveia OAwV Twv dEVTpWY (m?).

H peTtaBoAf TNG ouykEVTPWONG Twv PUTTWY UTToAoyileTal Pe Tov TUTTO:

E€iowon 5 YmoAoyiouég TG wpiaiag HETABOAAG TNG GUYKEVTPWONG TNG pUTTAVONG
AC=AP/(BLxCA)

OTTOoU:

. AC egivai n petaBoAn TNG ouykévipwong (ug/m?),
. APt gival n yetaBoAf Tng pdacag Tou puTtTou (ug),
. BL €ival To Uyog Tou oplakoU oTpWHAToS (m), Kai
. CA cival n reploxn MEAETNG (mM?).

H 1TocooTiaia BeATiwon TnG TTOIGTNTAG TOU A€Pa UTTOAOYICETAI e TOV TUTTO:

E¢iowon 6 YtmoAoyiopdg TmoocoaoTiaiag BEATiwoNnG TG TToIGTATAG TOU AEPa
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AC = APH/(APt+Pa)

otrou Pa €ival n yaZa Tou pUTTou oTAV ATHGCEAIPA, N OTToIO UTTOAOYICETAI WG N
OUYKEVTPWON PUTTWYV (Ug/m?3) €TTi TO UPOG TOU OPIOKOU OTPWHATOG KAl TNV ETTIPAVEIX
TNG TTEPIOXAG.

2.5 EpyaAgia

2.5.1 Aoyiouiké I-Tree Eco model kai cuAAoyR Sedopévwv

To i-Tree Eco eival éva AOyIOPIKO TTOU XPENOIKMOTTOIEITAI YIa TV agIOAGYNon Kal TN
dlaxeipion Twv aoTIKWY dacwv. AvaTTuxOnke amd 10 Apepikavikdé AGCog, TO
MaveTmoTAPIO TG Zupakouong kal aAAoug cuvepydTeg. [20]To i-Tree Eco trapéxel
O1d@popa epyaAcia kal JOVTEAQ yia TN HETPNON Kal TNV a&loAdynon TwV OIKOAOYIKWYV Kal
OIKOVOUIKWY OQEAWV TTOU TTapéxouv Ta aoTiIKA &don. Mepikég atmd TIGC BACIKEG
AeiToupyieg Tou i-Tree Eco mrepiAauBdvouv:[21]

* YmoAoyioudg Tou dykou Tou ddooug: To i-Tree Eco utropei va uttoAoyioel Tov
OYKO TWV BEVTPWYV KaI TWV dACIKWY TTOPWV O€ AOTIKEG TTEPIOXEG.

*  A&ioAéynon Tng uyeiag Tou ddooug: AvaAulel TNV KaTdoTaon Twy dEVTPpWY, TNV
KATAoTaOT Tou £6AQOUG Kal GAAOUG TTaPAYOVTEG TTOU £TTNPEAJOUV TNV UYEia TOU
ddooug.

*  YmoAoyioudg Twv o@eAwv TOU BAo0UG: YTToAoyilel Ta OIKOAOYIKA Kal
OIKOVOMIKA OQEAN TTOU TTPOCPEPOUV TA ACTIKA dACN, OTTWG N Opoaoid, N Peiwon
TNG ATHOCPAIPIKAG PUTTAVONG, N aTTOpPOPNON Tou AvBpaKa, Kal AAAQ.

+  2xedlaoudg  Tpoypouudtwy  diaxeipiong: BonBd oTtov  oxedlaoud
TTPOYPAPUATWY BlaxXEipIoNg TwV ACTIKWY dACWV PE OTOXO Tn PBeATiwon Tng
UYEiag TOUG Kal TN PEYIOTOTTOINON TWV OPEAWY TOUG.

To i-Tree Eco xpnoIgOTIOIEiTAI KUPIWG aTTO (POPEIG TNG TTOANG, ApXEG TTPOCTACIOG TOU
TEPIBAANOVTOG, €peuvNTEG Kal AAAOUG evBIAQEPOPEVOUS YIa Tnv dlaxeipion Kal T
dlatipnon Twv acTikwy dacwv. EmTpétel T Awn TTANPOQYOPIWY TTOU PTTOPOUV VO
BonBrioouv otn AQWn atro@Aacewy OXETIKA e TN SIAXEIPION TWV ACTIKWY TTPACIVWV
XWPpwV Kal TN BeAtiwon Tng 1mo1éTnTag (WG OTIG aoTIKEG TTEpIoXEG .To i-Tree Eco
XPNOIUOTIOIEI HABNUATIKA JoVTEAQ yIa va afloAoynoel Ta acTikG ddon Kal Ta 0QEAN TTOU
mapéxouv. O1 Baoikoi uttoAoyiopoi Tou Bacifovral e padnuatikd povTéAa
mepIAapBavouv:[19]

YmroAoyiopog Tou Aciktn Aévipwyv (Tree Index): AuTtdg o d€ikTng HETPA TOV OYKO TWV
OEVTPWY O€ JIa QOTIKN TTEPIOXN KAl XPNOIUOTTOIEI HABNUATIKA HOVTEAQ YIA VO EKTIMACEI
TOV OYKO auTOV G KUBIKG TTOdIa ) KUBIKA PETPA.

YmoAoyiopdg NG Atmoppdenong AvBpaka (Carbon Sequestration): To i-Tree Eco
XPNOIYOTIOIEl HABNUATIKA POVTEAQ yia va ekTIuAoEl TTéoo AvBpaka atroppo@olv Ta
OévTpa atrd TNV ATUOCPAIPA PECW TNG PWTOOUVOEDNG.

Y1roAoyiopog T1ng Meiwong 1ng ATuoo@aipikAg Putravong (Air Pollution Reduction): To
AOyIOpIKO XPNOIYOTTOIEl HaBnuUATIKG UJOVTEAQ yIO va EKTIUACEI TTOON ATUOCEAIPIKA
putravon (6TTwg d10&gidio Tou AvBpaka Kal ogidia Tou alwTou) agalpeital amd Ta
OévTpa.AuTd Ta pabnuatik@ pgovTéAa Bacifovtal o eKTEVA £pEUVNTIKA dedopéva Kal
OTaTIOTIKEG PEBOOOUG TTOU avaAUouv Tn OXE0on METALU TWV XOPAKTNPIOTIKWY TWV
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OEVTPWYV, TOU TTEPIBAAAOVTOG KAl TWV OIKOAOYIKWY o@eAwV. Me Tn Bondeia auTtwyv Twv
HovTéAwv, To i-Tree Eco TTapéxel TTOAUTIUEG TTANPOQOpPIEG yia Tn dlaxeipion Kal Tn
dIaTAPNON TWV ACTIKWY dAcWV Kal TN PeATiwon NG TToIdTNTAG (WG OTIG AOTIKEG
mepioxég. O Acgiktng Aévipwv (Tree Index) Tou i-Tree Eco uttoloyiCeTal
XPNOIUOTIOIWVTAG  €va  PaBNPOTIKO PovTéAo TTou  AauBdver utmown  OIdQopEg
TTOPAPETPOUG TTOU OXETiCovTal e Ta OEvipa oe AoTIKEG Treploxég. O1 Baaoikoi
TTOPAYOVTEG TTOU XPNOIYOTTOIOUVTAl YIO TOV UTTOAOYIONO Tou Acgiktn Aévipwyv
TTepIAaPBAvouV:

1. Noodtnta Aévipwyv (Number of Trees): Auth €ival n Ouvolikfy TTOOOTNTA TWV
OEVTPWY O MIO CUYKEKPIYEVN AOTIKN TTEPIOXH. To ovTEAO AauBavel utTdwn Tov aplBud
TWV OEVTPWY O€ AUTHV TNV TTEPIOXH.

2. Aevipik KédAuwn (Tree Canopy): Autdg 0 TTapAyovTag avag@épeTal 0TV TToocoTNTA
TNG EMQAVEIAG TTOU KOAUTITETAI ATTO TN OKIA Twv O&vipwy. O1 ddokaAlol cuvABwg
METPOUV TN BEVTPIKA KAAUWN WG TTOCOOTO TNG CUVOAIKNG ETTIQAVEIAS TNG TTEPIOXNG.

3. AlagopeTikd Eidn Aévipwv (Tree Species): O1 didg@opol TUTTOI SEVTPWY £XOUV
OIaQOPETIKI) duvaTOTNTA VA TIAPEXOUV WEEAEIEG, OTTWG OKId, aTTOpPOPNCN TOU
AavBpaka, Kal PEiwan TNG aTHooPaIpIKAG pUTTavoNnG. To YovtéAo Aauavel uttown Ta
O1d@opa €idn OEVTPWY TTOU UTTAPXOUV O€ JIa TTEPIOXNA Kal TNV TTO0OTNTA TOUG.

4. MéyeBog Twv Aévipwv (Tree Size): To péyeBog Twv dEVTPWY, TTOU PTTOPEI va
METPNOBEI oe UWog, TTePIPEPEIO KOPHOU Kal GAAa  xapakTnpioTikd, emrnpeddel Tn
ouvaToTtnTé TOoUug va TTapéxouv oQEAn. Ta peyaAitepa dévipa £xouv Tn duvaTtdTNTa VA
atmmoppoPolV TTEPICCOTEPO AVOPaKA Kal va TIapEXOUV TTEPICOOTEPN OKIG.To
MaBnuaTtikd poviéAo uttoAoyilel Tov Aciktn Aévipwv ouvdudloviag autoug Toug
TapdyovTteg Kal uttoAoyioviag évav apiBuntikd Oeiktn TTOU AVTITTPOCWTTEUEl TN
onpacia Twv OEVIpwY O MIA ACTIKA TTeEPIoX. AuTég o Oeiktng pTTOpEl  va
xpnoigotroinBei yia tnv afloAdynon Tng uyeiag Tou acTikou ddooug Kal Tnv Afyn
QTTOPACEWY OXETIKA WE Tn diatrpnon kai Tn diaxeipior) Tou.To i-Tree Eco xpnoiyoTrolEi
éva paBnuatikd poviéAo yvwoTd wg "Movrtédo Atroppodenong AvBpaka" (Carbon
Sequestration Model) yia va uttoAoyilel Tnv TT000TNTa AvOpaKa TTOU ATTOPPOPATAI ATTO
Ta 0évipa. Autd To povTéAo BaacileTal o€ BACIKESG ApXES TNG WTOCUVBECNG KAl TOU
KUKAOU TOou GvBpaka oTov Quoikd KOopo. O1 KUplEG TTapAUETPOI Kal PEBodol TTou
XPNOIUOTIOIoUVTAl CUVABWG a€ auTd To HOVTEAD TTEPIAQUBAvVOUY Ta €ENG:

1. AidBeon 1n¢ Pwreivig Evépyeiag: To poviéAo AapBavel utrown TNV EVEPYEIQ TOU
nAiou TTou @TAvel OTOV QUTIKG TTANBUOUOG (BévTpa) Kal TTWG auTA n evépyela
XpnoigoTrolgital Katd Tn dIdpKeIa TG pwTooUvOeonc.

2. AidBeon 1ou Aiogeidiou Tou AvBpaka (CO2): To povréAo AauBdver umméyn tnv
014Beon Tou CO2 oTOV ATHOOPAIPIKO AEPA, CUUTTEPIAAMBAVOUEVWY TWV EKTTOUTTWV
atrd TIG AVOPWTTIVEG dPaCTNPIOTNTEG, KAI TTWG TO BI0EEIDIO TOU AvBpaka armoppo@drTal
aTTo Ta QUTA KATA TNV WTOOUVOEDN.

3. AvdAuon 1n¢ Bioudlac Twv Aévtpwy: To povtéAo agloAoyei Tn Blopdada Twv dEVTPWY,
TTOU QVTIOTOIXEI OTOV OYKO TwV OEVTPWY KAl OTNV TTOCOTNTA TOU ATTOPPOPNUEVOU
avBpaka.

4. Yuvieheotég Aroppdpnong CO2: To PYOVTEAO XPNOIKOTIOIET £10IKOUG OUVTEAEDTEG
TTOU QVTITTPOOWTIEUOUV TNV TTo00TNTa Tou CO2 TTOU aTTOPPOPATAl ava HOVAda
Biopddag Twv dEVTPWV.
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Baoikd, 10 JovTéAo uTTOAOYICEI TNV aTTopPOPnon Tou diogeldiou Tou dvBpaka atrd Ta
Oévipa pe Bdon Tnv evépyela Tou AapBdvouv atmd Tov NAI0 KATd TN OIAPKEID TNG
pwtoouvBeong kai Tn diaBsocipdétnTa Tou CO2 oTov ATHOOQAIPIKG aépa. AuTd Ta
HovTEAQ BonBouv va ekTIPNBEI TO OIKOAOYIKO OQEAOG TWV ACTIKWY dACWY OTNV HEIWON
TOU AvOpaka OTNV ATHOCGAIPA KOl VA TTAPEXOUV TTOAUTIMEG TTANPOPOPIES yia TN
dlaxeipion Toug.

MNa Tov uttoAoyiopud TNG MEIWONG TG aTUOOQAIPIKAG puTtravong, 1o i-Tree Eco
Xpnoigotrolei pabnuatik& poviéAa TTou BaoifovTal OTIS apxE€G TNG XNMEIAG Kal TG
QUOIKAG. AUTA TO HOVTEAQ EKTIMOUV TN PEIWON TWV PUTTOYOVWYV QEPIWV KAl CWHATIOIWV
OTNV aTNOC@AIPA TTOU OQPEIAETAI OTNV TTAPOUTia Kal TN OpacTnPEIOTATA TWV OEVTPWY OE
QOTIKEG TTEPIOXEG. AUTA Ta povTéAa Aaupdvouv uttOown TOUG TOUG TTAPOKATW
TTAPAYOVTEG:

1. NoodtnTta Aévipwyv Kkai Eidog Aévipwv: To i-Tree Eco mpétrel va yvwpilel Tooa
OEVTPA UTTAPYOUV O€ IO QOTIKN TTEPIOXN, TO €i00G TOUG Kal To PEYEBOS Toug. AuTd Ta
oToIXeio eival onuavTIKA yia va UTToAoyioTeEl n duvatdétnTa Twv OEVIPWY Vva
QTTOPPOPrIOOUV PUTTOYOVA aéPIal.

2. Nooooté KédAuwng 1ou Aévtpou (Crown Cover Fraction): Autd To JETPO ava@EépETal
OTO TIO0000TO TNG ETMQPAVEIQG TIOU KOAUTITETAI aTmd TN OKIA Twv OEVTPWV.
XpnolyoTrolgital yia va uttoAoyioTei n em@dveia Tou eTnpeddetal atrd Ta SEVTPA Kal
TN PEiWOoN TNG OTHOCYAIPIKAG PUTTAVONG.

3.2uvteAeoTéc  Meiwong  1ng  Atpgoo@aipikig Puotravong: AuToi Ol OUVTEAEOTEG
Baocifovtal 0¢ €MOTNUOVIKEG MEAETEG KOl TTEIPAMATA KAl TTAPEXOUV TTANPOQPOPIES
OXETIKA HYE TN MEIWON TNG ATHOOQYAIPIKAG PUTTAVONG TTOU TTPOKOAEITaI aTTd Ta dEVTPQ,
avaAoya pe To €idog Tou BEVTPOU Kal AAAEG TTAPANETPOUG.

4, Exmmoutréc Putravrikwyv  Aegpiwv: To poviéAo Aaudavel uttoyn TIG EKTTOPTIEG
OTHMOC@AIPIKWY PUTTAVTIKWY aepiwv  atrd didgopeg TNyEG, OTTWG  aQuTOKivNTa,
Biounxavieg, K.ATT.

Ta mapamdvw padnuatikd povréAda ocuvdudlovTtal yia va UTToAoyioouv Tn Jeiwaon Tng
OTMOO@AIPIKAG PUTTAVONG TTOU OQEIAETAI GTNV TTAPOUGIA TWV OEVTPWY CE€ HIO ACTIKNA
mepioxr. Auth n ueiwon pttopei va agopd Tn ueiwon Tou Siogeidiou Tou &vBpaka
(CO2), Twv oteidiwv Tou alwtou (NOXx), Tou 6lovtog (O3), kal GAAWV PUTTAVTIKWV
aEpiwv.

To |-Tree Eco mapéxel mn duvatdomta cicaywyns did@opwy HETABANTWY yia Tnv
afloAdynon aoTikwv dacwyv. ZTo0 TAQioI0 autig TNG OITTAWMATIKAG €pyaciag,
TTPayMaTOTTONBNKE N €I0aywyn dedOPEVIWY TTOU AVTATTOKPIVOVTAlI OTOUG TTAPATTAVW
eTMAeyuévoug Oceikteg, OTTwG TrpoTeivovial otn BiBAloypagia. Autd T1a &edouéva
Xpnoigotronénkav yia Tnv agloAdynon tou TTépkou Twv Ayiwv ATTooTOAWV.

O1 peTaBAnTég TTOU €TIAEXONKAV TTEPIAAPBAVOUV:

» [evikég TTANPOPOPIES YIa TV TOTTOOETIA
- XpAon yng (Land use) :TUTTog XpAonG yng TnNG TTEPIOXNG MEAETNG.
- ZTpwya (Strata/area):YTrokaTnyopia oTnv OTToia XwpPieTal n TrEPIOXN
MEAETNG.
- ZuvreTaypéveg Xaptn (Map coordinates):Mewypa@ikd urkog Kai TTAATog
TNG TTEPIOXAG MEAETNG.
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» Agdopéva TTou oXETICOVTAI HE TA XAPAKTNPIOTNKA TWV SEVTPWYV

Eidn (Species): Auti n TTAPAPETPOG OTTAITEI TOV KABOPIOWO Kal TV
KATaypa@r] Twv ovOUATwy Twy £10WV KABE dEVTPOU.

AiqueTpog koppou (DBH): Avagépetal 6T SIGUETPO TOU KOPHUOU €VOG
OEVTPOU OE OUYKEKPIUEVO UWog atmd T Pdon Tou. To DBH cival n
ouvTopoypagia Tou "Diameter at Breast Height," 1Tou ek@pddlel Tn
OIAUETPO o€ UYWog ouviBwg, TTou opileTal ota 1.4 yétpa ammo 1 Bdon
Tou &évTpou.(BA. Eikéva 8)

DBH
at narrowest
point below fork

DBH
just above
butress

- DBH
just above
deformity

DBH
at narrowest
point below
wihorls

Eikova 8 EmiAoyn onueiou uétpnong tng S1auéTpou Tou OEVTpoU
avaAoya pe Tov TUTTO TOU KOPLOU TOU

2UVOAIKO Uwog &évipou (Total tree height): To Uywog ammd 10 £6a¢og
MEXPI TNV KOPUQT) TOU BEVTPOU, €iTE aUTA €ival (wvTavr) €iTE vekpr.
MéyeBog koung (Crown size): Mpdkertal yia 1o PEyeOOG TNG KOUNG TOU
Oévipou, Tou KkaBopiletal ammd Ta @QUAAQ, Toug Ppayxioveg, Toug
uttoBpaxioveg kal Ta KAadid Tou. H pétpnon Tou peyéBoug yivetal e
Baon Ta TTapakATw CTOIXEIA.

Ywog péxpl 1 Baon tng koung (Height to crown base): To Owog ammod
TO €0a@og PéEXP! TN Bdon TNG Cwvtavhg KOUNG. Z& autiAv Tn WEAETN,
utroBéoape OTI avTioToiXei oTa % TOU OUVOAIKOU Uyoug Tou
O0évtpou.(BAEIKOvVa 9)
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3 Tree height H

P o
e diameter’Cy Crown length CL

Crown base height CBH

(b)

Eikéva 9 Ta diagopetikd Uywn tTwv SévTpwy TToU armmaitouvral va gloax8oulv ora dedouéva

Ywoc¢ Lwvrtavou dévipou (Live tree height): To Uwog atmd 10 £6agog
MEXPI TN wvTavh Kopu@r Tou d€vTpou. Adyw TnG KOARG KaTaoTaong
Twv  Oévipwyv, Bewprbnke 00 Pe TO OUVOAIKO UWog Tou
oévtpou.(BA.Eikéva 9)

MAGToC  KéUNG (Crown width): To TAdTO¢ Tng KOPNG o€ OUO
Kateubuvoelg: Bopeia-voTia Kal avatoAn-ducon. H pérpnon yivetal
BewpwvTtag TNV KOUN WG KUKAO, e TO TTAATOG i00 pe Tn SIAUETPO TNG
KOMNG (Gvolypa KOPNG).

Katdotaon (kéung) (Condition): H ekTipnon tng katdotaong 1NG KOPNG
Kataypd@eTal wg T0 TTOCOOTO TNG KOUNG TTOU aTtToTeAEITal ATt Eepd
KAadid, 6mmou 10 100% avTioToixei o€ TTAPN atmmowidwon. MNa Tov
TPoodIopIoud TNG uyeiag TNG KOPNG Twv OEVIpwY OTNV &V AdYyW
OIMTAWMATIKA epyaacia, eMAEXBNKE N TTPWTN METABANTA TNS atTowilwong
(Dieback).EmitAéov, Adyw TnG €€aupeTIKAG KATAOTAONG TNG UYEIAg NG
KOUNG TV OEVTPWY OTNV TTEPIOXN MEAETNG, ETTIAEXONKE TO TTOOOOTO 0%
atmmoyilwong (Dieback), TTou utrodnAwvel Tnv atmouaia Enpwyv KAadIwv
KAl avTIOTOIXEI O€ APIOTN KATAOTAON UyEiag, oUPNPWVaA PE TO AOYIOMIKO
I-Tree Eco.(BA.Eikéva 10)
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Vigor
class

oz live o, live
235% crown = 35% crown
" Lower
dieback
excluded

< 35% live
crown
40% A Vigor
normal class
foliage 2
b
]
D= Severe
< 20% &?{ defoliation Vigor
0
normal m/‘% Everv needle class
foliage Y 3
> 50% chewed

Eikéva 10 lNpocdiopiouds mooooToU KEVWY KOUNS

- 'EkBeon 1ng kKOUNG oTtov NAIo (Crown light exposure): MeTpwvTag Tov

apIBuo6 TwV TTAEUPWV TTOU EKTIBeVTAI € NAIOKK aKTIVOBOAia, éTTou To
MEyioTo TTARBOG ival 5 ayu') 10 eAdxioTo 0.(BA.Eikéva 11)

Eikéva 11 mpoadiopiouos ¢ EKBEoNS TN KOUNS aTov nAio

MNa va atmmoktnBouv Ta atrairoupeva dedopéva attd 1o Aoyiopiké |-Tree yia 10 TTAPKO
Twv Ayiwv ATToOTOAWY, aTTAITHONKE N TTAPATAPNON KAl KATAYPAPr) TOUG OTO TTEdIO.
XpnoiyotroliwvTag dopupopikd dedouéva oto QGIS yia Tig B€o€Ig Twv dEVTPpwWY aTTd TO
Epyaotpio Aounpévou lMepiBdAlovTog kai Alaxeipiong Evépyeiag Tou MoAutexveiou
Kpntng, Tpayuatotrointnke oUykpion TG TTANPOQOPIag yia TIG BECEIG Twv OEVTPWV.
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EmmimmAov, TTpaydaToTTOINBNnKav PETPAROEIS OTo TTEdIO I TO UYOG, TNV TTEPIYETPO TOU
KOpMOU Kal Tn OIGUETPO TNG KOPNG ava €idog dévipou. Ta €idn Twv dEVTpwvY
avayvwpioTNKav HECW QWTOYPAPIWY KaBw¢ Kal atrd OXETIK  avalAtnon oTo
d1adikTuo. Na Tov uttoAoyiouo Tou DBH TOU évTpou XpNOIMOTTOIRONKE pedoupa YE TNV
OTTOIO METPNBNKE N TTEPINETPOG TOU KOPUOU Tou BEVTpoU ot UYog Trepitrou 1,4 m atrd
TO £00(Q0G. EVW yia Tov UTTOAOYIOUO TOU UYoug Tou BEVTPOU £YIVE XPron UETPNTH HUE
Aé1Cep oxnUaTiCovTag £va €IKOVIKO TPIYWVO, atTd TNV BACN TOU OEVTPOU WG TNV KOPUYN.

2.5.2 AiloBnTiipeg Senstick kal cuAAoyn dedopévwyv

MNa TNV KaTaypaer Twv TIHWV TwV BEPUOKPACIWV KAl TNG Uypaciag oTnv TTEPIOXNA
MEAETNG TOTTOBEeTABNKAV TTévie QIoBNTAPEG Senstick yia TOug TPEIG WrVEG Tou
KaAokaipioU. AKOAOUBET EIKOVA PE TO XOPAKTNPIOTIKA Twy aiodntrpwyv Senstick (

Eikéva 12)
Enclosure
Weight 120q w/ batteries /170 g with batteries
Dimensions 18Bmm x 210mm
Materials UV stable plastic, ALU casing, stainless steal mesh
IP rating IPBS

Operating conditions

Temperature -40°C to +85°C

Humidity 0to 100% RH

Power supply

Battery type 2 x 1.5V AaaA Alkaline

Expected operation <7 years (depending on sampling, signal, environment)

Configuration

Sending interval Configuration via NFC and downlink
Data upload interval Configuration via NFC and downlink
NFC configuration Mative Android App

Eikova 12 livakag ue 1a TEXVIKG XapakTnpioTIKA Tou aigbntipa Senstick

O (sensor 1) avagépetal oTov AICONTAPQ TTOU €ival TOTTOBETNUEVOG OTNnV B€0n NG
TTaIdIKAG XapAag, 0 (sensor 2) cival TOTTOBETNUEVOS OTO TTAPKIVYK TNG TTApaAiag Twv
Ayiwv AmmootéAwv |, (sensor 3) eival avaueoa o€ TTUkvO dacUAAIO Kal o (sensor 5)
BpiokeTal evidg Todoo@aipikou ynmrédou. O (sensor 4) gival o aiobnTipag Trou eivai
TOTTOBETNUEVOC O€ PAVTPA AUTOKIVITWY N oTroia BpiokeTal eKTOC TTPACIVOU XWPEOU
ApxIka, divetal 0 unviaiog pécog Opog TNG nUEPNOIag WEYIoTNG Bepuokpaaciag.
KaBévag atrd Toug TpEIG KAAOKaIPIVOUG MPRAVEG, atrd Toug aiobnthpeg 1, 2, 3 kai 5
TOTTOBETNUEVOUG OTOUG XWPOUG TTpaacivou Tou. (BA.Eikéva 13
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Eikéva 13 XapTng HE TIG BECEIC TWV aioBNnTAPWY OTO TTAPKO Twv Ayiwv atTooTOAWV

2.5.3 PopnTdg TPITTOOIKOG METEWPOAOYIKOG OTABUOG yia Tn METPNON
METEWPOAOYIKWYV TTAPAMNETPWYV KAl CUAAOYN BESONEVWV.

MNa pia mo oAokKANPWHEVN HEAETN TNG TTEPIOXNG TOU TTépKoU Twv Ayiwv ATTOOTOAWY
EMAEXTNKAYV OUO nuepounvies (13 kair 14 louliou) étTou eTmIKpaTOUCAV OUVONKEG
KaUowVa PE OKOTTO TNV ATTOTUTTWON KIAG TTIO EUKPIVAG EIKOVAG WG TTPOG TNV KATAYPA®N)
Kal oUykpIor Twv HEYIOTWY Bepuokpaciwy. Mo ouykekpigéva oTo SIAOTNPO QUTO
TIPayHaTOTTOINBNKAV PETPNOEIG O OEKA OIOPOPETIKA ONUEIa TOU TTAPKOU ,TPEIG KUKAOI
METPAOEWYV TNV KABE pépa .H TpwTn péTpnon paypatotromenke atd Tig 7:30 - 10:00,
n deutepn atmo Tig 14:00 - 15:30 kai n 1pitn a11éd 116 19:00 - 21:00. O popnTdS TPITTODIKOG
METEWPOAOYIKOG OTABUOG cival €va TTOAudpyavo XeIpog ME TIG €EAC OUVONKEG
Aeiroupyiag kai TexVIKé XapaktnpIoTIKA. (BA Eikéva 12)

2UuvBnKeg Aermoupyiag:

o Beppokpaacia Asitoupyiag: -10...+60°C.

e Ogpuokpaaoia amodrikeuong: -25...+65°C.

>xeTikA vuypaoia: 0...90%R.H., xwpig ouptTukvwon.
006vn LCD: 128x64 pixel (56x38 mm)

Al0B€Tel 086vVN ypa@IKWV Kal aveEdpTnTEG £10060UG OTTOU CUVOEOVTAI OI TTAPAKATW
QVIXVEUTEG:

> TP3207.2 AiobntApag péTpnong Bepuokpaaciag Enpou BepuopETPOU

O aioBnTpag d1abETel T aKOAOUBA XOPAKTNPIOTIKA:

- akpiBela: katnyopia 1/3 DIN

- eUpog péTpnong: -40°C €wg 100 °C

- avéAuon: 0.1°C

- yeTatoTion Bgpuokpaaiag otoug 20°C: 0.003% /°C
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- peTtatdTmion petd atod 1 £€10¢6: 0.1°C /éT0G
- dlooTdoelg: =14 mm kai L= 150 mm

- Xpévog atokpiong T95: 15 Aetrtd

> HP3201.2 AiobnTApag péTpnong Bepuokpaciag uypou BepUoUETPOU
O aioBnTRpag d10BETel Ta akGAOUBA XOPOKTNPIOTIKA:

- oKpiBeia: katnyopia A

- eUpog péTpnong: 4°C £wg 80°C

- avaAuon: 0.1°C

- peTatdTmion Bepuokpaciag otoug 20°C: 0.003% /°C

- yeTaToTmion PeTd atmd 1 £€10¢: 0.1°C /é10G

- dlaoTdoelg oTeAéxous: @=14 mm kai L=170 mm

- MKkog TTAegoUdag: 10 cm TouAdyIoTOV

- XwpnTIKOTNTA deCapevns: 15 cm3

- autovopia deapevng: 96 wpeg pe RH=50% ka1 t = 23°C
- Xpovog ammokpiong T95: 15 Aetrtd

> TP3276.2 AioBnTipag pérpnong Tng BepuikAg akTivoBoAiag (AlcOnTrpag
BeppopéTpou opaipwy P=50 mm)

O aioBn1Apag S1aBiTel Ta akOAOUBO XOPOKTNPIOTIKA:

- AkpiBeia: Katnyopia 1/3 DIN

- eUpog péTpnong: -10 €wg 100 °C

- avéAuon: 0.1°C

- yeTatoTmion Bgpuokpaaciag otoug 20°C: 0.003% /°C

- yeTaToTmion YeTd atd 1 £10¢: 0.1°C/€T0C

- dlooTdoelg oTeAéExous: D=8 mm kai L= 170 mm

- Xpbvog atrokpiong T95: 15 Aetrta
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Eikova 13 . Qwroypagics tng 01ataéng rou popnrou TpirTodikou
HETEWPOAOYIKOU oTaBlIoU aTrd 10 EPYACTNPIO

Eikéva 14 diséaywyn uérpnong ammé Tov eopnTto UETEWPOAOYIKO oTaBuo
oro medio

Ta déka onueia TTou TTapoucIGfovTal OTOV TTAPOKATW XAPTN EMAEXBNKAV PE yvWuova
TNV avlpwTrivn dpacTnpPIOTEPA TTOU AaPBAvEl HEPOG OTO EKACTOTE XWPO TOU TTAPKOU
KaBwg €TTioNg Kal aTn QUTIKA KAAUWN Kal TO €8a@IKO avayAuPo TnNG TTEPIOXNG MEAETNG.
Juykekpiyéva Ta onueia A kai F givar eviog rapaliog 61Tou 18iwg Toug KAAOKaIpIvoUg
MAVEG TTOPATNEEITAI  €VIOVOG OUVWOTIOMOG KOl TTPAYMOTOTTOIOUVTAl  OPKETEG
dpaaTNPIOTNTEG, YIa aUTO TOV AOYO KpiBnke OKOTTINO va An@OoUv PYETPACEIG OE OnUEio
ME Kal Xwpig okid. ETriong petproeig mépOnkav ota onueia C ,D kal H 61mou uttdpyxouv
TTEPITTATNTIKA POVOTTIATIA €VW TO €id0G TOU €0APOUG OTTWG Kal N TTUKVOTNTA TWV
O0évOpwV TTOIKIAEI aTTd onueio o€ onueio. TEAOG UETPAOEIG TTPAYUATOTTIOINONKAY OTA
onueia B, E,J,G ommou cuvteAoUvTal KOIVWVIKEG OpacTnPIOTNTEG Kal TTaPATNPEITAI
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OUVWOTIOPOG KOBWG KAl JOPPOTToinon TOO0 Tou £8APOUG OCO Kal TNG TTUKVOTNTAG TWV
oévipwv.(BA. Error! Reference source not found.)

Eikéva 15 Xaprng¢ rou mapkou Twv Ayiwv ATTooTéAwv O1Tou gaivovrai o déka BEaeIC Twv
HETPNOEWV aTTO TWV TPITTOOIKO aIgonTHpa

2.5.4 Agiktng MoiétnTag MNMpacivou

AUTOG 0 B€ikTnG PETPNONKE HE TNV dnuioupyia evog CUVTOUOU £pWTNUATOAOYiOU TO
oTToio atravtitnke atmod 83 TToAiTeEG Kal atToTeAciTal atrd £€1I EpWTACEIG TTOU OXETICOVTAI
ME TNV agloAdynon Tou TTédpKou Twv Ayiwv ATTOOTOAWYV a1Td Toug TTOAITEG. O1 EpWTATEIG
QUTEG OTTOOKOTTOUV OTnV CUAAOYR TNG Ammowng Twv TTOANITWV OXETIKA WeE BEparta
aIo0ONTIKAG, XPWHATWY ,00UWYV , AXOU TOU TTAPKOU KaBWG £TTiIONG Kal o€ BéuaTta TTou
Qa@OpPOUV TNV TTPOCRACINOTATA TOU Kal To €TTiTTEd0 ao@dAciag TTou aigcBdvovtai ol
ToAiTeEG o€ autd. To AoyliopIKO TTOU XpnolgotroinBnke yia Tnv eaywyr Twv
OTTOTEAECUATWY KAl TWV SlaypappdTwy gival To excel .
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3. AtroteAéopara:

3.1 AtroTeAéopaTa SEIKTWV KAIJATIKAG AVOEKTIKOTNTAG

3.1.1 AmoteAéopara yia Tov O€iKTn TNG HEONG Mpnvidiag TIMAG TG
NUEPNOI0G NEYIOTNG BEpOKpOTiag

2€ QUTAV TNV VOTNTA, TTAPATIOEVTAI O JEOEG INVIAIEG PEYIOTEG TIMEG TWV BEPUOKPATIWV
TTOU KaTaypagnkav tov louvio, Tov IoUAI0 Kal Tov AuyouoTo Tou 2023, atrd Toug
alIoONTAPES TTOU gival TOTTOBETNUEVOI OTO TTAPKO TWV Ayiwv ATTOCTOAWV .

Mivakag 3 Méoeg pnviaieg TIHEG TWV NUEPNOIWV MHEYIOTWY BEPPOKPATCIWY YIa TOV
TTPACIVO XWpPo Tou TTépKou Twv Ayiwv ATTOGTOAWV

Monthly mean value of daily max Temp-Green Space

SENSOR 1 SENSOR 2 SENSOR 3 | SENSOR 5 | GS-average
June 28.39 26.24 26.78 27.70 27.28
July 34.14 31.77 32.14 33.41 32.87
August 33.28 30.52 31.75 31.12 31.67
AVERAGE | 31.94 29.51 30.23 30.55 30.56

Omrwg diammoTtwenke, n péon uwnAdTepn Bepuokpacia yia GAoug Toug aloBnTAPES
Kataypd@Tnke Tov urpva lovAio (34.14 °C), (31.77 °C), (32.14 °C) kai (33.41 °C) evw
0l XaunAOTEPEG BepoKpaaies yia GAoUG Toug aioBNnTAPES Kataypd@tnkav Tov louvio
(28,39°C),(26.24 °C),(26.78 °C) kai (27.70 °C) avriotoixa .O1 SIOKUPAVOEIG OTIG
KaTaypagég TnG Beppokpaaciag ummopolv va amodoBolv oTa QUOIKA XOPAKTNPICTIKG
TWV QVTIOTOIXWV BECEWY TwY a1I0ONTAPWY, OTTWG 0 TUTTOG TOU £€BAPOUG Kal N TToCOTNTA
NG BAAoTnOoNG . MNa TTapddeiypa, o aiobnTipag 2 £xel ToTroBeTNOEi o€ TTUKVO SAGUAAIO
EVTOG TOU TTAPKOU Kataypd@ovTag €10l TIG EAAXIOTEG BeppoKpacieg atrd dAoug Toug
a1I00NTAPES Kal OTOUG TPEIG MAVEG. AvTiOeTa 0 aiocOnTrpag 1 £xel ToTToBeTNOEI 0€ onueio
otnv TaIdIKA Xapd O€ PN OKIGOPEVO ONMEIO, OUVETTWG  KOTOYPOQEI  MEYIOTEG
Bepuokpacieg. Autd Ta cupAuOTa OUVABOUV HE Ta OUVOAIKA aTTOTEAEOUATA yia TOV
XWPO TTpaacivou, 6TTou N uwnAdTepn Péon Bepuokpaaia kataypdenke Tov louAio (32,87
°C) kai n xapnAdtepn Tov louvio (27,28 °C)(BA .Mivakag 3)

Katotmv, Tmapoucidlovial Ol PECEG dnVIaieG TIMEG TwV NUEPNACIWV  HEYIOTWYV
Bepuokpaciwy KABe evdg ammd Toug Tpeic WAVEG TNG Bepivig TTepIOdOU aTTd TOV
aiobnmpa 4 TTou TOoTTOBETABNKE OTa 600 pETPpa £€w aTTd TOV TTPACIVO-UTTAE XWPEO
(BA.Error! Reference source not found.) kai Tov peTEwWpoOAOyIKO OTOBUS TTOU
BpiokeTal TOTTOBETNUEVOC OTO KEVTPO Twv Xaviwv. ‘Evag pécog 6pog yia To GUVOAO Tou
OOTIKOU XWPEOU UTTOAOYIOTNKE KAl TTPOCTEONKE €TTIONG OTA ATTOTEAECPATA TOU
mivaka.(BA. Mivakag 4)
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Eikoéva 16 Mérpnan tng amméaTact) Tou onueEiou EKTOS TTOACIVOU XWPOU UE TO TTAPKO

Mivakag 4 Méoeg unviaieg TIMEG TWV NUEPACIWY PEYIOTWY BEPUOKPATIWY VIO TOV OOTIKO
XWPO £¢w aTTd TO TTAPKO TwV Ayiwv ATTOOTOAWY

Monthly mean value of daily max Temp-Urban Space

Sensor 4 Meteorol. Station US-average
June 27.98 27.53 27.75
July 33.41 33.34 33.38
August 32.89 31.95 32.42
AVERAGE 31.42 30.94 31.18

Katd Tnv avdAuon Twv 6edopévwy attd Tov TTivaka, TTPOKUTITEI 0TI 0 aioBNnTrApag 4 Kal
0 METEWPOAOYIKOG OTABOGS KaTEYpaWav SIAPOPETIKEG HECEG TIMEG TOU HEGOU OPOU TWV
MEYIOTWVY NUEPATIWY BEPUOKPATIWY KATA TOUG MNAVES loUvio kal louAlo.

JUYKEKPIYEVA, O a10BNTAPAG 4 KaTéypawe TN uwnAdTEPN PECN TIWA KATA TOV pAva
louAio, epgavifovtag Tn péyioTn péon nueprola Bepuokpacia Twv 33.41°C, evw TN
XOUNAOTEPN MEONn TIUA Katéypawe Tov pAva louvio pe Beppokpacia 27.98 °C.
AvTioTOIXQ, O HETEWPOAOYIKOG OTABUOG TTapouciaoe Tn JEYOAUTEPN PECN TIMA KATA TOV
louAio pe 33.34 °C kai T XapnAdtepn kaTd Tov lolvio pe 27.53 °C.

O1 d1a@opég auTéG pETAlU Twv dUO PETPNTIKWY CNUEIWY PTTOPOUV VA EPUNVEUTOUV UE
didgopoug TpoéTTouG. Katapxdg, n Totrobeaia Tou aioBntipa 4 €KTOG TOU KEVTPOU TWV
Xaviwv, o€ avtiBeon Pe TOV JETEWPOAOYIKO OTABUS TTOU BPIOKETAI EVTOG TOU KEVTPOU,
MTTOPEI va €xel ETTIOPACN OTIG PETPNOEIG AOYW BIOPOPETIKWY KAIMATIKWY OUVONKWV.
EmmAéov, o TUTToG Tou auioBnTtpa etmiong dia@épel, eTTNPEAZOVTAG TNV aKPIBEIa Twv
METPACEWV.

JUVETTWG, Ta OTToTEAéOUATA KATADEIKVUOUV OTI N PEYIOTR Péon pnvidia TIUA Twv
MEYIOTWY NUEPATIWY BEPUOKPATIWY EPPaViel TN peyaAuTePn TIKK ToV louAio (33.38°C),
ME TN XaunAdTEPN va onuelwvetal Tov louvio (27.75 °C), 6mmwg amodideTal oTIg
TTOPATTAVW TTAPATNPACEIG
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3.1.2 AmroteAéopaTta yla Tov OEiKTn Tng ATTOOAKEUONG Kol SECHEUONG
avlpaka otn BAGoTnOoN

Bdon Twv amoteAeoudTwy TOU AoyiouikoU I-Tree Eco, n eTAola déousuon GvBpaka
atro Ta OEVTPA OTO TTAPKO Twv Ayiwv ATTOOTOAWVY eKTIUATAI OTI POAVEI TTEPITTOU TOUG
23 16voug. To didypaupa TTou TTapAyeTal amd TO AOYIOUIKO TTapouaiddel TNV €TACIA
akabdpiotn dEoueEUO AVOPAKA YO TA €iON AOTIKWVY BEVTPWY TTOU £XOUV TN MEYOAUTEPN
IKavoTNTa dETPEUONG.

2TOV TTAPOKATW TrivaKka, TTapaTtifetal n PeTdppaon Twv €I0WV TwV OEVTIPWY TTOU
Tapouciddovtal oto didypappa. O1 ovoupacieg TTou Ba xpnoigoTtroinBouv yia Tov
oxoAhiaoué cival ota eAAnVIkKA. Na onueiwBei 611 oto didypauua TTapoucidlovial Ta
OEVTPa UE TNV KOIVI TOUG ovouaaoia Kal OxI ME TNV ETTIOTAOVIKI OVOUATOAOYia TToU
xpnoigotroindnke oto povtéro. (BA.Mivakag 5)

Mivakag 5 . MeTtd@pacon Twv KOIVWV OVOUACIWY TwV OEVTPWY Tou TTApKoU Twv Ayiwv
ATTO0TOAWY

Koivl ovopacia dévrpou oTnv ayyAikn Koivij ovopacia dévrpou ota EAAnvVIKA
Aleppo pine Meuko

Blue gum eucalyptus EukdAuTtiTog

African tamarisk AApupiK

African olive EANG

White poplar AeUka

Canary island date palm Poivikag

Carbon Sequestration

12.00
10.00
8.00
6.00

4.00

Sequestration (tons)

2.00

0.00
Aleppo pine Blue gum African African Olive  White poplar Canary island
eucalyptus tamarisk date palm

Species

Eikéva 17 Ekriuwyevn erioia mooornta 6éoueuans akabapioTou avBpaka o€ paBdous yia Ta
€idn aoTiKwv OEVTPWY TOU TTAPKOU TwV Ayiwv ATTOOTOAWYV LE TNV LUEYAAUTEPN IKQVOTNTA
Oéoueuong avepaka.

2UPQwWva Pe To TTAPATTAVW BIAYPAUMA ,TTPOKUTITEI OTI O EUKAAUTITOG Kal 1 XOAETTIOC
TTEUKN BEOEUOUV TN PEYOAUTEPN TTOCOTNTA AvBpaka £TNaiwg TTepiTTou 10 TOVOUG TO
KGO €idog. To aApupiki deapevel AiydTepo atmd 2 TOVoug AvOpaka Tov XpOVo VW Ta
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uttoAoItTa €idn (eNIEG ,AEUKEG ,@OIVIKEG) deOpeUlOUV OXEDOV QUEANTEEG TTOOOTNTEG
avepaka .(BA.Eikéva 17)

EmimrAéov, 10 Aoyiouikd |-Tree Eco ekmiud Ot 1a dévipa OTO TIAPKO TWV Ayiwv
AtTo0TOAWV atmoBnkeuouv cuvoAlikd 1100 Ttévoug dvBpaka. To oxeTikd didypauua
TTAPOUCIAZEl TNV EKTIMWUEVN TTOOOTNTA aTToBriKeuong avBpaka avd €idog dévtpou. MNa
EUKOAIO OTnNV KaTtavonaon, TapaTtifeTal mTiong N HETAPPAOT TWV €I0WV JEVTPWY TTOU
TTapoucidadovTal oTo dIAYPAN KA

Mivakag 6 Metd@paon Twv 18wV Tw dEVTPWY oTa eAANVIKA

Koivj ovopacia dévrpou oTnv ayyAikn Koivij ovopacia dévrpou ota EAAnvVIKA
Aleppo pine Meuko

Blue gum eucalyptus EukdAuTITOg

African tamarisk AApuUpiKI

African olive EANG

White poplar AeUKa

Canary island date palm Poivikag

Carbon Storage

Blue gum Aleppo pine African African Olive  White poplar Canary island
eucalyptus tamarisk date palm

Species

Eikova 18 Ekmiuwpevn ammobnkeuon avepaka yia 1a €idn acoTikwyv OEVIpwWYV UE TN HEYAAUTEPN
arrobnkKeuan yia 10 TTAPKO TWV ayiwv armooTéAwv

H peyaAitepn pe diagopd ToodTNTA AVOPOKA TTOU aTToBNKEUETAI TTPOKUTITEl GTTO TOV
EUKAAUTTTO, eKTIHWHEVN O€ TTEPiTTOU 800 TOVOUG .ZTNV CUVEXEIQ AKOAOUBEI, N XOAETTIOC
TeUKn OeopelovTag oxeddv 200 tévoug dvBpaka .TéEAoG akoAouBouv Ta uttdAoITTa
€idn dévtpwyv deouevovTag TrEPITTou 9 TOVOUG AvVaAUOVTAG TA ATTOTEAECUATA POG OF
TTocooTiaia KAigaka eEdyoupe 6TI 0 EUKAAUTITOC aTToBnKEUEl TO HEYAAUTEPO TTOCOOTO
avOpaka, avTioTolxwvTtag o€ TePITTou 81%, n xaAetog eukn 18% kai Ta utTOAOITTO
€101 avtioToixei 10 TT0000TO Tou 1%. (BA.Error! Reference source not found.)

36



3.1.3 AtroteAéopaTta yia ToVv Maykéopio 0eppIkd KAIPATIKO BEIKTN
(Universal Climate Thermal Index- UTCI)

2T0 KEQAAQIO QUTO TTAPOUCIACOVTAI T ATTOTEAECPATA TTOU TTPOEKUYAV ATTO TN XProN
TOU AOYIOMIKOU YIa TOV TTPpOoodIopIoud Tou MNMaykoouiou OeppikoU KAiyaTikoU AegikTtn
(UTCI). OT1rwg Trepleypd@nKe TTPONYOUUEVWG OTO Ke@AAalo 2.3.3, ol TIMEG TNG
Bepuokpaciag UTCI avTioToixouv o€ pia KAiJAKa TTOU UTTOBNAWVEI TNV avOpwITIivn
katatrévnon  amd TN Ogpuokpacia Tou TTEPIBAANOVTOG. T va dleuKOAUVBEi n
Katavonon Twv oTToTEAEOUATWY, TTPOCTEDNKAV QVTITTIPOCWTTEUTIKA XPWHATA OTOV
Tivaka, ETITPETTOVTAG TNV EUKOAGTEPN KATNYOPIOTTOINGN TWV BEPUOKPATIWY OE OXEON
Me Ta eTTiTTEdA KaTatTovnong. (Mivakag 7)

Mivakag 7 AvTioToixion Twv Bepuokpaciwv UTCI pye 10 Babud tng avlpwirivng
Katatrévnong amd 1N Bepuokpacia Tou aépa TTEPIBAAAOVTOG, TTapouaidlovTal Ta
OXETIKA QVTITTPOCWTTEUTIKA XPWHATA:

Eupog UTCI (°C) Karnyopia karamrévnong
Mavw amd +46 Akpaia BepuIkA Katammévnon
+38 éwg +46 MoAU évtovn BepyIKr KATaTTOVNON
+32 éwg +38 loxupn BepuIkr KaTatrévnon
+26 éwg +32 MéTpia BeppikA Katamévnon

+9 £wg +26 Kauia BepuikA katatrévnon

0 éwg +9 EAappd wuxpn karatrévnon

-13 €wg 0 Métpia wuxpn karamrévnon

-27 €W -13 loxupr] wuxpr Katamévnon

-40 €wg -27 MoAU 1oxUpr Wuxper Katamévnon
KaTtw a6 -40 Akpaia yuypr Karamoévnon

ApxIkd, TTapouciGleTal O TTivakag TTou TTEPIAaUBAvEI TIG TIHES TwV Bepuokpaciwy UTCI
yia k@Be nuépa Tou prAva louviou. O1 PeTPACEIS TTPayUATOTTIOINONKAY ATTO TOUG
aiocbnmpeg 1, 2, 3 kai 5 mou ToTTOBETHBNKAY OTOV TTPACIVO XWPO TOU TTAPKOU TWV
Ayiwv AtmootéAwv (BAéme Trivaka .Ta atmoteAéoparta TTPoékuyav HE T Xpron
AOYIOUIKOU, Ye BAon TIG MEYIOTEG NUEPNOIES BEPUOKPATIES TOU agépa Kal TIG TIWEG TNG
OXeTIKAG uypaciag (RH%) katd 1n péyiotn nuepnola Bepuokpacia. ETTTAéov,
UTTOAOYIOTNKE O PHECOG OPOG TWV NUEPROIWY Beppokpaaciwy UTCI yia To gUvoAo Tou
TPACIVOU XWPEOU KOl TTPOCTEBNKE €TTIONG OTA OTTOTEAECUOTO QuTOU TOU TTIVOKA.
MapduoIEG TAKTIKEC avAPOPAS ATTOTEAECUATWY TTAPOUCIACOVTAl Kal YIO TOUG MIVEG
loUAI0 Kal AUyouoTo, OTTWG TTEPIYPAPETAI OTOUG TTIVOKEG.
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Mivakag 8 Oeppokpaacieg UTCI Tou TTPACIVOU XWEOU YIa ToV driva louvio

GS
June SENSOR 1 SENSOR 2 SENSOR 3 SENSOR 5 mean
mean | mean

Max Max Max Max max rh uTCl

Temp | RH UTCI | Temp | RH UTCI | Temp | RH UTCI | Temp | RH UTCI | temp
1 25.47 | 62.27 | 26.20 | 24.68 | 68.03 | 25.7 | 24.6 65.14 | 25.5 | 25.8 57.15 | 26.2 | 25.14 63.15 | 25.9
2 21.2 78.73 | 22.60 | 19.23 | 86.91 | 20.9 | 19.71 | 84.26 | 21.3 | 21.03 | 76.25 | 22.2 | 20.29 81.54 | 21.8
3 26.06 | 58.89 | 26.50 | 24.76 | 64.56 | 25,5 | 24.95 | 65.72 | 25.9 | 26.59 | 53.64 | 26.8 | 25.59 60.70 | 26.2
4 25 60.78 | 25.50 | 23.34 | 67.04 | 24.2 | 24.45 | 66.92 | 254 | 27.05 | 33.76 | 25.9 | 24.96 57.13 | 25.3
5 21.61 | 66.83 | 22.30 | 20.44 | 7256 | 21.4 | 23.88 | 65.52 | 24.6 | 24.72 | 55.83 | 24.9 | 22.66 65.19 | 23.3
6 27.26 | 64.05 | 28.50 | 24.34 | 72.91 | 25.7 | 24.19 | 71.64 | 255 | 24.88 | 66.84 | 25.9 | 25.17 68.86 | 26.4
7 25.3 70.65 | 26.60 | 23.7 7795 | 25.3 | 24.01 | 59.11 | 244 | 24.73 | 70.46 | 25.9 | 24.44 69.54 | 25.6
8 26.54 | 65.11 | 27.60 | 23.97 | 74.03 | 25.3 | 2493 | 71.03 | 26.2 | 25.45 | 66.29 | 26.4 | 25.22 69.12 | 26.4
9 28.52 | 49.86 | 28.70 | 25.7 57.46 | 26.1 | 26.38 | 53.92 | 26.6 | 27.92 | 40.61 | 27.3 | 27.13 50.46 | 27.2
10 29.87 | 50.4 | 30.20 | 27.22 | 60.29 | 28 28.28 | 64.95 | 29.6 | 28.88 | 47.93 | 28.9 | 28.56 55.89 | 29.2
11 28.23 | 62.86 | 29.40 | 26.69 | 65.94 | 27.9 | 27.47 | 69.86 | 29.1 | 28.27 | 53.8 | 28.7 | 27.67 63.12 | 28.8
12 28.38 | 64.71 | 29.80 | 25.67 | 70.8 | 27.1 | 25.61 | 74.09 | 27.3 | 27.32 | 65.09 | 28.6 | 26.75 68.67 | 28.2
13 27.95 | 60.79 | 28.80 | 25.63 | 69.21 | 26.9 | 26.46 | 65.8 | 27.5 | 26.46 | 65.92 | 27.5 | 26.63 65.43 | 27.7
14 28.36 | 55.67 | 28.90 | 26.02 | 68.45 | 27.3 | 25.69 | 69.78 | 27 26.23 | 63.45 | 27.1 | 26.58 64.34 | 27.6
15 30.02 | 47.38 | 30.20 | 29.18 | 50.47 | 29.4 | 29.06 | 50.03 | 29.3 | 29.93 | 43.48 | 29.7 | 29.55 47.84 | 29.7
16 28.62 | 50.79 | 28.80 | 26.65 | 58.92 | 27.2 | 27.02 | 66.43 | 28.3 | 28.13 | 54.07 | 28.6 | 27.61 57.55 | 28.2
17 27.38 | 51.6 | 27.50 | 26 56.93 | 26.4 | 26.65 | 59.28 | 27.3 | 27.47 | 52 27.6 | 26.88 54.95 | 27.2
18 27.77 | 60.75 | 28.60 | 24.96 | 71.76 | 26.4 | 26.3 6781 | 27.6 | 26.5 62.42 | 27.4 | 26.38 65.69 | 27.5
19 28.44 | 60.77 | 29.50 | 25.88 | 71.73 | 27.3 | 26.18 | 70.05 | 27.7 | 27.16 | 60.9 | 27.9 | 26.92 65.86 | 28.1
20 29.48 | 63.49 | 31.00 | 26.86 | 69.77 | 28.4 | 27.71 | 66.79 | 29.1 | 28.23 | 455 | 28 28.07 61.39 | 29.1
21 30.4 49.73 | 30.90 | 27.8 58.18 | 28.5 | 29.1 45.11 | 29 29.37 | 40.31 | 28.3 | 29.17 48.33 | 29.2
22 31.06 | 47.53 | 31.30 | 29.67 | 50.42 | 29.9 | 28.21 | 54.84 | 28.7 | 29.72 | 52.33 | 30.2 | 29.67 51.28 | 30.0
23 31.74 | 52.41 | 32.60 | 27.73 | 65.06 | 29 28.74 | 61.96 | 29.9 | 29.74 | 49.41 | 30.1 | 29.49 57.21 | 30.4
24 31.05 | 47.7 | 31.30 | 28.44 | 53.84 | 28.8 | 30.27 | 39.97 | 29.8 | 30.73 | 41.86 | 30.5 | 30.12 45.84 | 30.1
25 31.22 | 50.91 | 31.90 | 28.51 | 59.45 | 29.4 | 29.02 | 60.83 | 30.1 | 30.63 | 38.46 | 30.1 | 29.85 52.41 | 30.4
26 31.72 | 54.34 | 32.80 | 28.4 66.9 [30.1 | 28.38 | 65.98 | 29.8 | 29.78 | 53.98 | 30.5 | 29.57 60.30 | 30.8
27 30.09 | 58.63 | 31.20 | 28.61 | 64.6 | 30 28.2 66.2 [ 29.7 | 28.9 59.2 [ 29.9 | 28.95 62.16 | 30.2
28 31.71 | 60.17 | 33.50 | 28.56 | 69.31 | 30.4 | 29.63 | 47.7 | 29.8 | 30.16 | 44.31 | 30 30.02 55.37 | 30.9
29 31.15 | 51.79 | 3240 | 29.39 | 54.82 | 29.9 | 31.03 | 58.9 | 325 | 30.86 | 44.38 | 30.8 | 30.61 52.47 | 31.4
30 30.17 | 57.71 | 31.10 | 29.06 | 61.01 | 30.2 | 27.28 | 67.66 | 28.6 | 28.37 | 57.24 | 29 28.72 60.91 | 29.7
MEZOZ
OPOZ 28.39 | 57.91 | 29.21 | 26.24 | 65.31 | 27.29 | 26.78 | 63.24 | 27.77 | 27.70 | 53.90 | 28.03 | 27.28 60.09 | 28.07

Omrwg TTPoKUTITEl ATTO TOV TTAPATIAVW TTivaka, o aiodntipag 1 yia Tov pAva louvio
katéypawe 25 Bepuokpacieg UTCI mou avTioToixouv oTnv KaTnyopia Tng HETPIAG
BepuIKAG KaTaTTOVNONG , 3 Bepuokpacieg TTou utTodnAwvouv avuttapéia BePUIKNAG
KATaTrévnong Kal 2 PJETPROEIG TTOU avTIoToIXoUV G€ 1oXupr] BepuIkn Katattévnon . H
MéyioTn Bepuokpaaia UTCI mapatnpendnke tTnv 29n nuépa tou uiva (32.4 °C), evw n
eAGxioTn Kataypdenke TNV 2n nuépa (22.3 °C)

O aioBnmpag 2 yia Tov prva louvio, o otoiog €ival TOTTOBeTNUEVOG €VTOG TTUKVOU
daouMiou oTo TIApKO Twv Ayiwv ATTOOTOAWV , KATEYPAWE TIG XAMNAOTEPEG
Beppokpacieg UTCI Adyw Tng TTUKVAG BAGOTNONG OTNV TTEPIOXN. ZUYKEKPIMEVA, 8
METPAOEIG BEpUOKPATiag avTioToIXoUV 0€ CUVONKEG UNOEVIKAG BEPUIKAG KaTATTOVNONG,
Kal ol uttoAoITTeG 22 o€ ouvOnkeg péTpiag Bepuikng katatmrévnong . H péyiotn
Beppokpacia UTCI kataypaenke v 28n nuépa Tou prva (30.4°C), evw n eAaxioTn
Kataypdanke TNV 2n nuépa (20.4°C).

O aiobntipag 3 yia Tov urjva louvio katéypawe 22 Bepuokpacieg UTCI Tou TpokaAouv
METPIO BeppikA KaTatrévnon ,7 MPETPNOEIG TTou  Ogv TTPOKOAOUV Kaouia OgpuIkn
KATatmmovnon &vw POvo uia Tou TTpokaAei uwnAl. H péyiotn Bgpuokpaacia UTCI
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Kataypd@nke TNV 29n nuépa Tou uiva (32.5 °C), evw n eEAAXIOTN KaTaypa@nke Tnv 2n
nuépa (21.3 °C).

O aiobnmipag 5 karéypawe 25 Bepuokpacieg UTCI 1Tou TTpOoKaAOUV PETPIO BEPUIKA
KATATTOVNON €VW O UTTOAOITTEG 5 dev TTpoKaAoUV  Kapia Beppiki katarrévnon. H
MEyioTn Bepuokpaacia UTCI kataypdenke Tnv 29n nuépa tou prva (30.8 °C), evw n
eAGXIOTN KOTAYPAPNKE TNV 2n nuépa (22.2 °C).

TéAog, o uttoAoyIoudG Tou péoou dpou Twy Bepuokpaciwyv UTCI yia Tov TTpaaivo Xwpo
OAOKANpou Tou prva louviou deixvel 611 To 83.4% TWV PETPHOEWY AVTIOTOIXOUV O€
OUVOAKEG PETPIAG BEPUIKAG KATATTOVNONG VW TO 16.6% OeV TTPOKAANECE KAUia BEPUIKN
katatrévnon,. H peyaAutepn Bepuokpacia UTCI yia Tov prjva lolvio, otov TTpAcIvo
XWPOo, Kataypdenke otnv 29n nuépa kal ATav 31,4°C, evw n xaunAdTepn Bepuokpaacia
Kataypd@nke atnv 2n nuépa Tou priva kail Atav 21.8°C. (BA

Mivakag 8)
Mivakag 9 Ogppokpacieg UTCI Tou TTPACIVOU XWEOU Yia Tov diva louAio
July SENSOR 1 SENSOR 2 SENSOR 3 SENSOR 5 mean
mean | mean
Max Max Max Max max th UTCl
Temp | RH UTCI | Temp | RH UTCI | Temp | RH UTCI | Temp | RH UTCI | temp

1 31.72 [ 55.54 286 [72.93[30.8 [29.42 |67.47[31.3 [30.95 [51.85|31.8 |30.17 [61.95

2 35.83 | 32.81 33.2 [ 38.09 [ 881 | 32.23 [39.34 3499 [31.23 34.06 | 35.37

3 31.35 [ 54.02 29.72 [61.06 | 31.2 [31.8 |59.56 54.09 | 31.5 [30.86 [57.18

4 31.52 [59.21 28.47 [ 70.22 | 30.5 | 29.38 | 68.7 55.9 29.93 | 63.51

5 33.04 [ 44.64 29.57 [62.84 |31 30.58 [ 58.8 31.26 [ 52.83

6 34.41 [41.31 306  [53.43[31.4 [31.69 |54.01 3221 [ 4757

7 35.06 [ 39.93 31.78 | 48.26 33.22 [ 46.73 33.59 [ 41.90

8 33.3  [49.01 31.88 [ 57.39 32.55 [ 57.24 3265 [51.14

9 32.02 [ 40.09 30.67 [50.65|31.1 [29.95 |54.73[30.8 |30.69 [44.97 |30.8 |30.83 [47.61 312
10 31.35 [49.98 30.03 [50.42 |30.4 [2822 |6251[29.4 |30.32 [50.39|30.8 |29.98 [53.33]30.7
11 32.82 [50.62 30.98 [45.15|31.1 [30.61 |41.73[304 |31.29 [40.03|30.9 |3143 |[44.38]316
12 32.78 | 54.73 30.29 [62.29|31.9 [30.29 |59.94 31.17 [58.22

13 33.68 [ 56.17 31.54 [543 32.83 [57.02 32.87 [ 50.20

14 36.09 [30.51 34.85 [ 34.22 36.05 [34.31 3585 [31.95

15 36.19 [47.71 33.83 [ 4152 35.89 [45.21 3572 [ 4051

16 30.35 [60.72 28.15 [ 66.35 | 29.6 | 28.06 | 68.13 30.05 [57.96

17 36.22 | 28.41 31.72 [32.76 [ 30.2 [ 32.33 | 31.03 32.86 [ 33.94

18 34.86 | 37.98 32.31 [41.31 32.31 [ 40.46 33.30 [ 38.99

19 34.51 | 40.63 32.21 [ 49.85 32.21 [ 49.48 33.05 [ 44.61

20 34.69 |41.37 31.65 | 50 33.05 | 43.03 33.29 [ 44.36

21 36.28 | 29.79 34.16 | 36.46 35.62 [39.79 35.75 [ 33.29

22 35.87 [46.1 3259 [52.8 33.29 [ 56.84 34.44 [ 49.31

23 38.97 [ 29.94 36.04 [ 36.94 36.49 [ 30.29 37.70 [ 29.85

24 35.42 | 56.18 32.67 | 57.42 34.25 | 60.15 34.12 [ 55.10

25 35.86 | 38.58 32.05 [54.93 32.53 [58.78 33.84 [ 44.30

26 42.01 [21.34 38.98 [ 21.39 38.21 [21.89 40.25 [ 20.56

27 35.26 | 22.06 35.06 | 23.27 34.64 | 23.17 35.08 |[22.15
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28

32.63

42.46 | 32.80 | 31.73 | 42.62 | 32 32 42.89 321 | 31.65 | 36.77 | 31.1 | 32.00

41.19

32.0

29

28.75

61.19 | 29.90 | 28.12 | 64.23 | 294 | 27.95 |65.89 | 28.3 | 31.22 |53.62 | 321 | 29.01

61.23

29.9

30

30.35

57.08 | 31.40 | 29.28 | 62.16 | 30.7 | 28.92 | 64.94 |30.4 |30.28 |52.36|30.9 | 29.71

59.14

30.9

31

35.19

42.18 | 35.90 | 32.08 | 43.6 | 822 | 29.89 |63.99|31.6 |30.04 |52.63|30.6 |31.80

50.60

32.6

MEXOX
OPOX

34.22

43.56 | 34.85 | 31.87 | 48.86 | 8247 | 32.23 | 50.02 | 33.10 | 33.49 | 39.19 [ 38.51 | 32.96

45.41

33.48

2UPQWVA PE TOV TTAPATTAVW TTivaKa, 0 alo8nTApag 1 katéypawe yia Tov uAva louAio 5
Bepuokpacicg UTCI otnv KaTtnyopia TG HETPIAG BEPUIKNG KATATTOVNONG,24 UETPNOEIG
o€ 10XUpr BEPUIKA KATATTOVNON, KAl 2 HETPACEIG O€ TTOAU 10XUPN BEPUIKA KATATTOVNON.
H péyiotn Beppokpacia UTCI mou katéypawe o aiobntipag 1 Atav 42°C tnv 26n
nuépa, evw n eAdxiotn ATav 29.90°C tnv 29n nuépa.

O aioBnmpag 2 yia Tov prjva louAio, o oTroiog eival TOTTOBeTNUEVOG €VTOG TTUKVOU
0aouMiou oTo TApko Twv Ayiwv ATOOTOAWV , KATEYPAWE TIG XAUNAOTEPEG
Bepuokpacicg UTCI Adyw Tng TTUKVAG BAAOTNONG OTNV TTEPIOXN. ZUYKEKPIUEVA
katéypawe 13 petproeig Bepuokpaciag UTCI otnv KaTtnyopia TNG PETPIOG BEPUIKAG
Katatrévnong,17 HETPNOEIS I0XUPAS  BepuIKAG  KaTatTdvnong EVW MOANG 1
QVTIOTOIXOUOE O€ TTOAU £vTovn BepuiknA kaTtatrévnon. H péyiotn Beppokpacia UTCI 1Tou
Katéypawe o aiodntpag 2 ATav 38.5°C tnv 26n nuépa, evw n eAdxiotn Atav 29.6°C
TNV 29n nuépa.

O aiobnmpag 3 katd Tov prva lovAio katéypawe 10 Bepuokpacieg UTCI TToU
TTpoKaAOUV METPIO BepuIKh KaTATTOVNON Kal ol ummoloimmeg 21 Bepuokpaaieg
QVTIOTOIXOUV O OUVBRKES 10XUPNG BEPUIKNAG KaTatTovnong. H uéyiotn Bepuokpacia
UTCI 1mou katéypawe o aiodntipag 3 Atav 36.80°C Tnv 26n nuépa, evw n €AaxIoTn
ATav 28.3°C Tnv 9n ka1 Tn 29n nuépa.

O aiobnmpag 5 katd Tov prva louAio katéypawe 10 Bepuokpacieg UTCI TToU
TTPOoKaAOUV HETPIO BeppIK  Katammovnon 29 Bepuokpacieg 10XUPNG BEPMIKAG
KATaTrévnong Kai JOAIG 2 TTou TTpoKaAoUv TTOAU éviovn Bepuikh kaTtarmovnon . H
MéyioTn Bepuokpacia UTCI mrou katéypawe o aiobntipag 5 Atav 41.2°C v 26n
nuépa, evw n eAdxiotn ATav 30.6°C Tnv 31n nuépa.

AvaAoyika pe Tov utToAoyIoud Tou pécou 6pou Twy Beppokpaaiwv UTCI yia Tov pAva
louhio, Tapartnpeital 611 10 19% aQvTIOTOIXEI O€ OUVONKEG WPETPIAG BEPMIKAG
KaTatmovnong, 10 77.78% o€ oUuVvBNKEG I0XUPNG BEPUIKAG KATATTOVNONG, Kal JOAIG TO
3.22% o€ oAU évtovn katatrévnon. H péyiotn Bepuokpacia UTCI yia Tov pyfiva louAio
o€ 0AGKANPO TOV TTPACIVO XWPEO KaTaypdenke Tnv 26n nuépa (39.8 °C) kai n eAAXIOTN
Vv 10N nuépa (30.7°C).(BA Mivakag 9)

Mivakag 10 O¢ppokpaaciec UTCI Tou TTpdcivou Xwpou yia Tov priva AlyouoTto

August

SENSOR 1 SENSOR 2 SENSOR 3 SENSOR 5 mean

Max
Temp

Max Max Max max
RH UTCI | Temp | RH UTCI | Temp | RH UTCI | Temp | RH uTCl | temp

mean
rh

mean
UTClI

34.08

50.49 | 35.20 | 30.31 | 61.68 | 31.9 | 30.53 |59.72 | 31.9 | 29.8 52.89 | 30.4 | 31.18

56.20

32.4

34

51.47 | 3540 | 31.77 | 5551 | 329 | 31.54 | 62.71 | 334 | 29.56 | 53.16 | 30.2 | 31.72

55.71

33.0

34.4

46.37 | 35.30 | 31.9 52.82 | 33 32.73 | 57.54 | 344 | 29.32 | 53.42 | 29.9 | 32.09

52.54

33.2

35.11

48.26 | 36.40 | 32.44 | 52.54 [ 33,5 | 32.8 58.84 | 34.8 | 29.08 | 53.69 | 29.5 | 32.36

53.33

33.6

34.57

50.57 |135.90 | 32.23 | 49 32.9 | 33.05 |49.91 | 34 28.84 | 53.95 | 29.3 | 32.17

50.86

33.0

o (01 | W N |

32.72

46.58 | 33.20 | 30.97 | 51.13 [ 31.6 | 31.56 | 61.32 [ 333 | 28.6 54.22 1 29.1 | 30.96

53.31

31.8
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7 33.09 | 49.69 29.9 53.49 | 30.8 | 30.52 | 5457|314 |31.16 |46.06 |31.3 | 31.17 50.95 | 31.9
8 33.19 | 56.08 29.6 65.12 | 31.4 | 31.25 | 56.34 30.49 | 62.07 31.13 59.90

9 32.23 | 43.48 30.55 |47.64|30.8 | 29.74 |54.67|30.4 | 30.29 |47.07 | 30.5 | 30.70 48.22 | 31.0
10 33.2 39.92 29.29 | 5329 |29.9 |29.82 |5575|30.6 |30.18 |44.8 |30.2 | 30.62 48.44 | 31.0
11 30.39 | 56.06 | 31.40 | 30.09 | 52.09 | 30.6 | 29.41 |49.39 | 29.7 | 29.77 |51.31]30.2 | 29.92 52.21 | 30.5
12 31.65 | 43.82 30.00 48.24 | 30.3
13 31.17 | 54.02 29.61 58.28 | 30.7
14 31.22 | 56.87 30.13 59.71 | 31.3
15 32.23 | 55.57 30.69 59.79

16 32.26 | 58.7 31.37 61.79

17 33.22 | 52.95 31.86 58.81

18 34.14 | 47.29 30.62 57.60

19 34.13 | 41.42 32.72 44.88

20 32.95 | 53.73 31.53 49.41

21 33.49 | 50.03 31.81 56.28

22 33.27 | 54.74 31.68 59.02

23 32.43 | 60.06 31.48 61.36

24 34.16 | 39.17 33.41 42.54

25 35.34 | 34.6 34.10 36.96

26 34.41 | 43.96 33.75 42.52

27 33.54 | 39.09 32.80 44.58

28 33.31 | 49.45 31.96 51.83

29 36.51 | 41.38 35.42 38.26

30 32.74 | 42.82 31.13 51.03

31 3245 | 42.47 31.59 47.68
MEZOx

OPOX | 33.25 | 48.35 31.68 51.87

2UPQWva PE T TTOPATIAVW OTOIXEID, O aIoBNTAPAG 1 KATEYpAWE 2 UETPAOEIG TWV
Bepuokpaciwv UTCI Tov AlyouaTo avkouv GTn YETPIa BEPUIKN KATATTOVNOT), VW Ol
uttodoireg 29 avTtioToixoUv o€ 1oxupr) Bepuikr) katatrévnon. H uwnAdtepn
Bepuokpaaia kataypdenke otnv 29n nuépa (37,4 °C), evd n XaunAdTEPN ONUEILONKE
otnv 11n nuépa (31,4 °C).

O aioBnmMpag 2, katéypawe 22 petprioelg ato Tig Bgpuokpacieg UTCI o1 otroieg
KATAaTGoOoOVTal OTNV KaTnyopia Tng PETPIOG  OepuIKAG KaTattévnong, kabwg kai 9
puetpAoelg  Bepuokpaciag UTCI pe uywnAn Bepuikn katammévnon. H uywnAdtepn
Beppokpacia kataypdenke TNV 29n nuépa (34,1 °C), evw n xaunAdTepn TNV 12n nuépa
(29 °C).

O aioBnmpag 3, karéypawe 10 petproeis amod Tig Bepuokpacieg UTCI o1 oTroieg
KOTATAOOOVTAl OTNV KATNyopia TNG METPIOG BepUIKAG kaTtatrévnong, Kabwg kal 21
petpAoelg  Beppokpaciag UTCI pe uwnAn OBepuikr) katamévnon . H uwnAoTepn
Beppokpaaia kataypdenke TNV 29n nuépa (35,7 °C), evw n xapnAdTepn TNV 12n nuépa
(29,7 °C).
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O aicbnmpag 5, katéypawe 15 perprocig amd TIg Beppokpacieg UTCI o1 oTroigg
KatatdooovTal OTNV Kartnyopia Tng HETPIOG BepUIKAG KATATTOVNONG, KABwG Kal 16
peTproels  Bepuokpaciag UTCI pe uwnAn Beppikh katamovnon . H uywnAdTepn
Beppokpaaia kataypdenke TNV 29n nuépa (34,1 °C), evw N xaunAdTepn TNV 12n nuépa
(29,7 °C).

TéNoG, 0 péoog 6pog Twv Bepuokpaciwv UTCI yia Tov Tpdoivo xwpo deixvel 6T TO
38,7% TwV PYETPHOEWV AVTIOTOIXOUV OE METPIO BEPUIKR KATATTOVNON, EVW TO UTTOAOITTO
61.2% avTioToixei oe uywnArl. H uwnAdtepn Bepuokpacia yia Tov TTPACIVO XWPEO
Kataypdenke TNV 29n nuépa (35,63 “C), kal n xaunAdtepn v 12n nuépa (30,3 °C).

AkoAouBei o TTivakag pe TIG TIHEG TNG Bepuokpaoiag UTCI yia kdBe nuépa Tou piva
louviou. O1 peTpnoeig TTpayuaToTToInBnkayv atrd Tov aiodnTPa 4, TTOU £yKATaoTAONKE
oe¢ amootacn 600 pétpwv £Ew amd TOov TPACIVO XWPO KABWS Kal amd Tov
METEWPOAOYIKO 0TaBUS Twv Xaviwv o0 0TT0iog BpioKeTal OTO KEVTPO TNG TTOANG . AUTOG
0 TTiVaKAG €ival onUAvTIKOG yia Tnv agloAdéynon g BepuikAg aioBnong oTov aoTIKO
XWpo, kabwg e&etadlovral ol TiuEG Tou UTCI yia did@opeg nUEPES €gdyovTag
CUMTTEPAOUATA YIO TOV GOTIKO XWPEO KAl CUYKPIVOVTAG TOV E TOV XWPOo TTpaacivou .(BA
Mivakag 10)

Mivakag 11 Oeppokpacieg UTCI Tou aoTIKOU XWEOU yia Tov priva louvio

us

SENSOR meteo
June 4 station

Max Max MEZH MEZH METIXTH | MEZH

Temp RH UTCI | Temp RH UTCI | UTCI OEPMOKPAZIA AEPA RH
1 28.17 58.41 | 29 25.5 56.05 | 28.1 28.55 26.84 57.23
2 21.29 83.43 | 23 21.4 78.42 | 22.2 22.6 21.35 80.9271
3 25.84 60.41 | 26.4 27 59.33 | 26 26.2 26.42 59.87
4 25.49 65.55 | 25.4 27.2 63.02 | 25.2 25.3 26.35 64.285
5 22.87 72.66 | 21.8 24.4 70.80 | 21.5 21.65 23.64 71.73
6 25.39 70.41 | 26.7 24.4 69.20 | 21.3 24 24.90 69.805
7 24.95 58.92 | 25.4 25.5 57.01 | 25.2 25.3 25.23 57.965
8 25.46 69.12 | 26.7 25.6 67.84 | 25.9 26.3 25.53 68.48
9 27.82 53.51 | 28.1 26.4 57.21 | 26.9 27.5 27.11 55.36
10 29.37 51.36 | 28.7 29.4 59.99 | 30.5 29.6 29.39 55.675
11 27.68 62.51 | 28.8 27.3 62.65 | 28.3 28.55 27.49 62.58
12 27.08 70.97 | 28.7 26.4 63.74 | 27.3 28 26.74 67.355
13 26.83 69.51 | 28.3 27.4 58.9 28.1 28.2 27.12 64.205
14 26.96 66.71 | 28.2 26.3 55.22 | 26.6 27.4 26.63 60.965
15 31.26 47.27 | 31.5 28.6 50.22 | 28.8 30.15 29.93 48.745
16 28.12 54.02 | 28.6 29.1 65.16 | 30.7 29.65 28.61 59.59
17 26.86 55.36 | 27.2 28.2 54.41 | 28.7 27.95 27.53 54.885
18 26.48 68.56 | 28 26.3 58.44 | 26.8 27.4 26.39 63.5
19 27.28 68.17 | 28.8 26.8 49.86 | 26.7 27.75 27.04 59.015
20 28.93 64.88 | 29.3 27.8 4771 | 27.7 28.5 28.37 56.295
21 30.67 46.25 | 30.8 29.1 46.85 | 29 29.9 29.89 46.55
22 31.1 50.62 | 31.7 29.7 46.07 | 29.7 30.7 30.40 48.345
23 29.9 58.31 | 31 29 50.77 | 29.3 30.15 29.45 54.54
24 30.74 51.62 | 30.2 29.6 39.81 | 29.1 29.65 30.17 45,715
25 31.59 46.35 | 31.9 29.9 39.6 29.4 30.65 30.75 42.975
26 29.73 60.32 | 31.1 29.1 56.08 | 29.9 30.5 29.42 58.2
27 30.07 58.77 | 31.1 28.8 60.18 | 29.9 30.5 29.44 59.475
28 30.11 67.56 | 32.1 29.1 48.17 | 29.2 30.65 29.61 57.865
29 30.94 50.86 | 31 31.6 50.24 | 32.3 31.65 31.27 50.55
30 30.27 59.05 | 31.6 28.9 50.84 | 29.1 30.35 29.59 54.945
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MEXOX

27.98 ‘ 60.72 ’ 28.70 ‘ 27.53 ‘ 56.46 ’ 27.65 ’ 28.18 ‘ 27.75

saso |

OPOZ
O1rwg TTPOKUTITEI ATTO TOV TTAPATTAVW TTIVAKA, O AiIoONTAPAG 4 KATEYPAWE YIA TOV HAVA
louvio 25 Bepuokpaacicg UTCI TTou avTiIoToIXOUV GTNV KATNyopia TNG ETPIOG BEPHIKAG
Karamovnong, 1 omnv katnyopia NG 10XUPAG BepuIkAg kKartarmrdévnong kair 4
Bepuokpacicg TTou utTtodnAwvouv avuttapéia BepuIkng kaTammovnong. O aiodnTtrpag 4
Katéypawe TN pEyioTn Beppokpacia UTCI otn 28n nuépa Tou prva (32.1 °C) kail Tnv
eAaxiotn otn 5n nuépa (21.8°C). Ztov idIo Xpoviké didoTnua, o MeTewpoAoyikdg
21a6p6¢g KaTéypaywe 23 Bepuokpacieg UTCI TTou avrikouv OTnv Katnyopia TG JETPIOG
BepuIkAG katatmovnong 1 Bepuokpacia UTCI TTou avAKel 0TV KaTnyopia TnNg IoXUPAS
BepuIKAG KaTaTrdvnong KaBwg Kkal 6 Bepuokpacieg TTou utTodnAwvouv avutrapgia
Bepuikng katatrévnong .H péyiotn Bepuokpacia UTCI rapatnperibnke Tnv 29n nuépa
Tou pAva (32.30 °C), evw n eAdxioTn kataypdenke Tnv 6n nuépa (21.3°C). TéAog, o
utToAOYIOUGG TOUu Pédou Opou Twy Beppokpaaciwy UTCI yia Tov prva louvio deixvel OTi
10 83.4% Twv PETPNOEWV QVTIOTOIXOUV O€ CUVBNKES PETPIOG BEPUIKAG KaTaTrdévnong,
€VW TO UTTOAOITTO 16.6% avTIOTOIXEI O OUVORKEG UNOEVIKAG BEPUIKAG KaTaTtévnong. H
MéyioTn Bepuokpacia UTCI yia Tov pyfiva loivio oTov aoTIKO XWPO KATaypaPnKe TNV
29n nuépa (31.65°C), evw n eAdxiotn v 5" nuépa (21.65 °C).(BA Mivakag 11)
Mivakag 12 Oeppokpaacieg UTCI Tou aoTIKoU XwpEou yia Tov prva louAio
SENSOR meteo
July 4 station
Max Max MEZH MEZH METIZTH | MEZH
Temp RH UTCI | Temp RH OEPMOKPAZIA AEPA RH
1 31.21 65.62 30.1 59.19 30.66 62.41
2 35.35 35.83 34.2 39.56 34.78 37.70
3 30.93 56.63 30.9 50.23 30.92 53.43
4 29.97 68.63 29.9 57.44 29.94 63.04
5 31.69 48.79 313 49.7 31.50 49.25
6 32.37 48.48 323 44.35 32.34 46.42
7 33.68 45.62 32.9 39.49 33.29 42.56
8 34 54.58 324 51.98 33.20 53.28
9 32.99 47.13 31 48.22 32.00 47.68
10 32.53 51.89 30.1 48.01 31.32 49.95
11 31.59 58.04 32.2 44.64 31.90 51.34
12 32.43 61.22 31.2 45.6 31.82 53.41
13 33.67 52.55 32.7 40.19 33.19 46.37
14 35.87 35.49 35.7 35.65 35.79 35.57
15 36.27 37.99 36.4 36.47 36.34 37.23
16 30.1 74.14 32.8 62.68 31.45 68.41
17 33.24 52.04 | 28.3 | 334 51.33 33.32 51.69
18 35.15 39.6 33.2 40.63 34.18 40.12
19 34.16 41.85 33.2 39.2 33.68 40.53
20 33.65 54.44 32.9 36.63 33.28 45.54
21 36.21 36.55 36.9 52.72 36.56 44.64
22 36.1 49.48 34.2 52.16 35.15 50.82
23 39.14 38.7 38.2 34.42 38.67 36.56
24 35.83 50.04 35.1 47.42 35.47 48.73
25 34.47 45.79 34.3 50 34.39 47.90
26 41.41 22.54 41.7 32.98 41.56 27.76
27 35.51 24.06 35.6 40.31 35.56 32.19
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28 33.25 | 47.13 32.4 | 3595|319 H 32.83 41.54
29 29.18 60.11 311 | 4771|314 | 3090 |30.14 53.91
30 31.77 51.45 31.8 3469 | 312 | 3185 |31.79 43.07
31 33.25 52.03 33.4 46.69 33.33 49.36
MEZOZX
OPOZ 33.77 48.55 33.34 | 44.99 33.55 46.77
OTmwg @aivetal oTov TTapaTrdvw Trivaka, o a1o8ntpag 4 yia Tov priva louAio
katéypawe 25 Beppokpacieg UTCI Tou avTioToIXOUV OTnV KAThyopia Tng 10Xupng
BePUIKAG KATATTOVNONG KAl 2 BEPUOKPATIEG TTOU AVTIOTOIXOUV O€ TTOAU £vTovn BEPUIKNA
Katatrévnon Kabwg kal 4 Beppokpacieg TTou  UTTOONAWVOUV  PETPIa  BEPUIKA
katatrévnon. H péyiotn Bepuokpacia UTCIl tou katéypawe o aiobntipag 4
onMEIBNKE KaTa TNV 26n Nuépa Tou puAva (41.4 °C) kai n eAaXIoTn Katé TNV 16n nuépa
(28°C). O MeTewpoAoyIKOG 2TaBuOG Katd Tov urva loUAIo KaTéypaywe 7 BEPUOKPATIES
UTCI trou TTpoKaAoUv PETPIa BEPUIKY KATATTOVNON, 22 BEpUOKPATiEg TTOU TTPOKAAOUV
IoXupnA BepUIKA KaTatmdvnon Kal 2 BEpPoKPATies TTOU TTPOKAAOUV TTOAU €évTovn BEPUIKN
katatrévnon. H péyiotn Beppokpacia UTCI tou katéypawe o MeTewpoAoyikdg
21a0pb6¢ onuelwBNKe KATd TNV 26N nuépa Tou urva (42.1 °C) kai n eAdxI0TN KaTd TV
29n nuépa (30.9°C). TéAog, atrd Tov UTTOAOYIONO TOU PECOU OPOU TwV BEPUOKPATIWY
UTCI tou aoTikou xwpou yia Tov priva louAio mrapartnpeital Twg 10 71.05% Twv
METPAOEWV QVTIOTOIXEI O€ OUVONKEG IOXUPAS BepUIKAG kaTtatmmévnong, 10 22.5%
QVTIOTOIXEI O€ OUVONKEG PETPIOG BEPUIKAG KATATTOVNONG., EVW TO UTTOAOITTO 6.45% TWwv
METPAOEWV QVTIOTOIXEI O GUVBNKES TTOAU £vTovng BEPUIKAG KATATTOVNONG. H PEyIoTn
Bepuokpacia UTCI yia Tov priva [oUAio oTov acTiKO XWPOo KaTaypd@nke TRV 26n nuépa
(42.1°C) ka1 n eAaxiotn TNV 17n nuépa (31.45°C).(BA Mivakag 12)
Mivakag 13 O¢eppokpaacieg UTCI Tou aoTIKoU XwEou yia Tov hriva AUYouaoTo
August SENSOR 4 meteo station
Max MEZH MEFIZTH | MEZH
Max Temp | RH Temp RH OEPMOKPAZIA AEPA RH
1 32.66 58.1 30.7 51.82 31.68 54.96
2 34.9 53.65 32.4 42.22 33.65 47.94
3 33.13 55.29 34.3 45.34 33.72 50.32
4 34.13 52.8 33.8 43.52 33.97 48.16
5 33.19 51.5 33.6 40.42 33.40 45.96
6 32.11 50.77 32.9 54.58 32.51 52.68
7 31.96 55.9 31.3 47.5 31.63 51.70
8 32.1 65.23 30.8 50.25 31.45 57.74
9 33.49 45.55 30.1 52.35 31.80 48.95
10 31.18 50.24 29.9 46.9 30.54 48.57
11 32.59 49.99 30.3 52.24 31.45 51.12
12 31.22 47.77 30.1 49.32 30.66 48.55
13 30.63 57.75 29.5 58.15 30.07 57.95
14 30.76 61.12 30.8 61.39 30.78 61.26
15 32.37 59.8 30.3 54.98 31.34 57.39
16 32.47 57 31.6 50.23 32.04 53.62
17 32.51 58.6 31.6 62.23 32.06 60.42
18 32.06 51.26 32.6 49.4 32.33 50.33
19 33.9 41.04 32.8 47.47 33.35 44.26
20 33.16 45.74 31.3 51.98 32.23 48.86
21 33 56.34 31.6 57.47 32.30 56.91
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22 32.92 60.56 | 35.2 31.2 55.64 [32.3 33.75 32.06 58.10
23 32.71 62.68 [ 35 315 53 32.5 33.75 32.11 57.84
24 33.93 42.63 | 344 32.9 49.7 33.8 34.10 33.42 46.17
25 35.14 36.96 | 35.1 33.9 42.18 | 34.3 34.70 34.52 39.57
26 34.45 50.1 35.2 33.2 53.99 [ 34.6 34.90 33.83 52.05
27 33.69 44.08 [ 34.2 32.6 45.05 [ 33 33.60 33.15 44.57
28 32.97 55.3 34.6 32 53.78 [33.1 33.85 32.49 54.54
29 35.89 39.27 [ 36.5 36.8 39.48 [37.5 37.00 36.35 39.38
30 32.8 48.43 | 33.6 32.2 48.71 | 32.8 33.20 32.50 48.57
MEXOX

OPOZ 32.93 52.18 [34.08 | 31.95 50.38 [32.74 | 3341 32.44 51.28

O1Twg TTapoucIAZeTal OTOV TTAPATTAvW TTivaka, 0 a1o8nTAPag 4 Katéypaye Katd Tov
Mrva AuyouoTo 3 Bgpuokpacieg UTCI Tou avikouv oTnv Katnyopia YETPIOG BEPUIKAG
KATaTrévnong Kal TIG UTTOAOITTEG 26 va avAKOUV OTnV KaTnyopia 10Xuphs BepuIKAg
katatrévnong. H péyiotn Beppokpacia UTCI 1Tou katéypawe o aiobnmpag 4 Arav
(35.7 °C) otnv 4n nuépa, evw n eAdxiotn ATav (31.6°C) atnv 12n nuépa. Katd Tov idio
MAvVa, 0 MeTewPOAOYIKOG 2TaBuGG KaTEYpaWe BEPUOKPOATIEG JE PETPHOEIG VA AVIIKOUV
OTNV KATnyopia PETPIOG KATOTTOVNONG KAl OI UTTOAOITTEG 21 OTnv Katnyopia 1oXUpng
katatrévnong. H péyiotn Bepuokpacia UTCI tou katéypawe o MeTewPOAOYIKOG
21a0péc NTav( 37.50 ‘C) atnv 29n nuépa, kai n eAdxiotn Atav 30.00°C atnv 10N nuépa.
O péoog 6pog Twv Bepuokpaaiwyv UTCI yia Tov aoTikd xwpo katé Tov AUyouoTo OeiXVel
o1 T0 10% TWV PETPHOEWYV AVTIOTOIXEI 0€ CUVOAKES PETPIAG BEpUIKAG KaTatrdvnong,
evw 10 uTtOAoITTo 90% 0€ ouvlrikeg 10XUPAG Bepuikng katatmmdévnong. H péyiomn
Bepuokpacia UTCI yia Tov priva AUYyouoTo OTOV AoTIKO XWPO KaTaypd@nke TNV 29n
nuépa (37.00°C), evw n eAdxiotn Atav 30.90°C otnv 10n nuépa. (BA Mivakag 13)

21N ouvéxela, TTapouaialovtal ol Péool 6pol Twy Beppokpaciwy UTCI yia Toug PRveg
louvio, louAio kai AUyoucTo atré Toug aloBnmpeg 1, 2, 3 Kai 5 TTou ToTTOBETABNKAYV
OTOV TTPACIVO XWPEO Tou TTapKou Twv Ayiwv ATToaToAwv.(BA. MNivakag 14)

Mivakag 14 Méool 6pol Twv Bepuokpaciwv UTCI yia Toug urveg louvio, loUAio kai
AUyouaTo yia Toug aioBnThPES Tou TTPAGIVOU XWPOU

uTCI °C

Sensor 1 | Sensor 2 | Sensor 3 | Sensor 5 | GS-average
June 29.10 27.30 27.80 28.10 28.08
July 34.70 32.50 33.00 33.40 33.40

August 34.10 31.50 32.90 31.60 32.53
AVERAGE | 32.63 30.43 31.23 31.03 31.33

ZUpu@wWVa AOITTOV JE TOV TTAPaTTAVW TTivaKa 0 aloBnTripag 1 Katéypawe TIG UYPNASTEPES
METPAOEIG yia TNV péon Bepuokpaacia UTCI atrd 6Aoug Toug AAAOUG, UE TOV YEVIKO JECO
6po Bepuokpaoiwv UTCI (32.63 “C) va Tov KATATAOOEI OTNV KATNYOPIO TNG I0XUPNAG
BeppikAG KaTatrovnong .O1 TTOAU uwnAéG Bepuokpaaieg TTou KaTtaypd@nkav atré Tov
aicbntpa 1 cuvéBaAiav atnv augnon Twv PEowv Opwv Twv BEPUOKPATIWY Kal VIO
OAOKANPO TOV TTPACIVO XWPO KABWGS 0 aloBnTrpag €ival TOTTOBETNUEVOG OE PEPOG UE
atroucia dévTpwy TTANCiov TTaIBIKAG XapAg. ZTOV avTiTToda o aiolnTipag 2 o0 o1roiog
gival TotroBeTNUEVOG EVIOG TTUKVOU OACUAAIOU KaTEypawe TOV EAAXIOTO PECO OpPO
Bepuokpaoiag UTCI (30.43°C) atrd 6Aoug Toug aioBnTripeg. Agicel va onuelwbei 6Ti ol
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uwnAoTepeG Beppokpaaicg UTCI kataypdenkav amd Tov aicbntpa 1 kal 3 ol o11oiol
gixyav TOTTO0OeTNOEi 0 pPépog pe ENNeYn TTUKVAG PAdoTnong. Mapartnpeitar o7
aIoONTAPESG TOU XWpPou TTpacdivou, Katéypayav katd 66.70% yia Toug KaAokaipivoug
Mrveg, louhio kalr AuyouoTo, péoeg Bepuokpacieg UTCI 1Tou avtioToixolv oTnv
KATNyopia TNG 1I0XUPNG KATatTovnong evw Tov louvio katéypawav Katd 33.30% péoeg
Bepuokpacieg UTCI 1TOU avTioToixoUv OTnNV Katnyopia tTng péTplag katarmovnong. O
YEVIKOG H€0OG 0pog TNG Bepuokpaciag UTCI trou e€dxOnke atrd tnv TTpdaoivn TTepIoXh
KATA TOUG BepIvOUG HAVEG QVTIOTOIXICETAI € OUVORKES PETPIAG BEPUIKNAG KATATTOVNONG
ME YeVIKO W.6. Beppokpaaiag UTCI toug 31.33 °C.

AkoAoubei o TTivakag e Toug péooug 6poug Twv Bepuokpaciwyv UTCI Twv pnvwv
louviou, louAiou kai AuyouoTou TTou £¢rAxBnoav atrd Tnv TTeCepyaoia Twv OEBOUEVWV
Tou aIoBNTAPG 4 Kal TwWV OEOOPEVWY TOU NETEWPOAOYIKOU OTABUOU TTOU BPioKETAI TO
KEVTPO TWV Xaviwv Kal avTIoTOIXOUV GTOV AOTIKO XWPO £§w atrd Tnv TTEPIoX MEAETNG.
(BA Mivakag 15)

Mivakag 15 Méool épol Twv Bepuokpaciwv UTCI yia Toug prveg louvio, loUAio kai
AUyoUGCTO YIa TOUG aIcONTHAPES TOU ACTIKOU XWPEOU

UTCI

Sensor 4 | Meteorol. Station US-average
June 28.7 28.18 28.44
July 34.3 34.13 34.22
August 34 3341 33.70
AVERAGE | 32.33 31.91 32.12

MapaTtnpeital Twg 0 alIcONTAPAG 4 TOU ACTIKOU XWPOU O OTT0i0G TOTTOBETAONKE O€
ammoéoTaon 600 péTpwy atrd Tov TTPACIVO-UTTAE XWPEOo, Kal MeTEWPOAOYIKOG ZTaBuOG
o010 KEVTPO Twv Xaviwv, Katéypaywav katd 66.70% yia Toug KOAOKAIPIVOUG MUAVEG,
louAio kal AuyouaTo, péoeg Bepuokpacieg UTCI Tou avTioToixoUv aTnv Katnyopia Tng
Ioxupng katatrévnong. Tov louvio katéypawav katd 33.30% péoeg Beppokpacieg
UTCI 1mou avTtioToixoUv OTnV Katnyopia tng PéTpiag katamovnong. O1 diagopég Tou
aiocbntpa 4 e TIG avTioToixeg Bepuokpacieg Tou MeTewpoAoyikoU ZTabuoul eival
AOVYIKEG va ugioTavTal KaBw¢ To PJOVTEAO Twv aiIcONTipwy gival SIOQOPETIKO Kal N
a1TéoTaon METAEU TOUG Eival APKETA JOKPIVH ME OIOPOPETIKO aaTIKO OKNVIKO OTOV KABE
JOTTWw¢ TTPOKUTITEI ATTO TOUG TTAPATTAVW TTIVOKES TWV HECWYV Opwv Bepuokpaciwy UTCI
yIO TOUG a10BNTAPES TOU TTPACIVOU O YEVIKOG HECOG OpOoG TNS Bepuokpaciag UTCI Tou
€€axONKe KaTd TOUG BePIVOUG WPNVES AVTIOTOIXICETOI G OUVONAKEG WETPIAG BEPMIKNG
KATaTrévnong evw O YEVIKOG HECOG Opog TG Bepuokpaaiag UTCI tTou e€axBnke atrd
TNV GOTIKN TTEPIOXN KOTA TOug BepPIvoUg PNVESG avTIoTOIXI(ETal 0 OUVOAKES I0XUPNGS
BeppikAG katatrovnong. EidikdTepa  Toug prveg loUAIo kai AUyouoTo evToTTideTal
a100nTA dlopopd Tng Tagews Tou 1 °C og Bepuokpacia UTCI petagu Tou Xwpou
TIPOCIVOU KAl TNG QOTIKNG TTEPIOXNG.
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OEPMOKPAZIA UTCI

MEZOZ OPOX OEPMOKPAZIAZ UTCITIA
TON MHNA IOYNIO

—&— M£cog 6pog UTCI atov nmpdoivo xwpo —— Mécog 6po¢ UTCI otnv aoTikni mepLloxn
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Eikéva 19 Atreikdvion Tou péoou 6pou Tng Bepuokpaaciag UTCI aTov TTPACIvo
Kal OTOV A0TIKO XWPO yia Tov uiva louvio

MEZOZI OPOX OEPMOKPAZIAZ UTCITIA
TON MHNA IOYAIO

—l— M€00¢ 0pog UTCI otov mpAoLvo xwpo —&— Méoog 6pog UTCI oTtov aoTikd Xwpo

OEPMOKPAZIAUTCI
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Eikéva 20 Atreikdvion Tou péoou 6pou TnG Beppokpaaiag UTCI atov Tpdaoivo
KQI OTOV AOTIKO XWPO Yyia Tov prva louAio
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MEZOZ OPOZ OEPMOKPAZIAZ UTCITIA
TON MHNA AYTOYZITO
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Eikéva 21 Atreikdvion Tou péoou 6pou TnG Beppokpaaciag UTCI atov TTpAacivo
KAl OTOV A0TIKO XWPO yia Tov urva AlyouoTo

3.1.3(ii) AmroteAéopara amd TOV QOPNTO TPITTOSIKO METEWPOAOYIKO
oTaOuO

2Tnv Trapouca evotnTa Trapoucidlovral ol Tivakeg peTpiocewyv UTCIl o1 oTtroiol
avadelkvuouv TIG dlagopég oTiG Beppokpaacieg UTCI katd Tn SidpKeia Twv PETPHOEWV
TWV BEPUOKPATIWY TOU TTAPKOU Twv Ayiwv ATTOOTOAWY o€ dIAQOoPETIKG onueia. H
MEBOBOG TTOU XPNOIKMOTIOINBNKE, JE TN XPAON TOU popnToU PETEWPOAOYIKOU OTABHOU,
emETPEYE TNV agloAdynon Tng Bepuokpaciag UTCI oe onueia evdiagpépovtog TTou
TTapartnpeital évrovn avBpwrivn dpacTtneidTnTa . AUTA N TTPOCEYYIOT ATTOTUTTWVEI TOV
TPOTTO YE TOV OTT0I0 01 BepuoKpaaieg emnpedlouv TNV avlpwTTIvn Katamévnon oTov
TPACIVO Xwpo Katd Tn didpkeia Tou kKavowva TéAog ,mapoucidlovial £€1 XAPTEG,
KaBEVAG €K TWV OTTOIWY AVTIOTOIXEI O€ £vav ATTO TOUG TPEIS KUKAOUG UETPHOEWY TTOU
Olevepyndnkav katd TN Oidpkeld Twv OUO nNUEPWY HE AKPaieG OepuoKpaaies
(katowvag) atov TTpdcivo xwpo oTiS 13 kal 14 louAiou. O1 xdpTeg avadeikvUiouv TN
dlakupavaon Twv Bepuokpaciwv UTCI ye Baaon TG HETPAOEIG TTOU TTPAYHATOTTOIRBNKAV
o€ ETMAEYUEVQ ONEia, XPNOIPOTTOIWVTAG TOV QOPNTO TPITTOBIKO JETEWPOAOYIKO OTABUO
Kal TN H€B0OO TToU TTEPIEYPAPNKE OTNV £voTnTa 2.6.3.

2TOUG TTAPOKATW XAPTEC TTAPOUCIACOVTal OI TIHEG TwV BEPUOKPACIWV TOU agpa, TNG
oxeTIkAG uypaaoiag (%RH) kail Twv Beppokpaciwv UTCI yia kGBe onueio yérpnong. Ta
METPrOIYA CTOIXEIO ONnUEIWVOVTAl PJE KOKKIVO XPWwHa Yia Tn Bepuokpacia aépa, HE
GOTIPO XPWHGO YIa Tn OXETIKI Uypaoia, Kal hE KITPIVO Xpwua yia Tig TIuEG Tou UTCI.
MeTd TnVv TTapouciaon Twv XapTwv yia KABe nuépa, akoAouBei o oxoAiIaoudg Kai n
oUYKPION TWYV ATTOTEAECUATWY

Mivakag 16 Kataypa@Eg Twv HETPAOEWV Yia To onueio 1(okid) otig 13/07/2023

ZHMEIO 1 13/7/23
QPA 7:53 14:01 19:08
HAIOZ/ZKIA 2KIA 2KIA 2KIA
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EIAOZ

EAADOYZ AMMOZ AMMOZ AMMOZ

UTCl 26.1 334 29.1
KATHIOPIA Métpia Bepuikn loxuph BepuIkn MéTpia Bepuikni
KATAMNONHZHZ | karamrévnon KaTamévnon KaTamévnon

2UPQWVA JE TOV TTOPATTAVW TTiVOKA, TTapatnpouue 6Tl oTo onueio pétpnong 1, ol
MéyioTeg TIHEG UTCI epgavifovial otov OeUTEPO KUKAO METPROEWY Kal Wpa 2,
@TavovTag Toug 33.4°C. AvTioTolxa, ol EAGXIOTEG TINEG ep@avifovTal TIG WPES 7:53 1T
ME Bepuokpaaoia 26.1°C, kabwg kal oTIG 7:08up pe Bepuokpacia 29.1°C.H Tapatipnon
QUTH €pPNveUETal ATTO TO YEYOVOGS OTI KOTA TIG HECNUEPIAVES WPEG, N BEPUOKPATIia Tou
agpa gival uwnAn. AvtiBeta, Katd TIC TTPWIVEG KAl BPadIvEG WPEG, N BEpUoKpaTia Tou
aépa gival XapnAdTepn, kal dgv UTTAPXEl £viovn €kBeon Tou onueiou atov AAIO .(BA
Mivakag 16)

Mivakag 17 Kataypa@Eég Twy HETPACEWY Yia To onueio 1 oTig 13/07/2023

ZHMEIO 1 13/7/23
QPA 8:00 14:09 19:17
HAIOZ/ZKIA HAIOZ HAIOZ HAIOZ
EIAOZ
EAADPOYZ AMMOZ AMMOZ AMMOZ
UTCI 27.5 39 33.1
MoAU évtovn
KATHIOPIA Métpia Bepuikn Bepuikn loxupn Bepuikn
KATAMNONHZHZ | katamrévnaon KataTmmévnon KATaTévnon

2ZUUQWVa JE TOV TTaPATTAVW TTiVOKA, TTapATNPOUNE OTI OTO Onueio pétpnong 1, ol
MéyioTeg TIHEG UTCI gpgavifovial otov OeUTEPO KUKAO PETPACEWV QTAVOVTAG TOUG
39°C. AvrioToixa, ol eEAAXIOTEG TIUEG EUPaviICovTal OTOV TTPWIVO KUKAO JETPAOEWY KATA
TIG WPeG SuP-10up pe Bepuokpacia 27.5°C, kaBwg Kal OTIC WPES THU-9UM ME
Bepuokpacia 33.1°C.H Tapartpnon auth epunveleTal amo 1o yeyovog OTI KaTd TIG
MECNUEPIOVEG KOl ATTOYEUMATIVEG WPEG, N BeppoKkpacia Tou aépa eivalr uwnAr, Kai
utTdpxel €viovn €kBeon Tou onueiou otnv nAlakr akTivoBoAia. AvTiBeta, katd TIg
TPWIVES Kal Bpadivég wpeg, N Bepuokpacia Tou agpa eivalr XaunAdTepn, Kai dev
uTTdpxel €vrovn £kBeon Tou onueiou atov AAIo .(BA MNMivakag 17)

Mivakag 18 Kataypa@ég Twy HETPACEWY yia To onueio 1(okid) oTig 14/07/2023

ZHMEIO 1 14/7/23

QPA 8:05 14:30 19:17
HAIOZ/ZKIA 2KIA 2KIA 2KIA

EIAOZ

EAADPOYZ AMMOZ AMMOZ AMMOZ

UTCI 26.4 34.8 32.4
KATHIOPIA Métpia Bepuikn loxupr] BepuIKnA loxupn Bepuikn
KATAIMNONHZHZ | katamrévnon Karammoévnon KaTaTrovnon

SUPQWVA PE TOV TTOPATTAVW TTiVOKA, TTapatnpouue 6Tl oTo onueio pétpnong 1, ol
péyioTeg TINEG UTCI epgpaviovtal oTov SeUTEPO KUKAO PETPAOEWYV KATA TIG WPEG 2UM-
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4up, eTavovtag Toug 34.8°. AvTtioTolxa, Ol EAAXIOTEG TIUEG EPPAVICOVTAl KATA TIG WPEG
8uu-10uu pe Bepuokpacia 26.4°C, KaBWG Kal OTIC WPEG 7TUU-9UU pE Bepuokpacia
32.4°C.H mapatpnon autr gpunveleTal atmmo 10 YeYovog OTI KATA TIG HECNUEPIAVES
WpEG, N Beppokpaacia Tou agpa cival uwnAn. AvtiBeta, Katd TIG TTPWIVES Kal BPAdIVES
wpeg, n Bepuokpaacia Tou aépa gival XapnAdTePN, Kal dev UTTAPXEI €vTovn €KBeon TOU
onpeiou otov AAIO (BA lMivakag 18)

Mivakag 19 Kataypa@Eg Twv HETPAOEWY Yia To onueio 1 oTig 14/07/2023

ZHMEIO 1 14/7/23
QPA 8:13 14:39 19:10
HAIOZ/ZKIA HAIOX HAIOX HAIOX
EIAOZ
EAA®OYZ AMMOZ AMMOZ AMMOZ
UTCI 28 40.8 37.7
MoAU évtovn
KATHIOPIA Métpia Bepuikn BeppuikA loxupn Bepuikn
KATAMNONHZHZ | katamrévnon KaTamévnon KATATTévVNon

2ZUUQWVA JE TOV TTOPATTAVW TTiVOKA, TTapatnPouue OTI 0To onueio pétpnong 1, ol
MéyioTeg TINEG UTCI epgavifovtal aTov SeUTEPO KUKAO PETPAOEWY KATA TIG WWPEG 2UM-
4up, etavovrtag Toug 40.8°C. AvTioToixa, o1 EAGXIOTEG TINEG EJ@avifovTal KATA TIG WPES
8uu-10uu pe Bepuokpacia 28°C, kKaBWG Kal OTIC WPEG 7TUU-9UU pE Bepuokpacia
37.7°C.H mmapatripnon autr epunveleTal aTrd TO YEYOVOS OTI KATA TIG JECNUEPIAVES KAl
OTTOYEUPATIVEG WPEG, N BepuoKpaaia Tou agpa gival uwnAn, Kal UTTApXE! EvTovn £KBeaN
TOU onueiou oTnv nAlakA akTivoBoAia. AvTiBeTa, Katd TIG TTPWIVEG Kal BPadIvéG WPEG, N
Bepuokpacia Tou agpa gival xaunAdTepn, kai dev UTTAPYXEI €vTovn €KBean TOU onpeiou
oTtov AANIo.(BA lMivakag 19)

Mivakag 20 KaTtaypa@£ég Twy HETPACEWY Yia To anueio 2 aTig 13/07/2023

2HMEIO 2 13/7/23

QPA 8:10 14:20 19:28
HAIOZ/ZKIA HAIOZ HAIOZ HAIOZ

EIAOZ

EAADOYZ XQMA XQMA XQMA

UTCI 30.7 36 32.8
KATHIOPIA Mérpia OepUIKA | |oyup  Beppikd | loxupr,  Bepuikh
KATAMONHZHz | Karamovnon Karamdvnon Karamdvnon

2UPeWvVa Je TOoV TTapaTTadvw Trivaka, TTapatnpouue 6Tl 0TO onueio péTpnong 2, ol
péyioTeg TIuEG UTCI epgpaviovtal oTov SeUTEPO KUKAO PETPAOEWYV KATA TIG WPEG 2UU-
4uu, @tavovtag Toug 36°C. AvtioToixa, ol EAAXIOTES TINEG EppavifovTal KATA TIG WPES
8up-10up pe Beppokpacia 30.7°C, kaBwg Kal OTIC WPEG 7UP-9uP PE Bepuokpacia
32.8°C.H mraparfpnon auth epunveUETal atrd TO YEYOVOS OTI KATA TIG JECNUEPIAVES KOl
QTTOYEUMATIVEG WPEG, N BEpPoKpacia Tou agpa gival uPnAn, Kal UTTAPXEl EvTovn €KBeoN
TOu onueiou aTnv nAlokr akTivoBoAia. AvTiBeTa, KOTA TIG TTPWIVEG Kal BPadIvEG WPEGS, N
Beppokpaaia Tou agpa gival xaunAdTepn, Kai dev UTTAPXEI EvTovn €KBEON TOU onueiou
otov AAo.(BA Mivakag 20)

Mivakag 21 Kataypa@Eg Twv HETPACEWV Yia To onueio 2 oTig 14/07/2023
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ZHMEIO 2 14/7/23

QPA 8:23 14:39 19:26
HAIOZ/ZKIA HAIOX HAIOX HAIOX

EIAOZ EAA®OYZ | XQMA XQMA XQMA

UTCl 31.6 37.6 37.2
KATHIOPIA Métpia Bepuikn loxuph BepuIkn loxuph BepuIkn
KATAIMNONHZHZ Katammévnon KATaTrévnon KATATIéVNON

2UPQWVa JE TOV TTOPATTAVW TTiVOKA, TTapatnpouue 6T 0To onpeio péTpnong 2, ol
MéyioTeg TINEG UTCI ep@avifovtal aTov OeUTEPO KUKAO PETPHOEWY KATA TIG WWPEG 2UM-
4y, etavovtag Toug 37.6°C, KaBwg Kal OTIC WPES 7UM-9UM UE Beppokpaaia 37.2°C.
AvrTioToIxa, o1 eAAxI0TEG TINEG gp@aviCovTal KT TIG WPeG 8uP-10uy Ye Bepuokpaaia
31.6°C, H tmmapatipnon auth epunveusTal atrd To YEYOVOG OTI KATA TIG UECNUEPIAVEG
KAl ATTOYEUMATIVEG WPEG, N BepUoKpaaia Tou agpa gival uPnAr, Kal UTTApXel éviovn
£€kBeon Tou onueiou oTnv nAlakh akTivoBoAia. AvTiBeTa, KaTd TIG TTPWIVES KAl BPadivég
wpeg, n Bepuokpaacia Tou agépa eival XapnAdTepn, Kal dev UTTAPXEI £vTovn €KBeon TOU
onueiou atov NAIO(BA Mivakag 21)

Mivakag 22 Kataypa@£g Twv HETPAOEWY Yia To anueio 3 aoTig 13/07/2023

ZHMEIO 3  13/7/23

QPA 8:17 14:30 19:38
HAIOZ/ZKIA ZKIA ZKIA 2KIA

EIAOZ

EAAPOYZ XQMA XQMA XQMA

UTCI 27.8 33.6 31.1
KATHIOPIA Métpia Bepuikn loxupr] BepuIKn MéTpia Bepuikni
KATAMNONHZHZ | katamévnon Karammévnon KATamoévnon

Z0PQWva JE TOV TTAPATTAVW TTiVaKa, TTapaTtnpouue OTI 0To onueio péTpnong 3, ol
MéyioTeg TINES UTCI epgavifovtal aTov deUTEPO KUKAO PETPAOEWY KATA TIG WPEG 2UH-
4uu, eravovtag Toug 33.6°C Kabwg Kal oTIG wpPEeG 7HU-9uM he Bepuokpacia 31.1°C.
AvrTioToIxa, o1 EAAxIoTEG TIHEG ep@aviCovTal KaTd TIG WPES SUP-10uY Ye Bepuokpaaia
27.8°C, .H mrapartipnon autrh epunveueTal amd To yeyovog OTI KATA TIG HECNMEPIAVES
WwpEeg, n Bepuokpacia Tou agpa civar uwnAn. AvTiBeTa, KATA TIC TTPWIVES WPEG, N
Bepuokpaaia Tou agpa gival xaunAdTepn, kai dev UTTApXEl Eviovn €KBEoN TOU onuEiou
oTtov AAIo .(BA Mivakag 22)

Mivakag 23 Kataypa@ég Twy HETPAOEWY yia To onueio 3 oTig 14/07/2023

ZHMEIO 3 14/7/23
QPA 8:37 15:03 19:35
HAIOZ/ZKIA 2KIA 2KIA 2KIA
EIAOZ EAA®OYX XQMA XQMA XQMA
UTCI 28.6 35.4 33.7

loxupn
KATHIOPIA MéTpia BepuIkn loxupn Bepuikn BepuIKN
KATAIMNONHZHZ Karamoévnon Karammoévnon Karamrovnon
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2UPQWvVa PE TOV TTOPATTAVW TTiVOKA, TTapatnpouue 6T oTo onpeio pétpnong 3, ol
MéyioTeg TINEG UTCI epgavidovtal oTov OeUTEPO KUKAO PETPHOEWY KATA TIG WPEG 2UM-
4y, eravovtag Toug 35.4C° KaBwG Kal OTIG WPEG 7UP-9uM he Bepuokpacia 33.7°C.
AvrTioToIXa, o1 EAAXIOTEG TIUEG eP@aviCovTal KATA TIG WPEG 8uP-10pu Ye Bepuokpaacia
28.6°C, .H mrapartipnon auth epunveusTal atrd T0 YEYOVOS OTI KATA TIG HECNHEPIAVES
wpeg, N Beppokpaacia Tou aépa cival uwnAr. AvtiBeTa, KATd TIG TTPWIVEG WPEG, N
Bepuokpaaia Tou agpa gival XapnAdTepPn, Kal dev UTTAPXEl EvTovn £KBean Tou anueiou
oTov Ao .(BA Mivakag 23)

Mivakag 24 Kataypa@Eég Twv HETPACEWY Yia To onueio 4 oTig 13/07/2023

ZHMEIO 4 13/7/23

QPA 8:27 14:40 19:47
HAIOZ/ZKIA SKIA SKIA ZKIA

EIAOZ

EAA®OYZ TZIMENTO TZIMENTO TZIMENTO
UTCl 29.5 37.5 30.8
KATHIOPIA Métpia Bepuikn loxupn Bepuikn MéTpia Bepuikni
KATAMNONHZHZ | katamrévnon KATammévnon KATATIévnon

2ZUPQWVa JE TOV TTOPATTAVW TTiVaKa, TTapatnpouue 6Tl 0To onueio pétpnong 4, ol
MéyioTeg TINEG UTCI epgavifovtal aTov deUTEPO KUKAO PETPAOEWY KATA TIG WWPEG 2UM-
4up, etavovTtag Toug 37.5°C. AvTioToixa, ol EAGXIOTEG TINEG EJpavifovTal KATd TIG WPEG
8uu-10uu pe Beppokpacia 29.5°C, kaBwg Kal OTIC WPESG 7UP-9UU pE Bepuokpacia
30.8°C.H mapatpnon auth gpunveleTal amd 10 yeyovog OTI KATA TIG PECTUEPIAVES
WpEG, n Beppokpaaia Tou agpa cival uwnAr. AvtieTa, KaTd TIG TTPWIVES KAl BpadIvég
wpeg, n Bepuokpaacia Tou agpa gival xapnAdTepn, Kal dev UTTAPXEI Eviovn €KBean Tou
onpeiou atov AAIO .(BA lMivakag 24)

Mivakag 25 Kataypa@ég Twv HETPACEWY Yia To onpeio 4 omig 14/07/2023

ZHMEIO 4 14/7/23
QPA 8:51 15:12 19:45
HAIOZ/ZKIA ZKIA ZKIA 2KIA
EIAOZ
EAADPOYZ TZIMENTO TZIMENTO TZIMENTO
UTCI 30.7 39.1 33.5

MoAU évtovn
KATHIOPIA Métpia Bepuikn BepuiIkn loxupn Bepuikn
KATAMNONHZHZ | katamrévnon Karammévnon KaTamévnon

SUPQwva PE TOV TTOPATTAVW TTiVOKA, TTapatnpoupe OTI 0To onueio péTpnong 4, ol
péyioTeg TIuEG UTCI epgpaviovtal oTov SeUTEPO KUKAO PETPAOEWYV KATA TIG WPEG 2UU-
4up, @tavovtag Toug 39.1°, Kabwg Kal OTIG WPEG 7PP-Ouu pe Beppokpaaoia 33.5°C.
AvTioToIxa, ol EAAXIOTEG TIMEG ep@aviCovTal KaTA TIG WPES 8uu-10uY pe Beppokpaaia
30.7°C .H 1rapatipnon auth epunveusTal atrd 10 YEYOVOS OTI KATA TIG HECTUEPIAVEG
WwpeS, N Bepuokpaacia Tou agpa gival uYnAn. AvTiBeTa, KATA TIG TTPWIVEG WPEG, N
Beppokpaaia Tou agpa gival xaunAdTepn, Kai dev UTTAPXEI £vTovn €KBEON TOU onuEiou
otov nAio .(Mivakag 25)

Mivakag 26 Kataypa@Eg Twv HETPACEWV Yia To onueio 5 oTig 13/07/2023
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ZHMEIO 5 13/7/23

QPA 8:35 14:49 19:56
HAIOZ/ZKIA HAIOX HAIOX HAIOX

EIAOZ

EAADOYZ XQMA XQMA XQMA

UTCl 33.4 36.9 313
KATHIOPIA loxupn BepuIkn loxuph BepuIkn MéTpia Bepuikn
KATAMNONHZHZ | karamrévnon KATaTévnon KATATIOVNON

2UPQWVa JE TOV TTOPATTAVW TTiVOKA, TTapatnpouue 6Tl 0To onpeio péTpnong 5, ol
MéyioTeg TINEG UTCI ep@avifovtal aTov SeUTEPO KUKAO PETPHOEWY KATA TIG WWPEG 2UM-
4, eradvovtag Toug 36.9°C. AvTioTolxa, ol EAGXIOTEG TIHEG EJPaviIfovTal KATA TIG WPEG
8uu-10uu pe Bepuokpacia 33.4°C, kaBWG Kal OTIC WPESG 7HU-9UU pE Bepuokpacia
31.3°C.H mapatripnon autr epunveleTal ard TO YEYOVOS OTI KATA TIG HECNUEPIAVES KAl
QTTOYEUPATIVEG WPEG, N BEpUOKpaacia Tou agpa gival uYnAr, Kal UTTAPXE! EvTovn £KBEaN
TOU onueiou oTnv nAlakA akTivoBoAia. AvTiBeTa, Katd TIG TTPWIVEG Kal BPadIvéG WPEG, N
Bepuokpacia Tou agpa cival xaunAdTepn, kai dev UTTAPYXEI €vTovn €KBean TOU onpeiou
oTov nAio.(lMivakag 26)

Mivakag 27 Kataypa@£ég Twv HETPAOEWY Yia To anueio 5 aTig 14/07/2023

ZHMEIO 5 14/7/23

QPA 8:59 15:20 19:53
HAIOZ/ZKIA HAIOZ HAIOX HAIOZ

EIAOZ

EAADPOYZ XQMA XQMA XQMA

UTCI 34.4 37.9 34.9
KATHIOPIA loxupr] BepuIkn loxupr] BepuIkn loxupn Bepuikn
KATAIMNONHZHZ | katamrévnon Karammévnon KATamévnon

Z0PQWva JE TOV TTAPATTAvVW TTiVaKa, TTapatnpouue OTI 0To onueio péETpnong 5, ol
péyioTeg TINEC UTCI epgavidovral atov deUTEPO KUKAO PETPACEWY KATA TIC WPES 2UH-
4up, etavovrtag Toug 37.9°C. AvTioTolxa, ol EAGXIOTEG TIHEG e@avifovTal KATd TIG WPES
8uu-10uu pe Bepuokpacia 34.4°C, kabBwg Kal OTIC WPES 7UP-9UU HE Bepuokpaaia
34.9°C.H mapatripnon autr epunveveTal ammo To yeyovog OTI KATA TIG JECNUEPIAVES KOl
QTTOYEUMATIVEG WPEG, N BepUOKpaTia Tou agpa gival uwnAr, Kol UTTApXEl EvTovn £KBEO
Tou onueiou aTnv nAlak akTivoBoAia. AvTiBeTa, Katd TIG TTPWIVES Kal BPadIvéG WPEG, N
Bepuokpaaia Tou agpa gival xaunAdTepn, kal dev UTTApXEl Eviovn €KBECN TOU OnuEiou
oTov NAio.(Mivakag 27)

Mivakag 28 Kataypa@Eg Twv JETPACEWY Yia To onueio 6 oTig 13/07/2023

ZHMEIO 6 13/7/23

QPA 8:47 15:07 20:31
HAIOZ/ZKIA HAIOZ HAIOXZ HAIOZ
EIAOX

EAADOYZ AMMOZX AMMOZ AMMOZ
UTCI 35.8 40.4 32.2
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KATHIOPIA
KATAMNMONHZHZ

loxupn BepuIkn
Karamoévnon

MoAU évTtovn

BepuIKN
Karammoévnon

loxupn BepuIknA
Karamoévnon

2UPQWVA e TOV TTAPATTAVW TTiVOKA, TTOPATNPOUNE OTI OTO onueio péTpnong 6 ol
péyioTeg TINEG UTCI ep@avifovtal oTov OeUTEPO KUKAO PETPHOEWY KATA TIG WPEG 2UH-
4up, eradvovtag Toug 40.4°C. AvTioTolxa, ol EAGXIOTEG TIHEG EJPaviICovTal KATA TIG WPEG
8uu-10uu pe Bepuokpacia 35.8°C, KaABWG Kal OTIC WPEG 7THU-9UU pE Bepuokpacia
32.2°C.H mapatripnon autr epunvelsTal atrd TO YEYOVOS OTI KATA TIG HECNUEPIAVES KAl
QTTOYEUPATIVEG WPEG, N BEpUOKpacia Tou agpa gival uYnAr, Kal UTTAPXE! EvTovn £KBEaN
TOU onueiou oTnv nAlokA akTivoBoAia. AvTiBeTa, Katd TIG TTPWIVES Kal BPadIvéG WPEG, N
BepuoKkpaaia Tou aEpa gival XapnAdTeEPN, Kal &ev UTTAPXEI EvTovn €KBECT TOU OnuEiou
oTov nAio.(Mivakag 28)

Mivakag 29 Kataypa@ég Twv HETPAOEWY Yia To anueio 6 oTig 14/07/2023

ZHMEIO 6 14/7/23
QPA 9:30 15:50 20:24
HAIOZ/ZKIA HAIOZ HAIOZ HAIOZ
EIAOZ
EAADPOYZ AMMOZ AMMOZ AMMOZ
UTCI 37 41.3 36.1
MoAU évtovn
KATHIOPIA loxupr] BepuIkn Bepuikn loxupn Bepuikn
KATAMNONHZHZ | katatrévnon Katatmévnon KaTamoévnon

2ZUPQWVa JE TOV TTAPATTAVW TTivaka, TTapatnpouue 6Tl 0To onueio péTpnong 6, ol
MéyioTeg TINEG UTCI epgavifovtal aTov deUTEPO KUKAO PETPAOEWY KATA TIG WWPEG 2UH-
4up, etavovtag Toug 41.3°C. AvTioTolxa, ol EAGXIOTEG TIEG EJ@avifovTal KATA TIG WPES
8uu-10uu pe Bepuokpacia 37°C, kKaBWG Kal OTIC WPEG 7TUU-9Uu pE Bepuokpacia
36.1°C.H mapatripnon autr epunveUeTal aTTd TO YEYOVOS OTI KATA TIG JECNUEPIAVES KAl
OTTOYEUPATIVEG WPEG, N BepUoKpaacia Tou agpa gival uwnAr, Kol UTTApXEl EvTovn £KBeo
TOU onueiou oTnv nAlak akTivoBoAia. AvTiBeTa, Katd TIG TTPWIVEG Kal BPadIvég WPEG, N
Bepuokpacia Tou agpa gival xaunAdTepn, Kai Osv UTTAPYXEl £vTovn €KBeoN TOU anpeiou
oTtov AAIo.(BA lMivakag 29)

Mivakag 30 Kataypa@ég Twv HETPAOEWY Yia To onueio 6(okid) otig 13/07/2023

ZHMEIO 6 13/7/23

QPA 8:54 15:17 20:23
HAIOZ/ZKIA ZKIA ZKIA 2KIA

EIAOZ EAA®OYEX | AMMOZX AMMOZ AMMOZ

UTCI 30.7 35.1 30.1
KATHIOPIA Métpia BepuIkn loxupr] BepuIKnA MéTpia Bepuikni
KATAIMNONHZHZ Karamoévnon KaTramovnon KaTaTTovnon

JUPQWVA PE TOV TTOPATTAVW TTiVOKA, TTapatnpouue 6T oTo onueio pétpnong 1, ol
péyioTeg TINEG UTCI epgpaviovtal oTov SeUTEPO KUKAO PETPAOEWYV KATA TIG WPEG 2UU-
4uu, @Tadvovtag Toug 34.8°. AvtioToIxa, Ol EAGXIOTEG TIUEG EPPaviCovTal KATA TIG WPEG
8up-10up pe Beppokpacia 26.4°C, kaBwg Kal OTIC WPEG 7UP-9uP PE Bepuokpacia

54



32.4°C.H mrapatfpnon autr} epunvelsTal atmo 1o YEYovOg OTI KOTA TIG UECNPEPIAVEG
WpEG, N Beppokpaacia Tou agpa cival uWPnAr. AvTiBeTa, KaTd TIG TTPWIVES KAl BPadIVES
wpeg, N Bepuokpaacia Tou aépa gival XapnASTePN, Kal dev UTTAPXEI EvTovn €KBeon TOU
onpeiou otov AAIO .(BA Mivakag 30)

Mivakag 31 KaTaypa@EéG TWV HETPHOEWY Yia To onpeio 6 (okid)oTig 14/07/2023

ZHMEIO 6 14/7/23

QPA 9:22 15:40 20:16
HAIOZ/ZKIA SKIA SKIA ZKIA

EIAOZ

EAA®OYZ AMMOZ AMMOZ AMMOZ

UTCl 31.8 36.1 33.5
KATHIOPIA Métpia Bepuikn loxuph Bepuikn loxupr BepuIkn
KATAMNONHZHZ | karamévnon KATammévnon KATATTéVNon

2UPQWVa JE TOV TTAPATTAVW TTiVaKa, TTapatnpouue 6Tl 0To onueio péTpnong 6, ol
MéyioTeg TINEG UTCI epgavifovtal aTov deUTEPO KUKAO PETPAOEWY KATA TIG WWPEG 2UM-
4, etadvovtag Toug 36.1°. AvtioTolxa, o1 EAAXIOTEG TIWEG EP@aviIovTal KATA TIG WPEG
8uu-10uu pe Bepuokpacia 31.8°C, kaBwg Kal OTIC WPESG 7HU-9UU pE Bepuokpacia
33.5°C.H mapatipnon autr epunveleTal ammo 10 Yeyovog OTI KATA TIG MECNUEPIAVES
WpEG, n Beppokpaaia Tou agpa cival uwnAr. AvtiBeta, KaTd TIG TTPWIVES KAl Bpadivég
wpeg, n Bepuokpaacia Tou agépa eival XapnAdTepn, Kal dev UTTAPYXEI €vTovn €KBeon Tou
onpeiou atov AAIO .(BA lMivakag 31)

Mivakag 32 Kataypa@£ég Twv HETPAOEWY Yia To anueio 7 aTig 13/07/2023

ZHMEIO 7 13/7/23
QPA 9:15 15:38 20:41
HAIOZ/ZKIA HAIOZ HAIOX 2KIA
EIAOZ EAA®OYX AZDAANTOZ AZDAATOZ AZOAATOZ
UTCI 33 42.2 28.3

[MoAU évTovn
KATHIOPIA loxupr] BepuIKn Bepuikn MéTpia Bepuikni
KATAIMNONHZHX KaTammévnon Karammévnon KaTamoévnon

2UheWva Je ToV TTapaTTdvw Trivaka, TTapatneouue 6T 0TO onueio péTpnong 7, ol
péyioTeg TINEC UTCI epgavifovtal aTov deUTEPO KUKAO PETPACEWY KATA TIC WPES 2UH-
4up, eravovTtag Toug 42.2°C. AvTioToIxa, ol EAGXIOTEG TIHEG e@avifovTal KAaTd TIG WPES
8uu-10uu pe Bepuokpacia 33°C, kKaBWS Kal OTIC WPEG 7TUU-9uu PE Bepuokpacia
28.3°C.H mmapartApnon auth epunveveTal atrd TO Yeyovog OTI KATA TIG JECNUEPIAVEG KOl
QTTOYEUMATIVEG WPEG, N BEpPoKpacia Tou agpa gival uPnAn, Kal UTTAPXEl EvTovn €KBeoN
Tou onueiou aTnv nAlokr akTivoBoAia. AvTiBeTa, KOTA TIG TTPWIVEG Kal BPadIvEG WPEGS, N
Bepuokpaaia Tou agpa gival xaunAdTepn, kai Ogv UTTAPYXEl £vTovn €KBEON TOU anueiou
oTov NAio.(BA Mivakag 32)

Mivakag 33 Kataypa@Eg Twv JETPACEWY Yia To onueio 7 oTig 14/07/2023

ZHMEIO 7 14/7/23

QPA 9:50 16:10 20:48

HAIOZ/ZKIA HAIOX HAIOX 2KIA
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EIAOZ EAA®OYZ AZPAATOX AZPANTOZ AZPANTOZ
UTCI 318 46.3 33.2
KATHIOPIA MéTpia BepuIKn Akpaia BepuIKnA loxupn BepuIknA
KATAIMNONHZHZ KaTammévnon KATaTévnon KATATTéVNOon

2UPQWVa JE TOV TTOPATTAVW TTiVOKA, TTapatnpouue 6Tl 0To onpeio péTpnong 7, ol
péyioTeg TINEG UTCI epgavifovtal oTov OeUTEPO KUKAO PETPHOEWY KATA TIG WPEG 2UM-
4, eradvovtag Toug 46.3°C. AvTioTolxa, ol EAGXIOTEG TIHEG EJPaviICovTal KATA TIG WPEG
8uu-10up pe Bepuokpacia 31.8°C, kaBwWG Kal OTIC WPEG 7THU-9UU pE Bepuokpacia
33.2°C.H mapatripnon autr epunveleTal ard TO YEYOVOS OTI KATA TIG HECNUEPIAVES KAl
QTTOYEUPATIVEG WPEG, N BEpUOKpacia Tou agpa gival uYnAr, Kal UTTAPXEI EvTovn £KBEaN
TOU onueiou oTnv nAlokA akTivoBoAia. AvTiBeTa, Katd TIG TTPWIVEG Kal BPadIvéG WPEG, N
Bepuokpaaia Tou agpa gival XapnAdTeEPN, Kal &ev UTTAPXEI EvTovn €KBECT TOU OnuEiou
oTov nAo.(BA Mivakag 33)

Mivakag 34 Kataypa@ég Twv HETPAOEWY Yia To anueio 8 aTig 13/07/2023

ZHMEIO 8 13/7/23

QPA 9:05 15:22 20:41
HAIOZ/ZKIA 2KIA YKIA 2KIA

EIAOX EAA®OYZ XQMA XQMA XQMA

UTCI 34 37.6 28.4
KATHIOPIA loxupr] BepuIkn loxupr] BepuIKn MéTpia Bepuikni
KATAIMNONHZHZ Katammévnon Katatmévnon KaTamoévnon

Z0UQWvVa JE TOV TTAPATTAVW TTivaKa, TTapatnpouue 6Tl 0To onueio péTpnong 8, ol
péyioTeg TINES UTCI epgavifovtal aTov deUTEPO KUKAO PETPACEWY KATA TIG WPEG 2UH-
4upu, etadvovtag Toug 37.6°. AvtioTolxa, Ol EAAXIOTEG TIUEG EP@aviCovTal KATA TIG WPEG
8uu-10uu pe Bepuokpacia 34°C, kKaBWG Kal OTIC WPEG 7TUU-9uu PE Bepuokpacia
28.4°C.H mapatipnon auth €punveleTal atmmd To YEYOVOGS OTI KATA TIG MECNUEPIAVES
WpEG, n Beppokpaaia Tou agpa cival uwnAr. AvtibeTa, KaTd TIG TTPWIVES KAl BpadIvég
WwpEeg, n Bepuokpaacia Tou agpa eival XapnAdTepn, Kal dev UTTAPYXEI EvTovn €KBeon Tou
onueiou otov AAIO.(BA lMivakag 34)

Mivakag 35 Kataypa@ég Twy HETPAOEWY yia To anueio 8 aTig 14/07/2023

ZHMEIO 8 14/7/23

QPA 9:41 16:02 20:35
HAIOZ/ZKIA ZKIA ZKIA 2KIA

EIAOZ EAA®OYX XQMA XQMA XQMA

UTCI 32.6 37.8 31.1
KATHIOPIA loxupr BepuIkni loxupr] BepuIKnA MéTpia Bepuikni
KATAIMNONHZHZ Karamoévnon Katamovnon KaTaTTovnon

2UPQWva PE TOV TTOPATTAVW TTiVOKA, TTapatnpouue 6T oTo onueio péTpnong 8, ol
péyioTeg TINEG UTCI epgpaviovtal aTov SeUTEPO KUKAO PETPAOEWYV KATA TIG WPEG 2UM-
4uu, @tadvovtag Toug 37.8°. AvtioToixa, ol EAAXIOTEG TINEG EPPAVICOVTAI KATA TIG WPEG
8up-10up pe Beppokpacia 32.6°C, KaBwg Kal OTIG WPEG 7UU-OuP PE Bepuokpacia
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31.1°C.H mapatpnon autr epunvelsTal atmo 10 YEYovog OTI KATA TIG HECNUEPIAVES
WpEG, N Beppokpaacia Tou agpa cival uWPnAr. AvTiBeTa, KaTd TIG TTPWIVES KAl BPadIVES
wpeg, N Bepuokpaacia Tou aépa gival XapnASTePN, Kal dev UTTAPXEI EvTovn €KBeon TOU
onpeiou otov AANIO.(BA TMivakag 35)

Mivakag 36 Kataypa@Eég Twv HETPAOEWY Yia To onueio 9 oTig 13/07/2023

ZHMEIO 9 13/7/23
QPA 9:25 15:48 21:00
HAIOZ/ZKIA HAIOX HAIOX ZKIA
EIAOX EAAQOYZ AMMOZ AMMOZ AMMOZ
UTCI 35 40.8 29.3
MoAU évtovn
KATHIOPIA loxupn BepuIkn BeppikA MéTpia Bepuikni
KATAIMNONHZHZ Karamévnon KaTamévnon KaTamévnon

2UPQWVa JE TOV TTOPATTAVW TTiVaKa, TTapatnpouue 6T oTo onueio pétpnong 9, ol
MéyioTeg TINEG UTCI epgavifovtal aTov deUTEPO KUKAO PETPAOEWY KATA TIG WWPEG 2UH-
4pup, etavovrtag Toug 40.8°C. AvTiaToixa, ol eEAGXIOTEG TIMEG pgaviovTal KATA TIG WPEG
8uu-10uu pe Bepuokpacia 35°C, kKaBWG Kal OTIC WPEG 7UU-9uu pE Bepuokpacia
29.3°C.H mapatripnon autr epunveleTal atrd T0 yeyovog OTI KATd TIG HECNUEPIAVES KOl
OTTOYEUPATIVEG WPEG, N BEpUoKpaacia Tou agpa gival uYnAr, Kol UTTApXEl EvTovn £KBE0
TOU onueiou oTnv nAlakA akTivoBoAia. AvTiBeTa, Katd TIG TTPWIVEG Kal BPadIvéG WPEG, N
Bepuokpacia Tou aépa gival XaunAdTepn, kal dev UTTAPXEI EvTovn €KBean TOU onueiou
oTtov AANIo.(BA lMivakag 36)

Mivakag 37 KaTaypa@Eég TwV PETPAOEWY Yia To onueio 9 oTig 14/07/2023

ZHMEIO 9 14/7/23
QPA 10:00 16:14 21:00
HAIOZ/ZKIA HAIOZ HAIOX 2KIA
EIAOZ EAA®OYE | AMMOZ AMMOZ AMMOX
UTCI 36.9 39.9 32.1
MoAU évtovn
KATHIOPIA loxupr] BepuIkn BepuiIkn loxupn Bepuikn
KATAIMNONHZHX Katammévnon Karammévnon KaTamoévnon

2UheWvVa Je TOoV TTapaTTdvw Trivaka, TTapatnpouue 6T 0To onueio péTpnong 9, ol
péyioTeg TINEC UTCI epgavifovtal aTtov deUTEPO KUKAO PETPACEWY KATA TIC WPES 2UH-
4up, etavovrtag Toug 39.9°C. AvTioToIxa, ol EAGXIOTEG TIHEG e@avifovTal KATd TIG WPES
8up-10up pe Beppokpacia 36.9°C, kaBwg Kal OTIG WPEG 7UU-9uP PE Bepuokpacia
32.1°C.H mmapartApnon auTh epunveueTal atrd TO Yeyovog OTI KATA TIG JECNUEPIAVEG KOl
OTTOYEUMATIVEG WPEG, N BEpPoKpacia Tou agpa gival uPnAn, Kal UTTAPXEl EvTovn €KBeoN
TOu onueiou oTnVv nAlokn akTivoBoAia. AvTiBeTa, KOTA TIG TTPWIVEG Kal BPadIvEG WPEGS, N
Bepuokpaaia Tou agpa gival xaunAdTepn, kai Oev UTTAPYXEl £vTovn €KBEaN TOU onuEiou
oTov NAio.(BA Mivakag 37)

Mivakag 38 kataypagEég Twv JETPACEWY yia To onueio 10 oTig 13/07/2023

ZHMEIO 10 13/7/23
QPA 8:42 14:58 20:13
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HAIOZ/ZKIA HAIOX HAIOX HAIOX
EIAOZ
EAADOYZ XAOOTAIHTAX XAOOTAIHTAX XAOOTAIHTAX
UTCI 36 38.8 32.6

MoAU évtovn
KATHIOPIA loxupn BepuIkn BeppuikA loxuph BepuIkn
KATAMNONHZHZ | katamévnon KATaTrévnon KATATIéVNON

2UPQWVa JE TOV TTAPATTAvVW TTivaKa, TTapatnPouue 0TI oTo onueio yétpnong 10, ol
MéyioTeg TINEG UTCI ep@avidovtal aTtov deUTEPO KUKAO PETPHOEWY KATA TIG WWPEG 2UM-
4up, etadvovtag Toug 38.8°C. AvTioTolxa, o1 EAGXIOTEG TIHEG EJPaviIfovTal KATA TIG WPEG
8uu-10uu pe Bepuokpacia 36°C, KaBWGS Kal OTIC WPEG 7TUU-9uu pE Bepuokpacia
32.6°C.H mapatripnon autr epunveleTal atmo To yeyovog OTI KATA TIG HECNUEPIAVES KAl
QTTOYEUPATIVEG WPEG, N BepUoKpacia Tou agpa gival uYnAr, Kai UTTAPXE EvTovn £KBeoN
TOU onueiou oTnv nAlokA akTivoBoAia. AvTiBeTa, Katd TIG TTPWIVES Kal BPadIvéG WPEG, N
Bepuokpaaia Tou agpa eival XapnAdTeEPN, Kal dev UTTAPXEI £vTOovn £KBean TOu anueiou
otov NAIo(BA Mivakag 38)

Mivakag 39 kaTaypa@Eég Twv PETPAOEWY Yia To onueio 10 oTig 14/07/2023

ZHMEIO 10 14/7/23
QPA 9:09 15:19 20:04
HAIOZ/ZKIA HAIOZ HAIOX HAIOZ
EIAOZ
EAAPOYZ XAOOTAIMHTAZ XAOOTAIMNHTAZ XAOOTAIHTAZ
UTCI 34.4 38.2 34.7

MoAU évtovn
KATHIOPIA loxupr] BepuIkn Bepuikn loxupn Bepuikn
KATAMNONHZHZ | katamévnon Karammévnon KATamoévnon

Z0PQwva Je Tov TTapaTtdvw TTivaka, TTapatnPouue 0TI aTo onueio yétpnong 10, ol
péyioTeg TINES UTCI epgavifovtal aTov deUTEPO KUKAO PETPAOEWY KATA TIG WPEG 2UH-
4up, etavovrtag Toug 38.2°C. AvTioTolxa, ol EAGXIOTEG TIEG E@avifovTal KATd TIG WPES
8uu-10uu pe Bepuokpacia 34.4°C, kaBwg Kal OTIC WPESG 7UP-9UU pE Bepuokpaaia
34.7°C.H mrapatripnon autr epunveleTal atrd TO YEYOVOS OTI KATA TIG ECTUEPIAVES KAl
OTTOYEUMATIVEG WPEG, N BepuoKpacia Tou agpa gival uwnAr, Kal UTTApXEl EvTovn £KBeaN
ToU onueiou aTnv nAlak akTivoBoAia. AvTiBeTa, Katd TIC TTPWIVES Kal BPadIvég WPEG, N
Bepuokpacia Tou agpa gival xaunAdTepn, kai Oev UTTAPYXEI £vTovn €KBEaN TOU onueiou
oTtov AAIO(BA Mivakag 39)

58



Eikova 22 Ameikdvion Twv OéKa onueiwv uérpnong

13/07/23 7:53-9:15

51,29.5

45.9,35.8 35.5,34

45.9,29.5

Eikéva 23 O¢epuokpacia aépa, oxetikn vypacia ,8epuokpacia UTCI ro diaotnua 7:50-9:15 otig
13/07/23
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13/07/23 14:01-15:48

66.7,404 |
56.7,35.1.4F
56.7,36.9

66.88,37.6

60.6,33.6

Eikova 24 O¢puokpacia aépa, oxerikn vypaaia ,6spuokpacia UTCI ro didornua 14:00-15:50
origc 13/07/23

13/07/23 19:08-21:00

45,313 ’
4530.1 ,

47.7,28.4
45.3,30.8

,85.7 ,29,
457,33,

46.9,31.1

&l

rt ali,

e Im‘ .

3

Eikova 25 O¢cpuokpacia aépa, axeTikn uvypaaia ,6epuokpacia UTCI ro diaarnua 19:10-21:00
oric 13/07/23
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14/07/23 08:05-10:00

.

51.3,36.8

J ¥ Ry,

e R el !
‘I'M}w——t&g 15’:}:."' Pt b 3

Eikéva 26 O¢cpuokpacia aépa, oxerikn vypaaia ,6spuokpacia UTCI ro didarnua 7:30-9:30 oTig
14/07/23

14/07/23 14:30-16:10

¥50.3,41.3
3,36.1,

58.6,37.8
58.3,39.1

,52.9,34.8

52.9,40.8

Eikova 27 O¢cpuokpacia aépa, oxeTikn uypaaia ,6spuokpacia UTCI to diaotnua 14:30-16:10
oric 14/07/23
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14/07/2023 19:35-21:05

70:6;37.7

%7.6335
67.6,33.5

65.4,31.1
61.3,33.5

Eikova 28 O¢puokpaoia aépa, oxeTikh vuypaaia ,0cpuokpacia UTCI 1o didotnua 19:35-21:05
oric 14/07/23

2TOUG TTapATTAVW XAPTES TTAPOUCIALOVTAl O TIMEG TWV BEPUOKPATIWY TOU agpa, TNG
oxeTIKAG uypaaoiag (%RH) kal Twv Beppokpaciwv UTCI yia kGBe onueio pyérpnong. Ta
METPAOIUA OTOIXEIO OnUEIWVOVTAl PE KOKKIVO XpwHa yia Tn Bepuokpacia aépa, He
AOTTPO XPWHA YIa T OXETIKA Uypacia, Kal Pe KiTpIvo xpwua yia Tig TINéS Tou UTCI.
ACiCel va avagepBei 6T onueia TTou umtdpxel éviovn PBAdotnon (C kai H)
TTapoucIdlovTal aTro PETPIEG WG UWNAEG OUVONKES KATaTdvnong ,evw OTA UTTOAOITTO
onueia TTou gival ekTeEBEINEVA OTOV AAIO OI OUVOAKEG TTOU KUpIapXouv 18iwg TIG
MECNUEPIOVEG WPEC AVTIOTOIXOUV 0€ TTOAU évTovn Beppikr kaTamovnon. O1 diagopEg
TWV JETPOoewWV eTIReRaiwvovTal Kal atmd Toug Katé TOTToUG aiodnTrPEG.

3.1.4 AtroteAéopaTa yia Tov d&iKTn TNG Yugng aépa TepIBAAAOVTOg

2€ autrv Tnv evotnTa TTapoudidlovTal Ta aTTOTEAETHATO TTOU TTPOEKUWAV OTTd TNV
eTTegepyaacia Twv dedoPévwy yia Tov BEIKTN YUEng Tou aTyoo@alpikou TTePIBAAAOVTOG.
Omrwg Tepieypa@nke a1o Ke@aAaio 2.3.4, o1 BepuoKpaacies TTou oxeTiCovTal He TNV Yugn
TOU OOTIKOU Ywpou oTrd To TApko Twv Ayiwv ATooTOAwv agloAoynbnkav e
BaBuoAoyia atmd 1 éwg 5. MNa va dieukoAuvBei n KaTavonaon Twv ATmOTEAEOHATWY,
onuIoupynRBnKe évag TTivakag TTou TTapouaciddel To eUPOG TWV TIMWY TTOU avTIOTOIXoUV
o€ KGO BabuoAoyia. ZTov TTivaka autdv TTPOCTEBNKAV XPWHOTIKEG AVOTTAPACTACEIG
yI0 €UKOAGTEPN KaTnyopiotroinan Twyv Bepuokpaciwyv Yueng. (BA. Mivakag 40)

Mivakag 40 BaBuoAoyia Beppokpaciwy TnG Wuéng Tou TrePIBAANOVTOG

EUpog wuing aépa mepiBdAAovrog
(°C) BaBuoAoyia

<1 1
1-1.7
1.7-2.3
2.3-3
>3

g | N
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2TOV TTAPAKATW TTivaka TrapoucidalovTal Ta atmmoTeAéoparta TG Wuéng Tou acTikou
Xwpou atrd Tov TTPACIvo, Ta oTToia TTPOKUTITOUV aTTO TNV aQaipecn TwV HEYIOTWV
NUEPAOCIWY BEPUOKPACIWY TTOU KATAYPAPNKAV aTTd TOUG aloBNnTAPEG TOU QOTIKOU
XWPOU PE QUTEG TOU TTPACIVOU XWPOoU Yia KABe priva Tng Bepivig repiddou. (BA. Mivakag
41)

Mivakag 41 AtmroteAéopaTta yia TNV Wugn Tou aépa Tou aoTIKoU XWPOoU atrd To TTAPKO
TWV ayiwv aTTooTOAWV

WYoén aépa mepifdAlovrog (°C)
June July August

1 1.04 1.48
2 1.00 1.29

3 0.25 0.07 1.04
4 0.53 0.04

5 0.21 0.43 1.02
6 0.22 0.16 1.15
7 0.51 0.09 0.79
8 0.24 1.35 0.97
9 0.69 2.16

10 0.81 2.55 0.56
11 0.02 0.17

12 0.34 1.26 1.22
13 0.20 0.80 1.03
14 0.39 0.02 0.63
15 aza oss 1.69
16 0.52 0.05 1.11
17 0.01 0.38 0.65
18 0.10 186 144
19 0.37 1.11 1.18
20 0.86 0.37 1.63
21 1.50 0.46 1.20
22 1.44 1.67 1.24
23 0.41 1.44 1.23
24 0.62 _ 0.52
25 0.63 1.04
26 0.16 1.16 0.70
27 1.12 0.43 0.89
28 0.10 1.25 1.01
29 0.33 0.17 0.48
30 155 l206 167
31 1.45

MEZOZ OPOZX 0.7 0.91 1.27
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O mapatrdvw TTivakag avadelkvUEl TN onUAVTIKA €TiIdpacn Tou TTPACIVOU XWPOU OTN
Wugn Tou aoTIKOU TTEPIBAAAOVTOG KATA TOUG BepPIvOUG PAVEG. ZUYKEKPIPEVA, YIO TOV
MAva lolvio, Trapatnpeeital 6T n Wuén avTioToIXEi 0€ TTOCOOTA BACEl TTEVIATTIAAG
KAipakag, €IdIKOTEPa To 72% avTioToixei otnv BaBuoloyia 1, katd 16.6% oTnv
BaBuoAoyia 2, katd 6.6% oTn BabuoAoyia 3 ,kal TEAOG KaTd 4.8% oTn Baduoloyia 4
TNG KAiJakag. H péyiotn wugn Tou aoTIKoU XWPOU ATTO ToV TTPACIVO TTAPATNPEITAl KATA
TNV 1n nuépa Tou prva louviou pe Bepuokpaoia 3,03°C, evw n eAdxioTn wuoén
onuelwveTal Tnv 17n nuépa Tou idlou priva ue Bepuokpacia 0.01°C. Kard tov urRva
IoUAIO, N WUEN TOu ACTIKOU XWpPou atrd ToV TTPACIVO XApaKTnpideTal e TTOOOOTA
KataTagng weg €ENG: 61.2% yia Babuoloyia 1, 25.8% yia BaBuoloyia 2, 13% yia
BaBuoAoyia 3, 19.35% oTtnv KAipaka. ZTnv 24n nuépa Tou uAva louAiou, n uéyioTn Wuén
avépxetal otoug 3.31°C mnv 30" nuépa , evw n €AAXIOTN WUEN onuelwveTal TNV 14n
nuépa Tou prva pe Beppokpacia 0.05°C. Ooov agopd Tov uriva AUyouoTo, n Wwugn Tou
QOTIKOU XWpPOoU aTtrd Tov TTpAcivo KaTavépeTal we €€N1¢: 30% yia BabuoAoyia 1, 56.6%
yia Babuoloyia 2, 3.3% yia BaBuoloyia 3, kai 6,6% yia BaBuoAoyia 4 kai 3.3% yia
BaBuoAoyia 5 otnv KAiyaka. H pyéyiotn wogn ToU ACTIKOU XWPEOU atmd Tov TTPAcIvo
Tapatnpeitar otnv 2n nuépa tou pAva AuyouoTou pe Beppokpacia 3.18°C, evw n
eNaxiotn Woen onuelwvetral TNV 29n nuépa Tou idlou pAva Pe Bepuokpaaia
0.48°C.Zuvoyitoviag n Olo@opd TOoU MECOU OPOU TWV NUEPACIWV MPEYIOTWV
BEPUOKPACIWY PETALU TWV ACTIKWY XWPEWV KAl TOU XWPEOU TTPACivou yia Tov PhAva
louvio avépyetal o 0.7°C avTioToixi(ovrag Tnv OTnv Kartnyopia 1 cUu@wva Pe Tov
Mivakag 40.MNa tov louhio n dia@opd ToU PECOU OPOU TWV NUEPACIWY HEYIOTWY
BEPUOKPACIWY PETAEU TWV ACTIKWVY XWPWVY KAl TOU XWEOU TTPACivou avéPXETAl O€
0.91°C avrioToixiCovrag Tnv TTaAI oTnv Katnyopia 1 cupgwva ue Tov lMNivakag 40, evw
yia Tov priva AlyouaTo n diag@opd avépxetal atoug 1.27°C KaTtatdooovTag aTov OTnNV
2 katnyopia Tou Mivaka 40.

3.2 AtroTeAéopuaTa SEIKTWYV TTOIOTNTAG TOU aépa

3.2.1 AmoreAéopaTa yia Tov deikTn Tng déopeguong/ammopdkpuvong O3,
S02, NO2 ka1 CO amé tn BAdoTnon

2€ auTnv Tnv evotnTa TTapouacialovTal Ta atroTeAéoparta atmo 1o Aoyiouiko |-Tree Eco,
Ta OTToi0 aPopPoUV ToV UTTOAOYIONO TNG OTTONAKPUVONG/OEoEUONG aépiwV PUTTWY,
OTTWG 10 0Z6V (0O3), TO dIoteidio Tou Beiou (SO2), To dioteidio Tou alwTtou (NO2), kai
10 0&€idIo Tou avBpaka (CO) atd Tn PAAcTNoN. To Aoyiouikd TTapdyel Eva didypauua
TTOU avaTtrapioTd Tnv €TACIA amTOudKpUvon PUTTWY atrd Ta OEVTPA OTO TTAPKO TWV
Ayiwv AtrootéAwv. To didypauua TTapouciadel TNV TTooOTNTA AEPIWV PUTTWY TTOU
atTopakpuvovTal (o€ KIAG).

O agovag x avatrapioTd TouG aéPIoug PUTTOUG TTOU ATTOUAKPUVOVTAl aTTo T OEVTPQ TOU
TPACIVOU XWPOoU, evd 0 Gfovag y avagépeTal oTnv TToooTnTa KABE PUTIOU TToU
atropakpuveTal (o€ KIAG).(BA.Error! Reference source not found.)
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Air Pollution Removal

800.00
700.00
600.00
500.00
400.00
300.00

200.00
100.00 . .
000 NN —
co NO2

03 PM2.5 PM10 S02

Pollution Removed (kg)

Pollutants

Eikéva 29 Etrioia armroudkpuvon pumavong (onueia) amé ra aotika dévipa tou lNdpkou twv
Ayiwv AmmootéAwv

2Uuowva pe 1o Tapatmdvw diaypauua(BA.Error! Reference source not found.
KIAG/XpOvo, Ta dévipa Tou TTAPKOU Twv Ayiwv ATTOOTOAWY ATTOPAKPEUVOUV TTEPITTOU
mepitou 750 kg O3 atd TNV atpdéoc@aipa. H ammoudkpuvon autry CUVEICQEPEI OTNV
BeAtiwon TnNG TTOIGTNTAG TOU AEPA. ZTNV CUVEXEIQ OKOAOUBEI N atmoudkpuvon oxedov
275kg pikpoowuaTidiwv PM10 etnoiwg, oupBaAlovTag oTnv TTpoCoTaCia TnG uyeiag
Twv Katoikwy Emmeita , akoAouBoulv o1 €TRoieg atmopakpuvaoelg Twv NO2 kalr SO2
avTioToixa atmmod Ta OEVTPA Tou TTPACIVOU XWPOU 01 0TToieG ayyiouv TTepiTTou Ta 165 kg
n k&Be pia. TéAog akoAouBei To CO kal Ta PM2.5 katd 45 kg kail5 kg eTnoiwg.

3.3 AtroTeAéopaTA EPWTNHATOAOYIOU
2€ QUTAV TNV €voTNnNTa TTapoucidfovTal Ta OTTOTEAECUATA TTOU TTPOEKUYAV aTTd TO
EPWTNMATOAOYIO ,META TN CUAAOYR 82 aTTavTioEWYV TOU.

H mTpwTtn £pwyTNON a@opd oTnV YVWHN TwV TTOAITWYV YIa TO KATd TTOCO Bpiokouv TO
XWPO aUTO EAKUCTIKO aTTd ATTown alodnTIKAG, XPWHATWY, OopwV Kal xou .To 50%
TwV £pwWTNBEVTWY ammdvTnoe OTI Bpiokel “apkeTA” €AKUCTIKO TO TTAPKO Twv Ayiwv
ATTOOTOAWYV ,29% TwV £pWTNOEVTWY TO BewpPEi “TTOAU” EAKUCTIKO, EVW TO UTTOAOITTO
20,7% 10 Bewpei “Aiyo” .

1 2

Apkerd
50.0%

ApKeTd
50,0%

Aivo

7.3%
Népa moAu
4,9%
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KaBdhou

1,2%
Mokl
739

ApKeTd
42,7%

5

Ndpa Tohl
1,2%

Aiyo

13,4%

ApKTETE
5

ApKeTd
53.7%

Eikéva 30 lNooooTiaia karavoun NS KGOe epwrtnong (1: EAKUCTIKOTNTA WS TTPOC THV QIoBNTIKN,

XPWUQ, OCUES KAl NX0G, 2: KOIVWVIKN aAAnAemmidpaaon/yaldGpwan /owuarikn épaoctnpidrnra, 3:

IKQVOTTOINGN yia TNV YEVIKH GUVTAPNON TOU xwpeou, 4: aiocbnua acealsiag, 5: mpoaBaaiuornra,
6: emmimeda BopuBou)

H deUTepn €pwTNON QPOPA OTNV YVWHN TwY TTOAITWY YIa TO KaTd TTO00 Bpiokouv TO
XWPO €AKUCTIKO yIia KOIVWVIKA aAAnAemidpacn / xaAdpwon /CWPATIKNA
opaoTtnpIdTNTA. TO 50% TwV EPWTNBEVTWY ATTAVTNOE OTI BPIOKEI “APKETE” EAKUOTIKO
10 TépKo Twv Ayiwv AmooTtéAwv ,37,8% Twv £pwTnNOEVTWY TO Bewpei “TTOAU”
eAKUOTIKO, TO 4,9% 10 Bewpei “TTépa TTOAU evw TO UTTOAOITTO 7,3% TO Bewpei “Aiyo’

H 1piTn €epwtnon ava@épeTtal 010 KATé TTOCGO Ol TTONITES ,Eival IKAVOTTOINKEVOL PE TN
YEVIKI] OUVTHPNON TOU XWpPou (KaBapidéTnTa ,0uvTAPNCN TOU aOTIKOU €EOTTAIGHOU Kal
NG PAdotnong) To 48,8% Twv epwtnBéviwv atrdvinoe Ot givar  “Aiyo”
IKOVOTTOINUEVOI ME TNV YEVIKI] OUVTAPNON Tou TIdpkou Twv Ayiwv ATTOOTOAWYV
A42,7% Twv epwTnBEVTWY eival "apkeTA” IKavoTtToinuévol , To 4,9% eival ” TTOAU evw
evw 10 UTTOAOITTO 1,2% “Aiyo” .

H TétapTn €pwtnon agopd oTnV yvwun Twv TTOAITWYV yia TO KaTtd TT600 Bpickouv To
XWpPo ac@aAn} .To 59.8% Twv epwTnBEVTWY aTTAvTINOE OTI BPIOKEl "apPKETA” AOPAAN
T0 TApko Twv Ayiwv ATTooTOAWV ,18,3% Twv epwTnBEévIwy TO Bewpei “TTOAU’
"ao@aAr], evw 10 22% T10 Bewpeito “Aiyo” ao@aln.

H méuTTn €pwTnON ava@épeTal GTO KATA TTOCO €UKOAN €ival n TTPOCGRACINOTNTA TOU
Tadpkou amod Toug ToAiTeG. To 57,3% Twv epwtnBéviwyv amavinoe OT1  €ival
“apKETA”TTPOCRACIYNO TO TTAPKO,29,3% TwV epwTNOEVTWY aTTdvTnoe OTI eival “TTOAU”
Tpoofdaaciyo , 10 4,9% cival * TTOAU evw evw 10 uttdAOITTO 1,2% “Aiyo”

H TteAeutaia epwrtnon agopd oTnv Ammoyn Twv TTOAMITWYV YIia TO KOTG TTO00 PpiocKouv
IKAVOTTOINTIKA Ta eTTiTTEda BopuBou 01O XWPO TTAPKO .To 62,2% Twv £pwTNOEVTWV
atmavTnoe o1 Bpiokel “apKeTA” IKAVOTTOINTIKG Ta £TTiTTESQ BOpUROU OTO TTAPKO TWV
Ayiwv ATTOOTOAWY ,22% TwV £pwTNBEVTWY Bewpei “Aiyo 'IkavoTroinTikd , 10 14,6%
10 Bewpei ‘oAU’ ’,kal 1,2% “tmapa 1mo. (BA Eikéva 30)
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4 YuptrepdopaTa

H TTapouca dITAWMATIKA epyacia avédelGe To TTAPKO Twv Ayiwv ATTOOTOAWY WG TO
MEYAAUTEPO Kal TTIO TTOAUCUXVOOTO TTAPKO oTa Xavid, ue éktaon 540 oTpePATWY Kal
OUVOAIKG TTpdaoivo Xwpo TTou TrepIAauBavel 1991 dévtpa. Kupiapxo €idog dévTpou ival
N XOAETTIOC TTEUKN, aKOAoOuBoUpEVN aTTO TOV EUKAAUTITO, TO AAUUPIKI KAl TEAOG TNV NG
Kal Tov @oivika. ATTO Ta ATTOTEAECUATA TWV UTTOAOYIOHWY, TTPOKUTITEI OTI N €TACIO
akabdapiotn déopeuon avBpaka atrd Ta OEVTPA TOU TTAPKOU AVEPXETAI O€ TTEPITTOU 23
TéVOoUg, JE TNV atroBAkeuon va @Tavel Toug 1109 tévoug avBpaka.

AvaQopIKG JE TIG PETPAOEIS BEPPOKPATIOg, O WEYIOTOG PECOG OPOG TWV MEYIOTWY
NUEPNOIWY BEPUOKPATIWY KATAYPAPNKE KATA Tov MAva loUAIo, evid n €AAXIOTN
kataypdenke Tov louvio. O1 PeETPAOEIG TNG Bepuokpaciag Yuéng Tou TTEPIBAAAOVTOG
aépa Ocixvouv 6T, KaTd PECO OPO, O TTPACIVOG XWPOGS TTAPEXEI YUEN OTOV AOTIKO XWPO
Katd Trepittou 1°C, pe TIG UWnAOTEPEG TIMEG va TTapaTnpouvTtal Tov AUyouoTo.
EmmpdobeTta, o TTaykdouiog BeppikdG KAIMaTIKOG OeikTng (UTCI) KaTEDEIGE ONUAVTIKEG
OIaPOPEC OTIC OUVONKES BEPUIKAG KATATTOVNONG WETALU TOU TTPACIVOU XWPEOU Kal TNG
OOTIKAG TTEPIOXNG, KABWG Kal EVTOG TOU idIOU TOU XWPOU TTPacCivou, €I0IKA KATA TOug
MAVES loUAI0 Kal AUYOUOTO. ZUYKEKPIMEVA, TTOPATAPNBNKAV CNUAVTIKEG SIOKUNAVOEIG
OTIG OEPMPIKEG KATATTOVACEIG €VTOG TOU TTIPACIVOU XWPEOU, atrd TTOAU €VTOVeEG £wG
METPIEG, AOYW TNG OlaQOPOTTOINCNG TNG TTUKVOTNTAG Tng PAAOTNONG OTa onueia
METPNong. O1 Beppokpaacieg Tou TTPACIVOU XWPEOU TTOIKIAOUV avaAoya PE TO €TTITTEDO
NG BAGOTNONG, WE TIC TTEPIOXEG ME TTUKVA BAAOTNON va TTapoucidlouv OnUavTIKG
XOUNAOTEPEG BEPUOKPOCTiEG 0 GUYKPION KE TOV AOTIKO XWPO Kal GANEG TTEPIOXEG ME
Aiyotepn  BAdotnon. Aut n diakUpgavon oTtn Bepuikh  Katammévnon Kal  TIG
BepUOKPACIOKEG BIAPOPES OTTOTEAEI ONUAVTIKO OTOIXEIO yia TN AW MEANOVTIKWV
OoXeOIOOTIKWY ATTOPACEWY ATTO TTOAEOBONOUG KAl PNXAVIKOUG.

AT116 Toug UTTOAOYIGHOUG Tou AoyIoMIKOU |-Tree Eco TpokUTTTEl akOun OTI T OEVTPA TOU
TTPACIVOU XWPOU GTTOPAKPUVOUV CNHAVTIKEG TTOOOTNTES PUTTWY aTTd TNV aTUOCPAIPA,
ouvelIo@épovTag €10l aTn BeATiwon TnG TTOIGTNTAG TOU aépa Kal OTNV TTPOCTacia TnNg
UYEIaG TWV KATOIKWV.

TéAog, n cuAdoyr TNG ATTowng Twv TTOAITWY Yia BEPaTa TTOU a@opolv TNV aiIobnTIKA,
TNV TTPOCRACIOTATA Kal TNV ac@AAEIa TwY TTPACIVWY XWPWV gival (WTIKAG onuaaiag
yIO TOV OXEQIO0NO XWPWV TTOU VA avTATTOKPIivOVTal OTIG AVAYKES TNG KOIVOTNTAG.

H yvwon autwv Twv TTapapétpwy Ptmopei va BonBroer otov oxedlaoud Kal Tn
dlaxeipion Twv TTPACIVWY XWPWY WE TPOTTO TTOU va BeATILvEl TNV TToIOTNTA WAS TWV
KOATOIKWV Kal va TTPodyel TV uyEia Toug. EmITTAéoV, n €yKATAOTACH €VOG TTUKVOU
OIKTUOU a10BnTApwyv 1600 OTOV TTPACIVO OCO Kal GTOV OOTIKO XWPEOo Ba TTPoCPEPEl
ouveXeic PeTproelg Oedouévwy, ETITPETTOVTAG £T01 TNV TTIO AKPIPN EKTiPNON Twv
BepuIKWY ouVBNKWYV Kal TwV TTEPIBAANOVTIKWY TTAPANETPWY. AUTO Ba ETTITPEWEI OTOUG
TTOA€OOOUOUG UNXAVIKOUG va AauBAvouv TTo EVNUEPWHEVEG QTTOPACEIS YIO TOV
OXeOIOONO Kal TNV QvaTITugn Twv TPACIVWY XWPWYV, AauBdavovtag utroyn TIg
TTPOTIUNAOEIG Kal TIG avAyKeg Tou TTANBuopou. H pébodog TTou Xpnoiyotroienke otnv
TTapoUoa £pyacia YTTOPEi va EQAPUOOTE KAl 0€ AAAEG TTOAEIG yia TNV agloAdynon Kai
™ ouykpiIon Twv TPACIVWY XWPWV Kal Tn onuioupyia BEATIOTWY TTPAKTIKWV
oxedlaouou.

67



REFERENCES

[1] M. Santamouris kai D. Kolokotsa, ‘On the impact of urban overheating and
extreme climatic conditions on housing, energy, comfort and environmental
quality of vulnerable population in Europe’, Energy Build., 1. 98, 0o. 125-133,
louAiou 2015, doi: 10.1016/j.enbuild.2014.08.050.

[2] IUCN, International Union for Conservation of Nature, IUCN Global Standard for
Nature-based Solutions: a user-friendly framework for the verification, design and
scaling up of NbS: first edition, 1n ékd. IUCN, International Union for
Conservation of Nature, 2020. doi: 10.2305/IUCN.CH.2020.08.en.

[3] D. Kolokotsa, Aikaterini A. Lilli,, Maria A. Lilli, Nikolaos P. Nikolaidis, ‘On the
impact of nature-based solutions on citizens’ health & well being’, Energy Build.,
T. 229, 0. 110527, AekeuBpiou 2020, doi: 10.1016/j.enbuild.2020.110527.

[4] European Commission. Directorate General for Research and Innovation.,
Evaluating the impact of nature-based solutions: appendix of methods. LU:
Publications Office, 2021. Huepopnvia rpéofaong: 17 Oktwppiog 2023.
[Ekdoon oe wnolak popen]. AiaBéaiyo aTo:
https://data.europa.eu/doi/10.2777/11361

[5] P.J.Villeneuve k.d., ‘A cohort study relating urban green space with mortality in
Ontario, Canada’, Environ. Res., 1. 115, 00. 51-58, AekepyBpiou 2012, doi:
10.1016/j.envres.2012.03.003.

[6] C.Ward Thompson, J. Roe, P. Aspinall, R. Mitchell, A. Clow, kai D. Miller, ‘More
green space is linked to less stress in deprived communities: Evidence from
salivary cortisol patterns’, Landsc. Urban Plan., 1. 105, 1x. 3, 00. 221-229,
ATtrpiAiou 2012, doi: 10.1016/j.landurbplan.2011.12.015.

[7]1 E. Thiering k.a., ‘Associations of Residential Long-Term Air Pollution Exposures
and Satellite-Derived Greenness with Insulin Resistance in German
Adolescents’, Environ. Health Perspect., 1. 124, 1X. 8, 00. 1291-1298,
AuyoucTou 2016, doi: 10.1289/ehp.1509967.

[8] B. Balseviciene k.4., ‘Impact of Residential Greenness on Preschool Children’s
Emotional and Behavioral Problems’, Int. J. Environ. Res. Public. Health, 7. 11,
TX. 7, 00. 6757—6770, louAiou 2014, doi: 10.3390/ijerph110706757.

[9] R. Pilli, S. J. Kull, V. N. B. Blujdea, kai G. Grassi, ‘The Carbon Budget Model of
the Canadian Forest Sector (CBM-CFS3): customization of the Archive Index
Database for European Union countries’, Ann. For. Sci., 1. 75, 1x. 3, Art. 7X. 3,
ZemTeuPBpiou 2018, doi: 10.1007/s13595-018-0743-5.

[10]‘https://natural-resources.canada.ca/climate-change/climate-change-impacts-
forests/carbon-accounting/carbon-budget-model/13107°.

[11]F. A. Chrenko, ‘Paper 8: Thermal Comfort’, Proc. Inst. Mech. Eng. Conf. Proc., T.
182, 1x. 5, 00. 13-19, zemrteuPpiou 1967, doi:
10.1243/PIME_CONF_1967_182_147_02.

[12]D. Fiala, G. Havenith, P. Brode, B. Kampmann, kai G. Jendritzky, ‘UTCI-Fiala
multi-node model of human heat transfer and temperature regulation’, Int. J.
Biometeorol., 1. 56, TX. 3, 00. 429-441, Mdiou 2012, doi: 10.1007/s00484-011-
0424-7.

[13]K. Btazejczyk k.d., ‘Principles of the New Universal Thermal Climate Index
(UTCI) and its Application to Bioclimatic Research in European Scale’, Misc.
Geogr., 1. 14, 1x. 1, 00. 91-102, AekepBpiou 2010, doi: 10.2478/mgrsd-2010-
0009.

[14]

‘https://www.eclass.tuc.gr/modules/document/index.php?course=MHPER278
&openDir=/65e6¢c722DIrP/621a462bcay3/62404b2ewPWX..

[15]L. F. M. Francis ka1 M. B. Jensen, ‘Benefits of green roofs: A systematic review of
the evidence for three ecosystem services’, Urban For. Urban Green., 1. 28, o0.
167-176, AekepPpiou 2017, doi: 10.1016/j.ufug.2017.10.015.

68



[16]K. R. Gunawardena, M. J. Wells, ka1 T. Kershaw, ‘Utilising green and bluespace
to mitigate urban heat island intensity’, Sci. Total Environ., 1. 584-585, co. 1040—
1055, AtrpiAiou 2017, doi: 10.1016/j.scitotenv.2017.01.158.

[17]L. Shashua-Bar kair M. E. Hoffman, ‘Vegetation as a climatic component in the
design of an urban street: An empirical model for predicting the cooling effect of
urban green areas with trees’, Energy Build., 1. 31, 1. 3, 00. 221-235, ATpIAiou
2000, doi: 10.1016/S0378-7788(99)00018-3.

[18]‘Report: Impacts of Vegetation on Urban Air Pollution - Defra, UK’. Hugpounvia
TpooBaong: 8 lavoudpiog 2024. [Ekdoon o€ wyn@iakn popen]. AlaBéciuo oTo:
https://uk-air.defra.gov.uk/library/reports.php?report_id=966

[19]D. J. Nowak, ‘Understanding i-Tree: 2021 Summary of programs and methods’,
U.S. Department of Agriculture, Forest Service, Northern Research Station,
Madison, W1, NRS-GTR-200-2021, 2021. doi: 10.2737/NRS-GTR-200-2021.

[20]'What is i-Tree?’ Huepopnvia mpdoBaong: 9 lavoudpiog 2024. [Exkdoon o€
wnoeiakn popen]. Alabéoiyo oto: https://www.itreetools.org/about

[21]‘https://www.itreetools.org/documents/275/EcoV6_UsersManual.2021.09.22.pdf’.

69



6 MapdpTnua

6.1 Mapdptnua 1 (Bhpata dnuioupyiag Tou Aoyiopikou I-TREE ECO)

ject Configurat Vew L 2t Support

- A
FTomPs o9 % | Q[
User  User +Tree  Video User +Tree Software About License Feedback What's Change

Manual Guides» Methods Leaming Forum Webste Update

Help. .

To get started, i

*  New Project - to create 8 new Eco project
*  OpenProject - o open an existing Eco project
o,

at the top o £0 access the dif «um
phases of  you can click on one.
vt I the bon ses. T fekhae Uhnt v choces will become avafiste I e
action panel to the

Agreement &Bugs  New

Log

i“Wee Ecov6.032

Welcome to i-Tree Eco!

i-Tree Eco is a software application designed to use field data from complete inventories or randomly located plots throughout a study area along with local heurly air pollution and
4 meteorological data to quantify forest structure, environmental effects, and value to communities.

If you are new to Eco, please review the resources in the Support tab for more information.

| i.Tree 1fyou have used prr—--

Guidance is providy

ew Project
1f you wish t0 FESUE pieqse select the project type:  Comglete inventory
[complete inventory

/A complete Inventory project Is one In which you collect data
for all of the trees you are interested in. Exsmples of

Notes:

iselection of heritage or memorial trees in your town.
Complete inventories can ai5o be used to project the benefits
lof a planting project using the Forecast module. Complete
inventory peojects are most useful when detalled information
15 needed on each individual tree or the number of trees
interest can be assessed with 3 reasonable amount of effort

Data import is only enabled for complete inventory
projects and Is not possible for plot-based projects.
You canact change between Complete inventory and

You click OK
sel

Cancel

==t~ projects by going to the File menu in the ribbon above.

. #nu in the ribbon above.

lanusl in the Support tab for more information.

Eikova 31 Anuioupyia véou project

[Preject: MAPKO ANON ANOITOAGN] [Series: 1] [Vear: 2023] - i-Tree Eca v6.0.32

For move informotion: b itrestgols grg) view/itese
ranuals-workbooks

b

EEEE roect confiustion | Data Vew  Reports  Forecst  Support

Bl )

Project | Land Crown | Projectd
Defmton | Use Heath | Strata Area
Help.

Project Configuration > Project Definition » Project Settings

‘The Project Settings tab seen in the action pane! to the right is where you identify
many of your mest important project settings.

steps:

Project Configuration > Project Definition

Enter project overview information and cliek OK to save it or Caneel to quit this process.

Location Data

Enter & name for your project in the bax provided. Your i
Tree Eco praject s uniaus 1dantit. This 13 350 the mams ot wil be used when
referring to your study area in your model results (available on the Reports tab.
of the ribbon)

Enter a series name for your project in the box provided. Again, your series name
n be used ta identify the exact
ParkTrees” or “City" - to distinguish it fram
‘ather £co projects dane at the same time In the same place, If necessary. This
series name can be used In the future to reference the data for this project.

@

Enter » series year in the box provided. It is recommended that you enter the year
of your data collection for this variable.

- tory type does nat need to be defined, This information is aulmm:alw
1.||.d m besed on the project type that you defined when you started 3
Broject

Go through the ather tabs, Location and Data Collection Options, which are available
in the Projest Definition functicn. When you are satisfied with the roject setti
click OK in the top rig corner of the action panel.

‘wrers itrestgols 0rg/suppor

For mare information: hiigs
manusls-workbooks

What, ¥ project?

APKD Al

Project Name: N ANCITOACN

What name would you like to give your series?
Sories Name: 1

Please specify the series year for your project:
Seriesvear: 2023

Please specify the following inventory information:

Inventory Type:  Complete Inventory

Eikéva 32 Eioaywyika oToixeia tou project(ovoua apiBudg ékdoang ,£ETo¢ dnuioupyiag)
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«
R #osect Confouraton | 03t

b B g@z

Project  Land Cown | Project& | CSv
Defntion  Use Heath  Stats Area Mode: Off

Define Data Fekds Bxpot

[Project: 1) [Vear: 2023] 32

Hep.
Project Configuration > Project Definition > Location

Project Configuration > Project Definition

the
identify what data you will collect in the field.

Project Settings Location  Data Collection Options.

PR i nonis Enter project overview information and click OK to save it or Cancel to quit this process. ok
¥ stat Project Settings  Location Data Collection Options.
Steps:
1. Select the location where the majority of your study area is located using the Please select a location to use for your project:
L Hine: Use the Deiete ey 1 iear o sefection
Thatis,
or identify your focation Select please see hitos //database b
35 precisely 35 possible.
2. Specify whether your study are is urban by checking the appropriate box. If Nation: Greece ions/Oi for i £ Columbus, Ohio, USA s listed under Delaware
your study ared is rural lands, y <ounty, although expected in Franklin county.
answer thi see State: Nisia Algaiou, Kritt
Notes below,
County: Xanis
3. Enter your population values. for all locations the "Population” entered will
be used in reports that include “per capita” summaries. For locations in the Place Chania
continents| US, the *Population” entered will also be used to scale BenMAP
incidences and values a5 described in the “Pollution sthe studyareaUrban? @
Removal” section of Understanding i-Trees. n select locations, also enter your
i i ed and Population: 54559
N pa
i popul Population per km: 4
“ ¥ for your : ety the US may be d affect
! tist
yea is available. if that choice is made, then the reports that rely on pollution Weather & Pollution Year: 2015 (Westher snd Pollusion) Show Pollution Stations
data will not svailable
5 The ¢ button will Youk peojact
Sased oalocation sad wveitabilky. Weather station: 16746099999 show Mop
6 ifyour isina
check
Tropical Carbon
Fauations,
7
ough tabs, which are
proj  click OK in o
action panel
Notes:
. For rural, urban
Sauare mile (193 people per square klometes) For sdditionl urban fand
definitions, see the U Census Bureau:.
a [Project: 1] [Vear: 2023 = P R
EEED roectconfounton | Data Vew  Reports  Foreast  Support
Project | Land Cown | Projectd | SV | Edeng
Defoton  Use Heath | Stata Mode: Off
Defng Data Feids epont
Project Configuration > Project Definition
| Enter project overview information and click OK to save it or Cancel to quit this process. oK

Steps:
1 ‘What units ¥ & These fields MUST be collected!

English (e g, inches) units by clicking next to your preference. English This project h . he: HiGHLY essmatons.
2 See Notes ®_These feids are optonal

below. © Metric
3. Defi in the box of

action panel (eg. et

o 100¢ fewer Minimum Requirements. General Site Fieids Tree Detai Fields Management Fields
categories
@ species () Tree address @ Total tree height () Maintenance recommended
reak g [ -0 @ Landuse @ crownsze () Maintenance task
birphned L click oK - Measured 8 strata/area . Nﬂ:mlmuwm () Sidewalk conflict
is wil « Height to crown
hadins « Check this box if you know your project area. it O utiity confict
« See Project & Strata Area to configure i
dase % X B D( M:Lmr«man-m‘)
While th h Status Crown Health requires
allows users with limited, existing inventories to run the model, it also has. o L * Sign & symptoms of tree stress
substantial limitations, The accuracy of ecosystem service estimates can be () street tree/non-street tree © Dieback « Sign & symptoms of fokage/twigs
deio 8 Default non-street tree O Condition « $ign & symptoms of branches/bole

for i-Tree Eco data collection.

8 Map (GPS) coordinates

@ Crown light exposure

Data & Ecosystem Service Relationships O public/private [0 Energy (building interactions)
The letters
fauit Public « Distance to budding
service o model the data. Duuul e
n * Direction to budding
iabl
detail below Define up to three additional fields and their values:
A= air pollution removal; C.Stor = carbon storage; C.Seq. = carbon sequestration, £
=Forecast, R = avoided runoff; § = or O cust
Minimum Required Tree Measurements B o Nt s s
* Spedes=soacies conmen o, scentfic same o code. Ecoeatres O Custom Fiekd T .
Refer
£co database. (4, CStor, C5eq. £, R.5.V) Tree Information
o ecogrymiedks iy ‘:M‘»m::«’h The information The extramodel =
erepirpiindy wiia chseifinmmidy po inthe right-hand The optional g
thagcound. e reustel snd s far oy assiednce chicks oc for e ata that must be collectedfor each extra model component are designte d by an " 2
tegor Desaription E
1o further action is required. If categorized is chosen, users can then o felds.
fer cli
oot = [species [identfy snd recordthe secies and genus names of each tree T reaueeo |

Once OK s clicked,

Eikéva 34 Eioaywyn Twv oToixeiwy 1mou Ba emeéepyacTei To HovTéAO

- | Exact measurement or categories of the tree stem diameter 3 breast
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Project Configuration > Project & Strata Area
‘Project Configuration > Project & Strata Area

The Project & Strata Area feld seen in the action panel to the right i3 where you Strata & Zones: madify the values below as needed. oK
cam enter the ascs of your project or strata. This function 150 sllows you to

study units, such a5 land v
counties. your project I3 53 that you Total Area (ha): 55,00 Total #of Trees: 1991

can compare urbian forest effects between each stratum.
D | Descrption Abbrevaton | Area(ha) | # of Trees

proje you single
your entire study ares

“IMPORTANT*
This function will ot be wailable if you did mot set “Strata/Ares” during project
To. io

“Stratajares” you will
changes in this function. [Note If you did not set “Strata/Ares” as described, per
unit ares estimates will nat be included in the Reports tab. )

‘Steps for unstratified complete inventory:

1. When you click on the Project & Strata Area functian, you will see 8 single
strata listed in the table.

z abbrevistion,

manuslly adit those variables in the table (see Notes below).

Manually enter the ares of your project. This size should represent the entire

sampled aren of your project [see Notes below).

M

& whanyou are enty,
o yeu
5. Click Cancelif you decide to revert 1o all o the previous values, whether
manwally.
‘Steps for stratified complete inventory:
1. When the.

you
become available on the ribbon.
Use the tools In the Actions greup to customize the table of strata and zones.

2

3. The Actioms tocls allow you to create ar delete strata, undo or reda your most
recent actions, and restore

a by spectfying s in
the table (see Notes beiow).

s strata. This
sampled area of the strata (see Notes below).

& When you are entry,

This will
7. Click Cancel if you decide to revert to all of the previous values, whether
manuslly.

Notes:

* The Description” that you enter I used In reparting some Eco results by
strato on the Reports tab.

. e unitarea, or
density, estimates that are included in some of the Ece results e the Reperts

. entered here, "

will be.

+ The Tree caunt” col in based on ¥

enter in the Data tab,

Eikova 35 Eioaywyr OTOIXEIWV TNS TTEPIOXNS HEAETNS

[Project: nes: 1] [Year: 2023] - i = o X

Data > Inventory Value > Benefit Prices

Data > laventory Value > Benefit Prices.

Adjust your Beneft Prices (advanced users)
(e study ared. Noges:

= Tne o sof
A Jou oy €pcer your v ol 1o koo rem

model. Please use this function with caution! 2

2 wmouT
2. perns Benefit Prices

valuation immediately. (€(EUR ) 0198
n . Heating (€ 164

Eco; Carbon (€ 160,67

Avoided Runoff (€ (EURY/m") 1902

Steps: For processing.
A ¥
2 o
2. 100 1 =€(EUR) 0,93076 Get today's rate

‘made to the prices. .
4 Click Cancel whidie
“IMPORTANT*

& currency

your
Australia, Canada, or the UK, default prices are specific to each country.

Notes:
5 incaus
inental
parentheses. g
listed
. then the
o ;
- (es) file.
Notepad.

Eikéva 36 Emidoyn twv benefit prices
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L.} [Project: aAc To mapwko)] [Series: 1] [Vear: 2023] - i-Teee Eco v6.032

EEER rroectconfpuaton | Data | Vew  Repots  Foecst  Suppott

Wl“ﬁ@’@‘ﬁ’$¥ﬂx

Paper  Import  Trees Check Bmeft Anmal | DEH Crown
mm '-mm:‘\ Fom Daa Costs. Heah

Data Collectior Inventory Data Inventory Vakue | Report Chsses|  Export Actions

Help.

Data > Data Callection > lempart

Data > Inventory Data > Trees

Required inputs MUST properly 18 vou get stuck, over.

Do you have an existing inventory? The kmpart function in = =i =i = s

allows you 1o impart your existing tree inventory data, This toe! is only availabie for D | Statum | Crew | SeveyDate | Status Spacus Photo ID DeH 1 (em) y g OB 2 (em) 3 =

complete inventory projects and is generally greyed cut in the ribbon until you click Use Heght (m) | Measurad? Height (m) | Measwred? ‘
Trees functi

onthe unction i-Tree Eco - Dta Import Wizand - 0o x

s tatmport vetony: : o B8 a ini d ke toi L =0 . a e |
I the Data Impart Wizard, <lick Browse : st Select the file containing the data you'd like to import. 50 ] ]

2. Navigate to the ile containing your inventory data. i Tobe Fite Name C\Users\Seyras|Downioacs\| TREE ECO CAO TOMMP (1> | Beowse | | 140 B T s

3. Selectthe file and click Open. " g e —a a1

4. Canfirm that the data that appears in the table is correct and click Next e Workshees or Range: | Worksheet: SheetlS o | | ! ! !

s Mmzhymr:«.nm‘dm el Ecorsdos elds 7 | 8 Firstsom contains calumn headers E 13000 . = .|

6 Selectan will appear inthe | g = 20 ) e
~Your seurce Column space wrdswwmmvl 1 sha height height | |

T, Chins e ooVl fram e arop-dose i T Gehnda herpe of ara i 3 [ubm | e o | oag [ | F7 | P L. 0 L] L
your selected column. n |ube | | 150 a ]

& Check the box indicating whether or not you will need tomap your feldvaluesto | 112 |tan v |0 poimcam | Tamaincevansen 321 25.9787 35,5107 141 ET) ] [}
:;E(;r:‘w‘i::rntmﬂ?'muwrmm:o‘mwmhmmmwu 5 Uban 1 Point M | Tamarix tetrandea 133 23,9787 35,5128 13 : 1) 600 ] 2

5. CONDITIONALLY AEQUIRED: As previcusly described, Eco data variables can oten | |16 Uban |3 |PeintZM | ewahptus 169 289786 | 55,5119 169 L 1278 a L]
be displayed in several ways. For example, species dota con be 7 e t fointZM |eucalptus 124 (283787 385029 124 | 200 ] [}
comman name, scientific name, er species code. For data variables where this. " [T 4 PointZM | ewcalyptus 126 23,9786 35,5129 126 500  m a2 |
pplies, b “Fiel Type” drop-down list will sppear below Eea Field ” Select the 1 T porrrs P ot vt ey . —1 1
el type thatmatches yous existing data I [ |s  [eomean |eusanprus 3, |aasmer 385 3, = ) = C

10, Repest steps & through 3 unti each variable that you would like imported haz o |uem |6 [poinezut |ewanprus 182 23,9785 35,513 142 | M| 700 [] | ]
been matched 1o the appropriate Eco field 1 [ 7 |poinczm | ecanprus 155 23,9786 35513 145 om0 ] e

11. Click Next T Tuben {8 eoinezut [pine 80 T2nams a5 e & T T I

13, CONDITIONALLY REQUIRED: For data variabies that you indicated the nesdto mas | | = 1 a1 5 s 5 L e a L]
field walues [step B), match your Field values to Eco's. W usa L] ointZM_|pine 2 23,9786 | 35,5132 2 |3 300 a []

13, I the upper table, select a row # |ubm 10 PointzM | Tomarintewanara 26 25978 35,5182 26 200 ] []

14, Inthe lower table, chogse the "Ece Value® fram the érog-davm lst that maiches »  [otm - o s o
“Vour Value” . -

* Uban 4800 a a

15, Move threugh the lowss table until all of your values have been matched ta an Jubn 38 L
Ecovalue. 7 b <Bock cancel o s e

16. Repent steps 12 through 15 until all necessary data variables hove been mapsed. | 29 uben W] T TR T 3 5200 [] []

17 Click Next » I T i T " T 0 Cm 8 1

18, Reviewthe results X L ! | Wil . ¥ | 1 1
This il el from your be| (0 |uom | Uknomn P 00| s @ e
imported. N Liban LUrkanown ok $300 a [ ]

19, Wihen you bre satisfied with the data that will be imparted, elick Finish. (Note: T = 1
Use the Biack button to retusn to previous steps to make adjustments.) 2 | h - =ho | @ .|

1 [ Ukanown Pak 5300 a a
- _— . . U uem |Unkeown | Gucalpiis camaenss Eucahptus camaldunss 1 sva) Posk 5200 [] []
more oot et ” - o P 2 a
% |uem Urknen o) Pk 4900 [] []
a7 Uban Uninown rata) Posk: 4000 a a
£l Wb Uniknown mem‘m-: Pk %00 e L]
- [Project: aho vo mapeo] [Seres: 1] [Year: 2023) - i-Tree Eco v6.032 -
TR rroect Confiourstion | 0a | Vew  Repots  Forecest
G E D0 SN DS TeOONNCE X B
Submt  Retreve | Paper| kmport Trees check Benefit Annual | DBH Giown | CSV KML | New Undo Redo Restore Delete
o Moble from Mebie | Fom Data | Prces Costs Heath Defauls
Data Coliection Inventory Data | Inventory Vaie | Report Cosses|  Export Actirs
Help
Data > Inventory Data > Trees
Data > Data Calestion » Impart
i . 1 you get stuck,
Do you have an existing inventary? The mport function in Land DBH 1 DBH 1: DEH 2: DEH 2.
allows you 1o import your existing tree inventory data, This too! is enly available for o Statum | Cew Sunvey Date Status Speces Photo I DBH 1 (am) g . 08H 2 (cm) 3 :
complete inventory prejests and is generally greved out in the ribben until you click Use Height (M) Measured? Height (m) | Measured? |
b
o the Trees function. i-Tree Eco - Data Import Wizard [ Not Assigned =
st 3 Uban o 1500 a a
eps to impart Inventory: i = - 1 1

1 i e Outo ot wherd, clck Beowsz. . = Select a column below and then define how to importitinttg . poo s s

2. Navigate 1o the file containing your inventory data 5 = cohimp BEFORE elicking Next. Grew I s ° a

3. Selectthe file and click Open. ey - 1 1

+ coolh 5 [ 1500 a []

: rm that the dota that appears in the table (s correct and click Neat. wpe heght {m{species~ .

5 Mwhvmru.mudmﬂem;mam'sdmflzrds 7 it LondUse. 1300 L] a

& Selestan able. Th o will appear inthe A [ Tamariatetran.. | 141 "o"m“g‘)_ 1220 ] a
ot Soutce Colur” Space owards the oo of the window -

Choose the "Lca Field” from the drap-down listthat defines the type of data In : L Pmiramn 133 Eevbrtaaiis - 0 [] L]
your selected column. n Uban eucalyptus 185 ow . 50| . a a |

B, Check the box indicating whether or not you will need to map your ieidvaluesto | (18| tean evennprus 128 (0B 2 Height () 20 [] []
the vouwall 15 uean evean 126 [omsm | sa0 w @ =
Iter, See steps 12 through 16) . fuesens | ]

5. CONDITIONALLY REQUIRED: A previcusly described, Eco data variables canoften [ 18 Uben eusatiptus 131 1270 a a
e displayed in several ways, For example, species data can be entered a5 17 e evaalyprus 12 ) [] 8
comman name. scientific name, or species code. For data variables where this 8 Juen cecnnprs 18 0 e )
spplies, a Fi Grop-domn list will appear below Eca Field * select the
field type that matches your existing data. Ll W pine 89 000 L) L]

10. Repeat steps 6 through 9 until each variable that you would like imported has e \ban pine 7.2 7100 a a
lieen matched to the appropriate Eco field. 2 Uoan Tamarintevan_. |28 mo ] (]

11, Click Next

12 QUIRED: For dats variables that you edtomep | |22 [ oo ] | @ e |
field values (step 8), match your field values to Eco’s 3 tan ~ DESIENDLES B required ECO Fieid T Mest BE MAgoed. Invalid of u 300 L] . a

13, Inthe upper table, select a row. % uon fields wil rEsultin records that camnet be impored - see Suppart w00 ] B

14. Inthe lower table, choose the TEco Value” from the drog-dawn |ist that matches. I ” Your Seurce Column:  FID Eee Fisla w00 T a a T
“Vour Value.”

15, Move through the lowes table until 1l of your values have been matched to an % | . . o | B a0 L] L]
Ecovalue. 27 e [T ] ]

16. Repeat steps 12 through 15 until all necessary data variables hove beenmapoed. | 23 (san T T [Ubenn 1 00 ] )

13 Clck bt : h & !

38, Review the results of your prosessed data atthe 195 of the Data import Wiaard, C ‘ it e | @ . |
This information will tell you how many records from your inventory data will be | |30 Wtan | Unknown oveta) | Pak ELL 510 a a
imparted B Uoan Uk o) | Pasc smo ] ]

15, When you are satisfied with the data that will be imparted, lick Fnish. [Hote w o e F F
Use the Back buttan ta return i previous sieps 1o make adjustments | . t

£l \Sban | Unkngrn: a) Pak, s a a |
E = ko Pk, 500 a L]

Eikéva 38 AvrioTtoixion 6Awv twv dedouévwy Tou Excel ue Tic emAoyES Tou povréAou
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[Project oho o mapo] [Series: 1] Vear: 2023] - i-Tee Eco 6032
DRl roectconfuation | Datz | Vew  Reorts  forest  Suppott

E B FH e @M D 8§ T8 D6 X m

Submt  Fetreve | Paper | Import | Trees Check | Benefit Annual | DEH Crown | CSV KML | New Undo Fedo Restore Delete | Editing

to Moble from Moble | Form Data | Prices Costs Heakh Defauks Mode: On
Data Collection Inventory Data Inventory Vake | Report Casses|  Export Actions

Help.

Data > Inventory Data > Trees
Data > Data Collection > mport
Required inputs MUST 1 you get stuck, over.

D0 You have Bn existing inventory? The Import functicn in

Bllows you ta impart your existing tree inventory data. This tool is only available for © Stratum e Survey Data Stats Spucks Land DEH 1 (am) OBH 1t DBH 1: DBH 2 (em) 08H 2 08H &
complete inventary projects and is gemerally greved out in the ribbon until you click Use Heght (m) | Heasured? Height {m) | Measured? ‘
‘o the Trees function.
- Data Import Wi o
3 Uban 1500
Steps to lmport inventory: ! 1 L !
1 inthe Dot lomport Whzard, click : Selecta column below and then define how to import it into Eco, Repeat for EACH 2es0 e ]
2. Navigate 1o the file Containing your inventary Gata, TS Toew column BEFORE clicking Next. L f s :
3. selecthe file and click Open. T 1 T
4. Confire that the data that appears in the table is correct and click Nest. 6 |Ubon F1% tyel :;'ﬁ;‘m‘ 1 e L] | . B
5. Match your existing data fields to Eco’s data fields, 7 |Uban | | I 30| a L]
6. Selectan inventory column from the table. The column header will appear inthe | |3 sben Tamarix tetran._. | 1551000000000 1220 [-] a
“four - ndow. T | - |
7. Choose the o Feld" from the drap-down ist that defines the typetdatain | 0|89 [momarevevaa.. |1essocoonos ||| Ll L] L
your selected columa. [ Usban eucatyptus 1858 1150 ] ]
B Check the bax indicating whether of nat you vl need 1o map vour field valuesta | |14 Utan X | |eveatmtus 13,64000000000 200 [] ]
the (Mot You wi f i E1 T T
Iater, See stens 12 through 16) L - | Al . = 0] @ .
° 1 " Ut eucalvptus 1441 1270 L] a8
be displayed in several ways. For example, species data can be entered a5 ” Leban ualypeus. 15,6200000000C 3200 L] a
‘comman name. scientific name, or species code. For data variables where this i) Tistan @*,u,wm | 16,0800000000¢ 00, ] 2
applies, & “Field Type” drop-down |ist will appesr below Eco Field " Select the .\ - — —
field type that matches your exlsting data. 119 Uk W e A7RO00000K || L. L] L]
20, Repeot steps & thraugh 3 until each variable that you would like imported has £ Uben nine o | 7100 [] ]
been matched to the approprinte Eco field. 7 Utan 00 a L]
10, click et I | B £ L invatio forrequines -
12 bl o g 2 | Uban fields will result in records that camnat be imported - see Suppon > User Guides for details. L 0| a ]
field values (step 8], match your fieid values to Eco's. B |Uten Vour Source Column: oW Ecofield:  Crown: % Dieback <E 00 L) L]
13 1n the upper tble, select o u Ubon . S 200 (] -]
4. nhe omes e, chae the o Valu”rom the drop o st tht atches PR B | eeato map mysoute LTSS OB g Tme: % Dietock v s B 8
our Value.” L uban — ! ! ! }
» Lban 00 a a
25. Mowe through the lower table ntil all of your values have been matched ta an | Juben = |
Eco value 7 e Bacx  [Henr | | camcel o a a
:5 mu::osﬂmmmlsumiluumwummiablsnmmnmm. ] [tan E N B T | 200 "] 2
< T T
18, Review the results of your prosessed data ot the top of the Dutabmport Wizard, [ 2|1 ] [ohoomn | Pk 00| [] ]
il your inventory data willbe | 30Ut ko ava) | Patc 00 0 @ []
imported. 3 Libon Urkcnomn. Pak 5700 L] a
18 w“;ummamn.mamn..mnmmn:m:muzum ihate: a1 p P = e ]
£ LUban Lrkngmn. ota) | Padc %00 a a
u Uban Uricnomn. P 200 L] L]
- Bitos./fwan, trestool: it L ! ! ! ! i ! ! ! ! }
o mo nfometon: L — ™) (kmn ol P El [] []
% Libon Ukown: Pak 4300 a a
LT Urknomn a) | Pas %00 L] L]
] Usban Urknomn Pk 5600 ] []
- DR —in — - -
- [Proje 1] [Year: 2023
BBl roectconfouaton | 0ata | Vew  Repors 7 Support
TS I NHCL X @
Beneft Annual  DBH Crown  CSV KML | New Undo Red: ore Delete | Edeng
Prices Costs Heath Defauts Mode: On
o D3ta Cofiection Inventory Datal Inventory Vakie' Report Cses| Export Actions
Hep.
Data > Inventory Data > Trees
Data > Data Collection > kmport
Required inputs MUST be completely and properly filled out. If you et stuck, you can delete the row and start over.
serkas) bbb Land DBH 1: OBH 1: DBH 2: DBH 2:
llows v por y data. This tool 3 5 :
alous Yo impatt youc g _ s ool : | Cow | suveyoate | stats | Speces s Photo®d | DBH1(G™) | ReGi(m | messredr | OBH2(em | R ) | Mewssed? I
Trees functi
ua e Tess fonction. iTree Eco - Data Import Wizard =gl X . .
3 Uban 1500
Steps to Import inventory: ! J ] matching dats: - |
1 Inthe Data import Wizard, click Browse. 0 Utan oS ion o by o %50 a L]
2. Novigate to the file containing your inventory data, R Your Field | Eco Feld | | 1400/ [] [}
3. Select the file and click Open. + + — +
a g G (Ut 1500, a a
5. Motch your existing data fields to £co's data flelds. u |Uoan E 1200} a L]
6 Selectan table. appearinthe | g Uban 1220 a [
“Your - the window. + T E 1 T
7. Choose the "Eco Field” ype in i e | - LU e L
your selected column. e | T 150/ [] []
8 Checkthe box or not you will e Match your data by %0 ° a
(Note: You will 1 enter a value or, for some | 50 w0 ] e
Iater. See steps 12 through 16.) e — .
- oen| 15 |Uben Yoor valoe Eoo Yilie |3 1270 a a
For example, (vt populs s i 200, (] L]
or species code. For T auo I 6500 ] [}
applies, » “Field Type” drop-down list will appear below “Eco Field.” Select the T Tatmirini — T
ield type that matches your existing data. ! jubs == E 4000} L) e
10. Repeat steps 6 through h you would like L) { Rl rind |l 00| N i []
been matched to the appropriate Eco field. 2 Uban {foinikes 4700, [] a
11 Click Next £ olive 230 8 ®
12 REQUIRED: For e |- 1 Frr 1 1
field values (step 8, match your field values to €co's. 2 Ut L 30 a a
13. In the upper table, select 8 row. £ Usan ine 200, a a
14. In the lower table, choose the "Eco Value™ from the drop-down list that matches % T sprus F 200, | T i | )
“Your Value.”
% Ubon | 4800 a L]
15. Move through the lower table until all of your values have been matched to an i = | S !
Ecovalue. 7 e | <Back Next Cancel E a3 ] 5
16. Repeat steps 12 through 15 until all necessary data varisbles have been mapped. P Uben 200 [} e
17, Click Next I I
18, Review th results of your processed data ot the t0p o the Dutatmport Wizard, [ 22|20 %0 e L
This your 1be | 130 Uban Urknown. Pak 400, 510 a a
Imparted. |Uten Unknown 2 Pok 510 0 ] (]
19 ¥ nor _nuk;u:n (Note [ ~ 00 ° e
2 luke Unknown ok 590 [} [
* Uban Urknown Pk 5200 a a
trestool " ! n )
) Uriknown Pak 600 L] L]
% Ubon Urknomn o %00 [] []
37 Utan | Urknown Pk 000 (] []
B ke | Unknown Pk 600, L] L]
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[Project: 1] [Vear 2023] -

EER roect confiounstion | Data | Vew  Reports  forecast
e al=ONE 108 ¥62>@@ N » X =
Subme ve | Paper | Impot Trees Check Beneft Annual DEBH Crown CSV KML | New Urdo Rado Restore
to Moble from Hobis | Form Data | Prces Costs Heath i
| D3t Cosction Inventory Oatal Inventory Vakie | Report Chases'|  Bxport Actons
Hep.
Data > Inventory Data > Trees
Dats > Data Collection > Import

D6 you have an existing inventory? The kmport function

Required inputs MUST be completely and properly filled out. If you get stuck, you can delete the row and start over.

¥ This tool is only available for Land DBH 1: DBH 12 DBH 2: DBH 2:
e poor your st v D | Sawm | Gew | SuveyOte | Stats | Speces e Photo> | DBHI(GM | Rl | Ressuredy | OBH2 (M) Heght (m) | Messured? |
T
0 heTrews nction, iTree Eco - Data Import Wizard - o x
3 Uban 1500
Stape o mpert et ! | E | !
T e Dot mport wiaard,click rowse A [ Records before processing: = = S
z Novigate to the file containing your inventory data, s TUban dsting recoeds in wole: g [ 1400 ] L]
3. Selectthe file and click Open. + B b | !
“ that appears & |Uban Results of processed data: L 1500, ] ]
5. Motch your existing data flelds to Eco’s dats fields. 7 Uban Total records anatyzed for impor: 1991 1200 a a
6 lect appear inthe 1 1 oan E 1 | T
_8 +- Records that cannot be imported: 962 128 - L) - L]
7. Choose the “Eco Field™ ype in ., .w Records to be imported: 1029 — 0 a L
your selected column M e Records: | B 150 a L]
8 or notye I (Ut Py %00, a a
(Note: You will s ™ perted ; Mejecsed 580 [T ) L]
later. See steps 12 through 16.) + + = | - 1 1 1
B 3 often | 16 |Uben » Speces 0BH 1 (cm) a"m“"' (il == 1270, a )
bedisplayed vs. For example. d 17 e ' . o [] []
common name, scientific name, or species code. For data variables where this e Toten r 00 e ]
‘applies, 8 “Fieid Type” drop-down list will appear below “Eco Field " Select the ' 1 Aeppo pine (Pinus halepensis) 57,324840764331206 lﬂ | = +
field type that matches your existing data. 119 [Ubin o | 5 0] o e
10. Repet .?D ‘M.l = s = | & 7VD,I1‘ a a
been matched to the sppeopriate Eco field. 2 Uban 0 [} e
11, Click Next. 4 ¢ E ]
i EQUARED: For L. Giiex aiet Yo | = | o L]
field values (step 8), match your field values to €o’s. 2 |ub:n your data. L 3500 a a
13, In the upper table, select a row. 2 Uban 200 a L]
14. In the fower table, choose the "Eco Value™ from the drop-down listthat matches |15 P e na Tyl Mgidans! meieamtone mos be rewiedoe mees 00| CR| °
“Your Value” T | = +
15, Move through the lower tableunti] 1l of yourvaloes have been matchedtoon [ (25 [Usen s i raa E ) ] ]
Ecovalue 77 ube |3 00 [] [}
16. Repeat steps 12 through 15 until all necessary dota variables have beenmapoed | 25 | wen 200 [} ]
17, Click Next + T T
18 v the top of the Dataimport wizard. | 23|51 300} I e [ L]
his " be| [0 Juean 300, s @ [}
imported. 3t Usban 5700 a ]
19. When , click Finish. (Note: 7&2 1 wé' ] T [
Use the Back i ) ! fuen ! !
I 50/ = []
4 |Ubn 200 [ e
| v 00 e []
% Usan 4300 a a
7 uem 00 (] L]
£ Ubon 5600 L) L]
- [Project: aho 7o naps] [Sesies: 1] [Year 2023] - - Toee Eco v6.032 - o x
EEER roieconfunton  Dta  Vew | Reports | Forscst  Support

roosts

& ©

B B eaew

Coordinates E% M

Commants

B ey

Project SubmktData  Track & Wikten G ton  Benefts  Indvidual Pest | Polutionand | Mtk | Sclentific Model | Share Project Map Active  CSV  KML
Metadara for Processng Retrieve Resuls | Report 2nd SUUCTLE - and Costs - Lovel Rasuls~ ARAYSS - her « HdeZewos | Notes|  (bew)  Report (beta) (beta) (beta)
Forrratted Repots cans Settngs
Help [send data to tha USFS for processng (]
On this tab, you can send data, retrieve results, and view your reports. i-Tree Eco presents reports in the Reports tab in various formats, including charts, tables, and a written report [see Notes below).
Ta get started, £0 to the File menu and select one of the following eptions: On the ribbon abave, there are ten groups of available functions, including:
* New Project - 1o creste s new Eco project. — P " . -
M vt oo i e erefc roject Metadata — o view your project metadata.
- o Pl o — Submit Data for Processing — 1o SUBMIT your project data 10 the server where the i-Tree Eco model will run,
—
from the at the top of the ribbon the different. — Track & Retrieve Results — to track the status of a recent data submission or load your model results from the server.
pmms of an Eco project. one: or —
buttons in the ribbon above. choase will in the —
actron vamel o the L 10 view your summary reports.
o y d tabl
For more informetion. hitios Ares

manuslz-porkbooks

Settings—to change units {i.e., English or metric) and speci 0 yed in your reports.
Model Notes - to view notes about your model run,

Map Active Report ~1o view weather and pollution station locatiens and, if collected, plot and tree locations.

CSV = to export specific reports.

KMAL~to export coordinate data.

Choose the repart that you would like 1o view by clicking on one of the buttans or by selecting a report from one of the drop-down lists. The report will become available in the action panel to the
right. Thare is a toolbar at the top of the action pane! that allows you to room in and out and save or print your reports.

The Formatted Reports group offers a variety of report options:
*  Written Report provides a summary, narrative repart

the results of your project, g structure, services provided by your urban forest.

position and Strusture charts and nbl!sp(!sem Infarmation on the smmum aspects of the urban farest of your study area, including pvw\allrms{u. species make-up, leat area, tree
condition, and biomass in a variety of wi ich by by strata or g basis.

*  Benefits and Costs charts and.
of carbon sequestered) and in associated dollar values,

benefits that are provided by the urban forest in your study area, Results are provided in functional units (e.g., tons

Individual Level Results charts and tables present information on the characteristics of the sampled trees in your study area, Including structural aspects and ecosystem services. Results are
provided for each individual tree assessed.

of Incidents that

In pollutant Il as

Al Quality and
value of those reductions in health incidents.

Pest Analysis charts and tables include a standard report for all users on the susceptibility of their urban forest to known pests. For users who choose to collect pest {IPED] data in the field,
‘additional reports summarize that data here.

Mﬁhmwunmntalnscﬂedm -down list of reports:
charts and

about the air quality, weather, UV, and hy

ogy of y y area. Results.

your project.
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[Project 610 7o mapeo] [Seies: 1] [Year: 2023] - i-Tee Eco 6032 - 8 x
IR roecicontumton. a2 view | Repors | et Support

B o 2B B B % B mem ooa O

Project SubmkData  Track s Wikten Compostion nefts  Wdwidudl  Pest | Poltionand | metic | Sciemtiic Model | Share Project Map Actve SV KML
Netadata for Processing Retreve Resuls | Report and Stucture » and Costs Level Resubs Anakss= | Weathers fide Zeros | otes | (bet)  Report (bet) (beta) (beta)
Formatted Reports. Charts. Settings
Help[Send data to the USFS for processng 3
On this tab, y reports. in the Reperts tab In various formats, including charts, tables, and a written report [see Notes below).
Toiet started, select i Onthe ribbon abive, there are ten groups of vallable functions,including:
+ Mew Project ~to creste a new Eco project. — Project M ~tovi
. et roject Metadata —to view your project metadata.
s o " — for ing~to submit your the server where the i-Tree Eco model will run,
—
Choose from the available tabs at the top of the ribbon bar to access the different — Track & Retrieve Results =10 track the status of a recent data submission or load your model results from the server.
phases of an Eco project. ) —
buttons in the ribbon above. choose will inthe -
buttans I the ron b Formatted Reports ~ 10 View your sumMry reports.
Charts - to view your pollution and weather charts and tables.
Fov more infommoion: iigs ey estasl
manuslirkbooks ings—to change units (i.e., English or metri] and speci 1 sclentific) th yed in your reports,
Model Notes =10 view notes sbout your model run.
Map Active Rep and locations and, i collected, plot and tree locations.
€5V - to export specific reports,
KML = to export coordinate data.
Choase the rgerttrat o would ket vis by clcing oo o1 ofthe ttan o b selecting a 8port fom e of the rop-down s Theraprt il sacome vl the scion el tre
right. Thera is 2 toolbar at the top of the action panel that allows reports.
The Formatid Repors roup ffers vty f ot optlons:
Written the results of your project, 1 struct services provided by your urban forest,
+ Composition and Structure charts and tables present information on the structural aspects of the urban forest of your study area, including population size, species make-up, leaf area, tree
condition, and biomass information. Results are provided in a variety of ways, such as classified by DBH class or by strata or ap o o
+ Benefits and Costs charts and on benefits that are provided by the urban forest in your study area, Riesults are provided in functional units fe.g. tons
of carbon sequestered) and in associated dollar values.
* Individual Level Results charts and tables present trees in your study services. Results are
provided for each individual tree assessed.
« irquality the number of Incidents that were avoided due to changes | well a
value of those reductions in health incidents.
« Pest Analysls charts and tables incluge a standard report for all users on the susceptibility of their urban forest to known pests. For users who choose to collect pest (IPED)] dsta In the field,
additional reports summarize that data here.
The Charts group contains one drop-down lst of reports:
« pollutio charts and tab sbout the air quallty, weather, UV, and hydrology of your study area. Results are based on the pollution and weather data used for
your project.
- [Project: 1] [Vear: 2023] - - o X

DR rroectconfouaton  ata  Vew | Reports | Forecast  Support

E o W Bl:x B & B B smemr& O B OO

SubmeData  Trackd Benefts  Indwdual  Pest | Poltonand | metmc | Scentic | " | Model ShareProject MapAcve CSV KWL
Metadata for Processing Retreve Results Renen:ndsuume and Costs~ Level Resuks - Analyss.  Weather - Hoe Zeros  Notes (beta) Report (beta) (beta) (beta)
Formatted Repor Charts Settngs
Help 5
Reports > Formatted Reports > Written Report
Reports > Formatted Reports > Written Report
narrative A%
Your project 048 Q-0ms -0 © @ Page «noou @- o@os
R e I T TR A R SO S R RO RIS RN AR RO RS SR CIRE RN AR O s |
*  Urban forest cover and leaf area
. 3 ge, etc )
*  Structural and functional values of trees
*  Potential pest impacts
*  I-Tree Eco methods
Notes:
. luded s
de data limitations in the
case of international studies. ~
. ), you

20d load your result
ot your changes are refected in your eports .
. panel to z00m -
print the report you have open
fic) inyour 2
the ribbon sbove. -

information: btas. estool S
i

mamalsork
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